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The CQ-3770EE™ connectivity solution combines numerous
features with an advanced Graphical User Interface (GUI) to
provide clients with remote mainframe connectivity through
IBM’s® Enterprise Extender technology.  This solution provides
connectivity from any remote or local workstation or client
running a Microsoft® Windows® 32-bit operating system, such as
Windows XP or Windows Server™ 2003.  This manual describes
the basic operations of the CQ-3770EE emulation and
customization for your applications and requirements.

Organization

Section One: Solution Setup

Chapter 1: Installation explains how to install the complete
CQ-3770EE solution on your computer.

Chapter 2: Configurator explains how to configure your
CQ-3770EE software according to your specifications through
CQ’s Configurator program.

Chapter 3: Configuration Options explains the configuration
options associated with your software.

Section Two: Functions and Features

Chapter 4: Solution Operation explains how to communicate
with the CQ-3770EE software.

Chapter 5: Print Functions  explains how to print certain areas
of the Interface screen with the print commands.

Chapter 6: Edit Functions explains how to edit certain areas of
the Interface screen with the edit commands.
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Chapter 7: Data Transfers explains how to send and receive
data with the transfer commands.

Chapter 8: View Functions explains how to view the
convenient toolbar and SmartKey Pad from the Interface screen.

Chapter 9: Scripts  explains how to create, modify, and run
scripts.

Chapter 10: Advanced Options explains the advanced options
of the Interface screen, including the toolbar and SmartKey Pad
and also diagnostic features such as the audit and trace functions.

Chapter 11: DES/Triple DES Security Options explains the
optional single DES (Data Encryption Standard) and Triple DES
features.

Section Three: CQ Information

Chapter 12: Customer Services  explains the customer services
available with CQ-3770EE.

Chapter 13: CQ Solutions and Products describes CQ’s
connectivity and productivity solutions.

The Index is included for further reference.
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Manual Conventions

Single Characters and Command Keys

Single characters, command keys, and toolbar buttons appear in
SMALL CAPITAL LETTERS within square brackets:

[S]     [2]     [ENTER]     [F1]

Menu Bar Options and Commands

Menu bar options (i.e., File, Edit, Transfer, Options, or Help) and
menu bar commands appear in boldface:

File     Options     Print Screen to File     Script

Dialog Box Options

Dialog box options (i.e., any check box, drop-down list, scrolling
list, text box, command button, etc.) also appear in boldface:

OK     Prompt for Filename     Print Setup

Toolbar Buttons

Toolbar buttons appear in boldface:

Exit     Select All     Help Contents

Entering a Command

Text that the you must enter appears in a different TYPEFACE and is
framed:

 A:SETUP 
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Brief Messages that Appear on the Screen

Brief messages that appear on the screen appear in a different
TYPEFACE:

This is an example of a brief message.

Filenames and Directory Paths

Filenames and directory paths appear in boldface:

example.txt     c:\cq\transfer\

Other Specific Names

Other information such as dialog boxes and Notes and Warnings
appear in italic:

CQ Script dialog box

Note: 
This is an example of a Note.  As you can see, it appears in italic
and the heading is indented and overscored.

Common Terms and Phrases

The host is sometimes referred to as the “mainframe”, the
“mainframe end”, or the “host end”.

A workstation is any PC or notebook computer running
CQ-3770EE with the intent to communicate with the host.
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Help Screens and
Documentation

Help Screens

CQ help screens are available throughout the CQ-3770EE software
program.  To display the help screens, select the Help button
from any dialog box or screen or select the Help command from
a screen’s menu bar if it is available.  In many cases, you can also
press the [F1] key to access help information.  For information on
using other context-sensitive help features, refer to the
documentation that came with your operating system.

CQ-3770EE USER GUIDE in .PDF Format

The complete CQ-3770EE USER GUIDE is included in Adobe®

Acrobat® .PDF format on your CQ-3770EE CD.  The name of
this file is 37eeuser.pdf.

Quick Installation Guide

Your CQ-3770EE solution should have come with a Quick
Installation Guide.  This guide contains detailed instructions on
how to install your CQ solution.  In some cases, your Quick
Installation Guide may also be customized for communications
with a specific host site.

To install your CQ solution, CQ recommends that you follow the
instructions in the Quick Installation Guide.  Other information
about your CQ solution can be found in the CQ-3770EE USER
GUIDE.
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Technical Overview

This technical overview discusses the Enterprise Extender (EE)
technology and how it relates to the transmission of SNA data
over IP networks.  This overview looks at how SNA networks
exist today, in what ways they can be tailored in order to be used
in the future, and how the Enterprise Extender technology can be
used in this endeavor.

SNA Networks

Systems Network Architecture (SNA) networks are still in place
and in use today.  These SNA networks were implemented
decades ago and remain mission-critical components of the
organizations that use them.  However, more and more each year
it is becoming increasingly difficult for these organizations to
support and maintain their SNA networks and systems.

One reason that it is difficult to maintain SNA networks is that
key SNA networking equipment has been discontinued or is now
not supported.  For example, the IBM 3745 and 3746 Controllers
(also known as Front End Processors) form the backbone of
many mission critical SNA networks by allowing remote SNA
clients to connect to mainframe computers.  These FEPs were
withdrawn from marketing by IBM effective September 27,
2002.  Since that date, only used FEP products and features have
been available.

Another reason that it is difficult to maintain SNA networks is a
lack of personnel to support the applications and equipment that
are a part of the SNA system.  The knowledge, skills, and
technical expertise that are required to manage SNA networks as
they exist today is becoming increasingly scarce.

The reasons explained above necessitate a move from “pure”
SNA into a form of SNA that can be integrated with today’s
technology and resources.
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IP Networks

Many organizations would agree that Internet Protocol (IP) is
now the networking technology of choice.  Almost all new IT
deployments, including those that include mainframe
connectivity, are based on IP.  For many years, IP networks have
been run alongside SNA networks with great success.  However,
the solution of running two separate networks between the same
two end points has led to considerable duplication with excessive
administration, management, and maintenance costs between the
two networks.  So, this begs the question - “Why not just run
SNA traffic over the existing IP networks?”.  After all, there are
several advantages to integrating SNA networks into existing IP
networks.

The first advantage has already been explained in the previous
paragraph.  This advantage is that IP is the network of choice for
today’s networking and communications projects so it is well
supported and well maintained.  There is an abundance of IP
equipment that is available and that is constantly being updated to
meet today’s high-speed standards.  For example, through the use
of the OSA-Express adapter at the mainframe end, extremely
high-speeds can be achieved that otherwise would not be
available over a “pure” SNA connection.

A second advantage, also previously explained, is the
simplification of the network by integrating the SNA network
into IP.  By eliminating many of the SNA network components,
there is no redundancy costs associated with the upkeep of two
networks.
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SNA-over-IP through Enterprise
Extender

So, now that we’ve decided that running SNA traffic over IP is a
good idea, how do we accomplish this?  Simple - by
implementing Enterprise Extender!  For many years, SNA over
IP was not a possibility.  However, with the implementation of
Enterprise Extender on the mainframe, remote clients can now
transmit SNA traffic over their existing IP networks!

Enterprise Extender (EE) allows for the use of SNA transport
protocols (namely APPN and HPR) over an IP network.  EE
enables the leveraging of IP-based infrastructure network
components for use in delivering SNA traffic.

The Enterprise Extender architecture carries SNA (HPR) traffic
of any LU type over an IP infrastructure, without requiring
changes to that infrastructure.  EE essentially treats the IP
network as a particular type of SNA logical connection.  In this
manner, these SNA protocols act as transport protocols on top of
IP, as does any other transport protocol such as Transmission
Control Protocol (TCP).
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EE Strategic Advantages

Enterprise Extender combines the features of SNA and IP to offer
the best of both worlds when running SNA traffic over an IP
backbone.  Some of the advantages that the EE solution offers to
its users are listed in this section.

Cost-Effectiveness and Resource
Convergence

The use of Enterprise Extender allows you to avoid costly
application rewrites by providing a means of IP-enabling SNA
applications (such as RJE) that cannot be migrated to “pure” IP.
That is, EE allows the continued use of native SNA applications
over a different network: the IP network.  This allows you to
eliminate the SNA infrastructure altogether. The ultimate result is
the convergence to a single network infrastructure that carries
both IP and SNA application data.

Enterprise Extender has been designed to run over existing IP
networks without requiring any change to applications or to IP
routers.  SNA applications see the same SNA network interfaces
as before, whereas IP routers continue to see the same IP (UDP)
packets.

Flow and Congestion Control

TCP/IP and HPR both provide their own unique,
network-specific mechanisms for flow and congestion control.
TCP uses a windowed technique, whereas HPR uses a technique
based on data rate.  Enterprise Extender introduced a new variant
of the HPR flow control method known as responsive mode
adaptive rate-based (ARB) flow control.  Responsive mode ARB,
like basic mode ARB, is designed to prevent network congestion;
however, unlike basic mode ARB, it can also ensure a fair
division of network capacity between the four SNA priorities and
native IP traffic.
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Class of Service

One of the biggest issues facing those who wish to transport SNA
over an IP network is the question of maintaining SNA’s class of
service.  In SNA, the class of service specified for a particular
session is used to determine both the route taken by the session
and the transmission priority allotted to it.

With an IP backbone, the route is essentially unpredictable
because of IP’s connectionless property.  However, IP provides
for a transmission priority using the precedence bits in the IP
header.  Many routers now support the use of these bits, but in
the past they have tended to use the TCP or UDP port number as
a means of assigning priorities to packets.

Enterprise Extender supports the use of both the precedence bits
and the port numbers to inform the IP network of the
transmission priority.  Use of the precedence bits is
recommended because the UDP or TCP port numbers are carried
inside the IP datagram, whereas the precedence bits are in the IP
header.  Thus, encrypted packets have unreadable port numbers
and fragmented packets have no port numbers, after the first
fragment.  For such encrypted or fragmented packets,
intermediate routers cannot determine the appropriate priority.
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Session Availability

TCP/IP has always had the ability to reroute packets around
failing components, without disrupting the connection, by means
of the connectionless property of IP.  More recently SNA has
implemented the same function, albeit in a rather different
fashion.  The high-performance routing (HPR) extension to SNA
is connection-oriented as SNA has always been, but when it
detects a failure, it will move an existing connection around a
failing component.  The use of HPR transport over an IP network
provides non-disruptive rerouting around failed network
components using either IP or HPR methods, depending on the
location of the failure.

HPR consists of the following layers:

• Automatic Network Routing (ANR) - a connectionless
layer that enables rerouting around failures.

• Rapid Transport Protocol (RTP) - a reliable
connection-oriented layer that provides the end-to-end
functionality.

Conclusion

Enterprise Extender provides SNA users with a seamless
transition to SNA over IP that is both optimal in reducing
network complexity and cost while also providing strategic
advantages as a sustainable long-term solution that is adaptable
with the changes in the future.
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Benefits and Features

• Interactive GUI Interface.  The user friendly interface
makes installation, configuration, and use of CQ-3770EE
simple and easy to understand.  Interface components such
as drop down menus, customizable toolbars, clearly
identified buttons, and context sensitive help can be found
throughout the solution.

• Customizable Features.  The customizable toolbar and
floating SmartKey Pad allow users convenient and quick one
button access to scripts, complex commands, and other
programs, such as CQ’s optional productivity solutions.  For
example, a button can be setup that condenses a series of JES
commands into a single mouse click.  This might be helpful
as a means to have one button queue access.  A button may
also be easily setup for one button remote host login access.

• Configurator.  CQ’s Configurator program allows users to
quickly and easily set communication options.  Most of these
options are set from the Quick Configuration screen.  EE
specific options include the CP Name, DLUS Name, and
Destination IP address.

• CQ In/Out Bound Screen.  An informative CQ In/Out
Bound screen appears when the client is connected with the
host.  This screen clearly displays the current status of
communications, any OutBound console data, and any
InBound console data.  Users can also conveniently scroll
through the data queues from this screen.  All of the
information is displayed in a clear, concise manner.
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• Scripting and Scheduling.  CQ’s scripting language allows
automated and unattended CQ-3770EE host site
communications through customized scripts and scheduling
features.  Unattended automation facilities make host site
communications more cost effective than normal attended
operation.  Most any task can be scheduled for execution
through CQ’s scripting commands.

For advanced data management scheduling, the optional
CQ-Event Scheduler productivity solution provides an
automated way to schedule recurring computer tasks that you
would otherwise have to initiate manually.  The solution is
especially ideal for the automation of daily, weekly, or
monthly tasks such as file management processes, report
downloads, and large after hours print jobs.

• Printing Features.  CQ-3770EE supports any laser printer
that is supported by the Windows operating system.
Customizable print features such as the number of lines and
columns and page orientation can easily be setup through the
solution.  CQ-3770EE also supports the Windows operating
system print spooler so the user can print multiple jobs.  Up
to eight concurrent printers are also supported by the
solution.  The solution also supports older legacy printers for
uses that require raw line prints.

For the ultimate in printer features and compatibility, the
CQ-Print Administrator productivity solution provides an
efficient way to manage and print text based files according
to your specific print layout requirements and specifications.
The solution is useful for large recurring print jobs that
require pre-set file formatting options and also allows you to
configure and save print Layouts for unattended print jobs
that you schedule through other programs, including
CQ-3770EE.  Through these print Layouts, you can also
include customizable headers, footers, and banner pages that
allow you to separate and identify print jobs according to
your specific requirements.
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• CQ Diagnostics.  CQ-3770EE provides accessible
communications logging features through its audit and trace
options.  These features are used for tracking the user’s data
transfers and include time stamps, file send and receive
information, and file size information.

• Security Features.  CQ-3770EE is equipped with numerous
security features.  Certain areas of the program are password
protected and the configuration data is decrypted dependent
upon the proper entry of the correct password.  Also, for the
ultimate in secure communications, the Triple Data
Encryption Standard (Triple DES) security option is
available as an option.
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System Requirements

Workstation/Server Requirements

CQ-3770EE supports a wide range of systems.  There are
hardware and software requirements, as well as memory and
storage requirements, to consider when installing CQ-3770EE.

Microprocessor

An Intel Pentium® microprocessor is
recommended, although other compatible
microprocessors such as the Celeron and AMD
K6/Athlon/Duron family of microprocessors are
also supported.

Drive Space

A minimum of 200 MB of fixed drive space is
required.  Additional space may be required after
CQ-3770EE installation due to configuration
option changes and other post installation
changes such as diagnostics or scripting changes

Operating
System

All Microsoft Windows 32-bit operating systems
are supported by CQ-3770EE.

Memory
A minimum of 128 MB of memory is required,
although at least 256 MB of memory is
recommended.

Peripherals

The system should have access to a CD-ROM
drive.

CQ-3770EE is compatible with systems that
support all VGA resolution or above display
monitors, all VGA resolution or above video
adapters, all keyboards, and all printers (when a
PDT file is not used) that are supported by
Windows.

TCP/IP Protocol The TCP/IP protocol (i.e., Internet Protocol)
should be bound to the system’s network card
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Other
Connectivity
Programs

CQ recommends that you not have Microsoft’s
Host Integration Server (current versions as well
as previously released versions such as
Microsoft SNA Server, etc.) loaded and/or
running on the system you will be running
CQ-3770EE from.

CQ recommends that you not have any IBM
mainframe/host connectivity products (such as
Host Access Client) loaded and/or running on
the system you will be running CQ-3770EE from.

If you have a question on CQ-3770EE
compatibility with other connectivity programs
on your system, please contact CQ at
770-844-0233 .

Other
Requirements

Your CQ representative may have indicated
other hardware and software requirements to
you at the time of purchase.  Please note that
your actual requirements may also vary based
on your system configuration and the features
required.
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Application Data Access Requirements

Application data is generally defined to be files that contain user
preferences or configuration information.  The CQ-3770EE
solution needs access to specific application data files in order to
install and run properly.

CQ recommends that the current user logged onto the system
have access to the following application data locations in order
for CQ-3770EE to function properly.  Please note that some of
these locations are created during CQ-3770EE installation.

Windows 95/98 Operating Systems

• C:\Windows\All Users\Application Data\CqCompComm

• C:\Windows\All Users\Application Data\IBM\
Personal Communications

• C:\Windows\ %USERNAME% \Application Data\IBM\
Personal Communications

Windows NT-based Operating Systems (NT,
2000, XP, etc.)

• C:\Documents and Settings\All Users\Application Data\
CqCompComm

• C:\Documents and Settings\All Users\Application Data\
IBM\Personal Communications

• C:\Documents and Settings\ %USERNAME% \
Application Data\IBM\Personal Communications
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Registry Access Requirements

The current user logged onto the system must have read/write
access to the subkeys of the following Registry area in order for
CQ-3770EE to function properly:

• HKEY_CLASSES_ROOT\CLSID\{}
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EE Settings

Prior to CQ-3770EE installation, you will need to obtain several
EE settings from your host site contact for each CQ-3770EE
product that you plan to install.  These EE settings are as follows:

• Destination IP Address - This is the IP address to get
access to the host DLUS function.

• DLUS Name - This is comprised of the Network Name and
the CP Name of the host where the DLUS resides.

• CP Name - For each CQ-3770EE installation, you will need
to request a CP Name from your host site contact.

The Control Point Name (CP Name) is a 17-byte character
string that consists of two parts separated by a period (this
period appears on the Configurator screen so you need not
enter it).  The first part is a 1-  to 8-byte character string that
is the network name.  The second part is a 1-  to 8-byte
character string that is the control point name.

• XID - The Exchange ID is required for host connections
and consists of two parts - the IDBLK (three hexadecimal
digits) and the IDNUM (five hexadecimal digits).  For
example, a valid XID is 03D12345.

• # of LUs - This is the number of LUs configured for the
remote PU.

• Logon - The logon command is used to attach the LUs to an
application (usually JES2 or JES3).  An example of a logon
is as follows:

LOGON APPLID(XXX) LOGMODE(BATCH) DATA(RMT###,,password)

In the example above, XXX is the application identifier, ### is
your Remote Number, and password is the password
assigned to you by your host site contact for your Remote
Number.  This entire Logon is provided to you by your host
site contact.

Introduction

xxxii



All of these settings are necessary in that they will be entered into
CQ’s Configurator program after CQ-3770EE installation and will
allow the CQ-3770EE software to connect to the mainframe.
Keep in mind that if you plan to install multiple licenses of
CQ-3770EE, you will need a unique CP Name, Logon, and XID
for each installation.
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Windows XP Firewall

Certain packets of data are blocked by the Windows Firewall
feature included in Microsoft Windows XP when trying to
connect with CQ-3770EE.  To enable your operating system to
allow these packets, CQ recommends, if at all possible, that you
disable the Windows Firewall.  If you are unable to fully disable
your Windows Firewall, then the standard UDP ports (numbers
12000 to 12004) must be added to the Windows Firewall
exception list.

Follow either of the instructions below in order to allow
CQ-3770EE connectivity through the Windows Firewall.

Disabling the Windows Firewall

1. Open Windows Firewall from the Windows Control Panel.

2. Select the Off option button.

3. Select the OK button.

4. Close the Windows Control Panel.

Adding Ports to the Exception List

1. Open Windows Firewall from the Windows Control Panel.

2. Select the Exceptions folder tab.

3. Select the Add Port  button to add UDP ports 12000, 12001,
12002, 12003, and 12004.

4. After you have added all the ports, select the OK button.

5. Close the Windows Control Panel.

Introduction

xxxiv



Section One

Solution Setup

Chapters

Chapter 1: Installation

Chapter 2: Configurator

Chapter 3: Configuration Options





Chapter 1

Installation

Highlights

How to install the CQ solution



This chapter describes the procedures associated with installing
your CQ-3770EE solution.

Quick Installation Guide

Your CQ-3770EE solution should have come with a
Quick Installation Guide.  This guide contains detailed
instructions on how to install and configure your CQ
solution. 

To install your CQ solution, CQ recommends that
you follow the instructions in the Quick Installation
Guide.  The instructions that appear within the
remainder of this chapter are summary in nature.
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Software Installation

Please note that prior to CQ-3770EE installation, be
sure that you have followed the instructions within
the Planning to Install CQ-3770EE guide.  The
instructions within this guide must be followed prior
to CQ-3770EE installation.

After you have followed the instructions in the Planning to
Install CQ-3770EE guide, you can install the CQ-3770EE
solution.  If you require assistance, please contact CQ at
770-844-0233 to schedule a day and time for CQ to assist with
CQ-3770EE installation instructions that appear within this
section.  Then, at the assigned day and time, a CQ representative
will guide you through the instructions within this section so that
the solution is installed and ready for a production environment.

Software Installation
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CQ-3770EE System Check

Before you begin with CQ-3770EE software installation, check
your system according to the requirements listed below:

• System Requirements.  Confirm that your system conforms
to the list of System Requirements listed at the end of the
Introduction section of this guide.

• 3770EE Settings.  Your host site contact should provide you
with a Destination IP Address, DLUS Name, CP Name,
XID, and Logon.  You will need this information in order to
configure CQ-3770EE after installation.

• Other Third Party Programs.  CQ recommends that you
not have Microsoft’s Host Integration Server (current
versions as well as previously released versions such as
Microsoft SNA Server, etc.) loaded and/or running on the
system you will be running CQ-3770EE from.

Also, CQ recommends that you not have any IBM
mainframe/host connectivity products (such as Host Access
Client) loaded and/or running on the system you will be
running CQ-3770EE from.  If you have a question on
CQ-3770EE compatibility with other connectivity programs
on your system, please contact CQ at 770-844-0233.

Note:
If during the course of software installation you encounter an
error or similar event, contact the CQ Technical Support
department at 770-844-0233 for specific instructions on how to
uninstall and then re-install the software.  Do not attempt to
uninstall the software as the uninstall program may delete some
files that you would otherwise want to save.  A CQ
Representative can assist you in this procedure.
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Installation

When you are ready to install the software, CQ recommends that
you follow the instructions in the Quick Installation Guide that
came with your solution.
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Software License Registration

Sometime during the first month after initial software installation,
you will need to contact CQ for license authorization instructions
if the Software License Registration icon appears within the
CQ_WIN program group.

For more information on license registration, turn to the section
called “Software License Registration” in the Quick Installation
Guide  that came with your solution.  If you require additional
license registration assistance, you can also contact CQ.
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Configuration

After you have successfully installed your CQ-3770EE
connectivity solution, please note that all CQ-3770EE related
programs will appear in the CQ_WIN program group.

To access the CQ_WIN program group:

• Select Start > (All) Programs > CQ-3770EE from your
computer’s desktop.

CQ Configurator

Before you begin communications, you must first configure the
CQ-3770EE communications parameters such as the logon, CP
Name, and other parameters.  To set these parameters, access the
Configurator program.

To access the Configurator program:

• Select the Configurator icon in the CQ_WIN program group.

For detailed information on how to use the Configurator
program, turn to Chapter 2: Configurator.
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This chapter explains how to configure CQ-3770EE through the
Configurator.  This chapter is divided into two sections.  The first
section gives a brief overview of the Configurator, including an
explanation of each of its screens.  The second section explains
how to use the Configurator’s many options.

Quick Installation Guide

Your CQ-3770EE solution should have come with a
Quick Installation Guide.  This guide contains detailed
instructions on how to install and configure your CQ
solution. 

To install your CQ solution, CQ recommends that
you follow the instructions in the Quick Installation
Guide.  The instructions that appear within the
remainder of this chapter are summary in nature.
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Configurator Overview

Before you can communicate with a host, you must first create
and set up a configuration file.  Each configuration file that you
create contains the communications options that are necessary for
host communications.  These options include the logon, number
of Logical Units (LUs), and other information.  Most of the
options in the Configurator program are accessible from one
simple screen with more advanced options accessible through
other screens.

CQ’s Configurator program allows you to create multiple
configuration files for CQ-3770EE communications.  This might
be helpful if, for example, you connect to multiple host sites or
you need to connect to the same host sites using different options.
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Accessing the Configurator

To access the Configurator program, select the Configurator
icon in the CQ_WIN program group.

The Configurator program allows you to:

• Create one or more new configuration files.

• Change the option settings of one or more configuration files
that you have already created.

Note:
When you exit the Configurator after creating one or more new
configuration files, a new icon appears in the CQ_WIN program
group for each new configuration file that was created.  To
connect to the host site, select one of these icons.  This will run
the configuration file according to the communications options
that were set up through the Configurator.  For more information
on host site communications, see Chapter 4: Solution Operation.

2 - 1  Configurator Program Icon
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Special Note for Password Protected Users

If the Configurator program has been password protected, a
screen will appear that requests password entry.  A
Configuration Password may be required for access to the
communications options within the Configurator program.  A
Run Time Password may also be required for access to the
Configurator program.

These passwords protect the communications options on two
different levels of security:

• Configuration Password - This password gives the user
access to all of the Configurator communications options.
Your central site administrator usually has access to this
password.

• Run Time Password - This password gives the user access
to the majority of the parameters.  Through the use of this
password, the Logon is encrypted.  Some central site
administrators may find it useful to give end users access to
the majority of the communications options (such as the
XID) and restrict access to sensitive information such as the
Logon.

Once the required Passwords have been entered, the
CQ Configurator screen explained on Page 2-7 will appear.  If no
Run Time Password was required, then all communications
options become available for modification.  If a Run Time
Password was required, then all communications options except
for the Logon become available for modification.  For
information on password protecting the Configurator, see the
option called “Password” on Page 2-9.
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Configurator Screens

The Configurator consists of five screens:

1. CQ Configurator - This is the first screen that appears after
loading the Configurator.  Most of the settings that you will
need appear on this screen.

2. Change Passwords - This screen is used to change the
passwords associated with CQ-3770EE.

3. Interface - Local - This screen is where RJE communications
occur when you are connected with the host site.  When this
screen is accessed through the Configurator, you can
customize features such as the receive data options, the
toolbar, the SmartKey Pad, and scripts.

4. Advanced Options  - Intended for more advanced users, you can
set some of the more advanced options from this screen.

5. Configuration Tree - This screen gives a graphical
representation of the current configuration scheme.

These screens appear in order of complexity.  For example, when
you first access the Configurator, the CQ Configurator screen
appears.  From this screen, you can access the Change Passwords
screen to change the settings associated with the passwords or the
Interface - Local screen to customize features such as the receive
data options, the toolbar, the SmartKey Pad, and scripts.  You can
also access the Advanced Options screen.  This screen contains
more advanced options than the previous screen.  Many of these
options are not absolutely necessary to facilitate communications.
The last screen is accessible through the Advanced Options
screen and is called the Configuration Tree screen.  This screen is
intended for advanced users only that are using multiple
communications drivers.
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CQ Configurator Screen

The first screen that appears after you select the Configurator
program icon is the CQ Configurator screen.  This screen
displays the settings required by most users to complete
configuration.  Some users may need to access the Advanced
Options screen for further customization.

Note:
Some of the options that appear in the screen pictured above may
or may not appear on your version of CQ-3770EE software.

2 - 2  CQ Configurator Screen
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Menu Bar Options

The CQ Configurator screen menu bar has two options,  File and
Help.

• File - From this option, you can start a new configuration,
open an existing configuration, save the current
configuration, save the current configuration as another
name, rename the current configuration, delete the current
configuration, exit the Configurator, or open one of the most
recent configurations that you have accessed.

• Help - From this option, you can access the CQ-3770EE
Help file where you can use the Contents, Index, or Search
features to locate helpful information on the software.  You
can also access the About screen for information about the
CQ-3770EE software, including the serial number.

Quick Configuration Options

The quick configuration options make up the majority of the
CQ Configurator  screen.

• Session Options - This area is reserved for options that are
absolutely necessary for communications.  Be sure to enter
values for each of these options before attempting
communications.  For more information on Session
Options, see Chapter 3: Configuration Options.

• Audit - Activate this check box to initiate CQ’s audit
feature.  An audit file gives a summary of all
communications events, including a date and time stamp of
the number of records sent or received, the number of bytes
sent or received, the filenames sent or received, and the
status of each file.  For information on the audit feature, see
the section called “Audit” on Page 10-27.
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• Trace - Activate this check box to initiate CQ’s trace
feature.  A trace file gives detailed descriptions of all
low-level communications events.  For information on the
trace feature, see the section called “Trace” on Page 10-29.

• Advanced - Select this button to access the Advanced
Options screen.

• Interface - Select this button to access the current
configuration’s Interface screen in “Local” mode.  From the
Interface - Local screen, you can configure options such as
the receive options, the toolbar, the SmartKey Pad, and
scripts.  For more information on the Interface - Local
screen, see the section called “Interface Screen” on Page 4-5.

• Password - Select this button to access the Change
Passwords screen.  This screen allows you to change the
Configuration and Run Time Passwords.  For more
information on the Change Passwords screen, see the section
called “Change Passwords Screen” on Page 2-10.

• Save - Select this button to save the current settings on the
CQ Configurator screen.

• Close - Select this button to close the Configurator program.

Configurator Screens
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Change Passwords Screen

The Change Passwords screen is accessible through the
CQ Configurator  screen.  The Change Passwords screen is
intended for advanced users and administrative personnel that
want to password protect CQ-3770EE.

Warning:
When you password protect the Configurator or Interface, the
software will always be password protected.  You can change the
password, but you cannot disable password protection.  In order
to run the software without password protection after you have
installed a password, you will need to re-install the software.
Contact CQ Technical Support for more information before
proceeding. 

Note:
For information on how to set or modify the passwords, see the
section called “Passwords” on Page 2-29.

Change Passwords Screen Options

The Change Passwords screen has several options.

• Configuration Password - The password modification
process requires the re-entry of the old password in the Old
Password text box, the entry of the new password in New
Password text box, and the re-entry of the new password in
the Confirm New Password text box.  The characters that
are entered are displayed as asterisks (*) for security reasons.

• Run Time Password - The password modification process
requires the re-entry of the old password in the Old
Password text box, the entry of the new password in New
Password text box, and the re-entry of the new password in
the Confirm New Password text box.  The characters that
are entered are displayed as asterisks (*) for security reasons.
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• Minimum Length  - This text box contains the minimum
length of the Run Time Password.  It is recommended that
a minimum length be specified for this password.  Only
passwords containing at least the minimum number of
characters will be accepted.

• Allow user to change at run time - Activate this check box
to allow the user to change the Run Time Password
whenever the Interface screen is accessed.

• Require user to change on the first time execution -
Activate this check box to require the user to change the
Run Time Password upon initial execution of the Interface
screen.  The user will not be required to enter a new Run
Time Password unless the Allow user to change at run
time check box is activated.

Configurator Screens
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Interface - Local Screen

The Interface - Local screen is where RJE communications
occur.  When this screen is accessed through the Configurator,
the term Local appears in the title bar.

The purpose of accessing the Interface screen through the
Configurator is so you can configure options such as the receive
data options, the toolbar, the SmartKey Pad, and scripts without
being connected to the host site.

2 - 3  Interface - Local Screen
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Interface - Local Screen Options

The Interface - Local screen consists of five parts:

• Title Bar - The title bar is the horizontal bar at the top of the
Interface - Local screen that contains the session name and
the current connection mode.  If the configuration is not
connected to the host, the term Local will appear as the
connection mode.  If the configuration is connected to the
host, the term CQ In/Out Bound will appear as the
connection mode.

• Menu Bar - The menu bar is the horizontal bar located just
below the title bar that contains the names of the menus,
including File , Edit, Transfer, Options, and Help.

• Toolbar - The toolbar is the horizontal bar located just
below the menu bar that contains the icon buttons.  These
buttons initiate the commands that are associated with them.
Think of toolbar buttons as shortcut commands.  Another
part of the Interface screen similar to the toolbar is the
SmartKey Pad.  This pad is independent of the
Interface - Local screen and may appear anywhere on your
computer’s desktop.

• Console Area - The console area is the large rectangular
area located below the toolbar.  CQ-3770EE  connectivity
occurs within the console area.  This connectivity includes
all information involving the host application.  During
configuration and times that you are not connected to the
host, this area remains blank.

• Status Line - The status line is the horizontal bar located at
the bottom of the Interface - Local screen.  This bar displays
information on the status of the current connection, including
data transfer events and other communications information.
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Advanced Options Screen

The Advanced Options screen is accessible through the
CQ Configurator  screen.  The Advanced Options screen is
intended for more advanced users.  Most options that are
necessary for host communications can be set through the
CQ Configurator  screen.  In some cases, it may be necessary to
set some of the options that do not appear on the
CQ Configurator  screen from within the Advanced Options
screen.

Advanced Options Screen Options

The Advanced Options screen has several options.

• Folder Tabs - The Advanced Options screen uses a folder
format to group communications options.  For more
information on the folder tabs that are displayed with your
CQ-3770EE solution, see Chapter 3: Configuration Options.

• Configuration Tree - Select this button to access the
Configuration Tree screen.  This screen is intended for
advanced users.

• OK - Select this button to save any changes made on this
screen and return to the CQ Configurator  screen.

• Cancel - Select this button to cancel any changes made on
this screen and return to the CQ Configurator screen.

Configuration Tree Screen

The Configuration Tree screen gives a graphical representation of
the current configuration scheme.  The main function of the
Configuration Tree screen is to allow users to add multiple
communications drivers to a configuration.  Most CQ-3770EE
users communicate with only one type of communications driver
and therefore need not be concerned with this screen.

Chapter 2: Configurator
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Using the Configurator

This section gives instructions on how to use the Configurator
program.

• Configurations - Explains how to use the commands in the
File menu bar option of the CQ Configurator screen.

• Communications Options - Explains how to set the
communications options located throughout the
Configurator program as well as how to set the Audit and
Trace functions.

• Passwords - Explains how to password protect the
Configurator program.

Using the Configurator
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Configurations

Use the chart below to find information on a specific topic.

Function Page

Creating a New Configuration 2 - 17

Opening a Configuration 2 - 18

Saving a Configuration 2 - 19

Saving a Configuration as Another Name 2 - 20

Renaming a Configuration 2 - 21

Deleting a Configuration 2 - 22

Chapter 2: Configurator
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Creating a New Configuration

These instructions explain how to create a new configuration.

The filename of the current configuration appears in the title bar
at the top of the CQ Configurator screen.  A configuration
filename always ends with the extension .CQC.  Note that the
.CQC extension does not appear in the title bar.  When accessing
the program for the first time, a default configuration called
Config1.CQC is created.

To create a new configuration:

1. From the CQ_WIN program group that was created during
installation, select the Configurator icon.  The CQ
Configurator screen appears.

2. From the File menu, select New Configuration.

3. A dialog box appears and states that a new configuration has
been created with the default settings.  The name of the new
configuration is Configx, where x is the number given to the
next new configuration you have created.  For example, the
name of the configuration created when you first access the
Configurator is called Config1.  If you create a new
configuration, it is called Config2.  To rename the
configuration, select Rename from the File menu.

4. Select the OK button.  A new CQ Configurator screen appears
with the default settings.

Configurations
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Opening a Configuration

These instructions explain how to open a configuration that was
previously created and saved.

The filename of the current configuration appears in the title bar
at the top of the CQ Configurator screen.  A configuration
filename always ends with the extension .CQC.  Note that the
.CQC extension does not appear in the title bar.

To open an existing configuration:

1. From the CQ_WIN program group that was created during
installation, select the Configurator icon.  The
CQ Configurator  screen appears.

2. From the File menu, select Open Configuration.  The
Open Configuration dialog box appears.

3. Highlight the configuration that you want to open from the
scrolling Configuration List.

4. Select the Open button.  The CQ Configurator screen for the
configuration you selected appears.

Chapter 2: Configurator
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Saving a Configuration

These instructions explain how to save any changes made to a
configuration since it was last saved.

To save changes made to a configuration using
the menu bar:

1. From the CQ Configurator screen, select Save from the File
menu.

2. Any changes that you have made since you last saved the
configuration will be saved.

To save changes made to a configuration using
the Save button:

1. From the CQ Configurator screen, select the Save button.

2. Any changes that you have made since you last saved the
configuration will be saved.

Note:
Once the current settings are saved, the Save button will
gray out until another change is made within the
Configurator.

Configurations
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Saving a Configuration as
Another Name

These instructions explain how to save the current configuration
as another name.  This way, both the previously named
configuration and the newly named configuration still exist.

To save the current configuration as another
name:

1. From the CQ Configurator screen, select Save As from the File
menu.

2. From the dialog box that appears, enter the new name that you
want to save the current configuration as in the space
provided.

3. Select the OK button.  The name of the configuration at the top
of the CQ Configurator screen changes to the new name.

Chapter 2: Configurator
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Renaming a Configuration

These instructions explain how to rename the current
configuration as another name.  This way, the previously named
configuration is deleted and replaced with the newly renamed
configuration.

To rename the current configuration:

1. From the CQ Configurator screen, select Rename from the
File menu.

2. From the dialog box that appears, enter a new name for the
current configuration in the space provided.

3. Select the OK button.  The name of the configuration at the top
of the CQ Configurator screen changes to the new name.

Configurations

2 - 21



Deleting a Configuration

These instructions explain how to delete the current configuration.

To delete the current configuration:

1. From the CQ Configurator screen, select Delete Configuration
from the File menu.

2. From the dialog box that appears, select the Yes button to
confirm that you want to delete the current configuration.
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Communications Options

Use the chart below to find information on a specific topic.

Function Page

Changing the Communications Options 2 - 24

Setting Quick Startup 2 - 25

Activating the Audit Feature 2 - 26

Activating the Trace Feature 2 - 27

Accessing the Advanced Options 2 - 28

Communications Options
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Changing the Communications
Options

All of the communications options are located within the
Configurator program.  The options that are most necessary for
establishing communications are located in the opening
CQ Configurator  screen.  All communications options are
located in the Advanced Options screen.

To change the communications options:

1. From the CQ_WIN program group that was created during
installation, select the Configurator icon.  The CQ
Configurator screen appears and the current configuration
name appears in the title bar.

Note:
To open a configuration other than the one that is
currently open, select Open Configuration from the File
menu.

2. Make changes to the communications options that appear on
the screen.  These options are the settings that are most
necessary for initiating and maintaining communications
with the host site.

3. To change communications options that do not appear on the
CQ Configurator  screen, select the Advanced button.  The
Advanced Options screen appears.

4. To change the advanced options, select a folder tab to display
its options.  If an option on the Advanced Options screen also
appears on the CQ Configurator screen, any changes that
you make on one screen will be reflected on the other.

Note:
For information on the options that came with your
solution, select the Help button associated with each folder
tab or see Chapter 3: Configuration Options.

5. After you have made your changes, return to the
CQ Configurator  screen and select the Save button.
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Setting Quick Startup

When you run a configuration set for Quick Startup, the
software automatically  connects with the host site.  CQ
recommends that you activate the Quick Startup check box for
each configuration that you create.

To set a configuration for Quick Startup:

• From the CQ Configurator screen, activate the
Quick Startup check box if it is not already activated.

Communications Options
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Activating the Audit Feature

Audit files give a summary of all communications events,
including a date and time stamp of the number of records sent or
received, the number of bytes sent or received, the filenames sent
or received, and the status of each file.  Audit files are useful for
troubleshooting communications.  For information on the audit
feature, see the section called “Audit” on Page 10-27.

To set up an audit:

• From the CQ Configurator screen, activate the Audit check
box if it is not already activated.
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Activating the Trace Feature

Trace files give detailed descriptions of all low-level
communications events.  Hexadecimal details of all
communications events are date and time stamped and include
details of options including SDLC framing.  Trace files are useful
for troubleshooting communications.  For information on the
trace feature, see the section called “Trace” on Page 10-29.

To set up a trace:

• From the CQ Configurator screen, activate the Trace check
box if it is not already activated.
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Accessing the Advanced Options

The advanced options available for each configuration may be
different for your version of the CQ-3770EE solution.

To access the Advanced Options:

1. From the CQ Configurator screen, select the Advanced button.
The Advanced Options screen appears.

2. To configure the advanced options, select a folder tab to display
its options.

Note:
For information on the options that came with your
solution, select the Help button associated with each folder
tab or see Chapter 3: Configuration Options.
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Passwords

Setting the Passwords from the
Configurator

Both the Configuration and Run Time Passwords can be
modified from within the Configurator.

Warning:
When you password protect the Configurator or Interface, the
software will always be password protected.  You can change the
password, but you cannot disable password protection.  In order
to run the software without password protection after you have
installed a password, you will need to re-install the software.
Contact CQ Technical Support for more information before
proceeding.

Passwords Overview

The CQ Configurator and Interface screens can be password
protected by the Configuration and Run Time Passwords.  The
configuration data is decrypted dependent upon the proper entry
of either password.  You can set up these passwords through the
Configurator program.

When you first access the Configurator, the CQ Configurator
screen appears if the software is not currently password
protected.  If a screen appears instructing you to enter a
password, the product has already been installed with a
Configuration Password.  You must enter the correct
Configuration Password in order to have access to the
Configurator parameters.

Passwords
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Some administrators may find it useful to give end users access
to only most of the parameters (such as the XID) and not some of
the more sensitive information (such as the Logon).  In this case,
the end user would enter the Run Time Password to have access
to only most of the parameters (the Logon is encrypted).

To modify the Configuration and Run Time
passwords:

1. From the CQ Configurator screen, select the Password button.
The Change Passwords dialog box appears and presents the
Configuration Password and Run Time Password fields
for modification.

2. The password modification process requires the re-entry of the
old password to provide additional security.  The new
password also requires re-entry as confirmation of the new
password since the characters are not displayed.

3. Set the Configuration Password, Run Time Password, and
any options associated with the Run Time Password.

4. Select the OK button.  The CQ Configurator screen reappears.

5. Select the Save button.

Note:
No changes are saved in any of the Configurator screens
until the Save button is selected.

Chapter 2: Configurator
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This chapter explains the communications options associated
with the Configurator program.

Note:
Communications options are located on the Advanced Options
screen of the Configurator program.  Some of these options can
also be found on the CQ Configurator screen.  If you change a
setting on one screen, it will also be changed on the other.

Quick Installation Guide

Your CQ-3770EE solution should have come with a
Quick Installation Guide.  This guide contains detailed
instructions on how to install and configure your CQ
solution.

To install your CQ solution, CQ recommends that
you follow the instructions in the Quick Installation
Guide.  The instructions that appear within the
remainder of this chapter are summary in nature.

Chapter 3: Configuration Options
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Folder Tab Options

Use the following chart for information on the folder tabs for the
CQ-3770EE connectivity solution.

Folder Tab Options Page

IBM Terminal Session Name, Script Name,
Translation Table, Quick Startup 3 - 4

MLU Logon, Signoff, # of LUs,
LU Number 3 - 5

DLU(EE) Minimum Session-Level
Encryption, Trace Decrypted Data 3 - 6

Internal PU XID, Max RU, Master Key Storage
Options (optional) 3 - 8

EE Link

Local CP Name, DLUS Name,
Destination IP, Host SAP Number,
Local SAP Number , Backup DLUS,
Backup IP

3 - 11

Folder Tab Options
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IBM Terminal

The following options make up the IBM Terminal folder tab
options.

• Session Name - This text box contains the current session’s
name.

• Script Name - This text box contains the name of the script
that will automatically run when you initiate the
configuration.  For information on scripting, see
Chapter 9: Scripts.

• Translation Table - This drop-down list displays the
translation table selected for the current configuration.  The
default translation table used by CQ-3770EE is called
<Internal>.  You can edit the STANDARD.XLT
translation table as necessary.  Translation tables perform the
ASCII/EBCDIC conversion necessary for host
communications.

• Quick Startup - Activate this check box if you want the
current configuration to automatically begin communications
when you run the current configuration.

Chapter 3: Configuration Options
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MLU

The  following options make up the Multiple Logical Unit
(MLU) folder tab options.

• Logon - This text box contains the logon command used to
attach the LU to an application.  Many host sites
automatically attach your LU to an application so this option
is not always necessary.  An example of a logon is as follows:

LOGON APPLID(xxx) LOGMODE(BATCH) DATA(RMT###,,password)

In the Logon example above, xxx is the application identifier,
### is the remote number, and password is the password.
These parameters are usually provided to you by your host
site contact.

• Signoff - This text box contains the signoff command.  If
this box contains a value, then CQ-3770EE will automatically
send this card just prior to exiting.  A typical signoff value is
/*SIGNOFF.

• # of LUs - This drop-down list displays the current number
of LUs selected.  The default number of LUs is 6.

• LU Number - These text boxes contain the numbers
assigned to each LU.  You can usually get this number from
your host site contact.  This number identifies the LU to the
host.

By default, each LU Number is left blank.  If you leave the
LU Numbers blank (the default), CQ will automatically
assign them at runtime.  The LU Number may also be
known as the Local Address.

Folder Tab Options
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DLU(EE)

The following options make up the DLU(EE) folder tab options.

• Minimum Session-Level Encryption - You can choose the
minimum setting of session-level encryption for the current
session by selecting one of the option buttons.  This option
specifies the minimum cryptography that is required in the
BIND for CQ-3770EE to accept the BIND.  If an option
button is grayed out, then this form of session-level
encryption was not included with your version of CQ-3770EE.

Note:
The single DES and Triple DES security options are
available as options to CQ-3770EE at additional costs.
Your version of CQ-3770EE may not be equipped with one
of these options.  For information on how to upgrade your
software to CQ-3770EE/DES or CQ-3770EE/Triple DES,
contact your CQ Sales representative.

1. No Encryption - When this option button is selected,
NO session-level cryptography is required.  This
option allows all sessions to be bound.  Sessions do
not have to be encrypted through single DES or
Triple DES encryption in order to be bound.

2. Selective DES Encryption - When this option button is
selected, session-level selective or mandatory
cryptography is required through single DES or
Triple DES encryption.

3. Mandatory DES Encryption - When this option button
is selected, session-level mandatory cryptography is
required through single DES  or Triple DES
encryption.

Chapter 3: Configuration Options
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4. Selective Triple-DES Encryption - When this option
button is selected, session-level selective or mandatory
cryptography is required through Triple DES encryption.

5. Mandatory Triple-DES Encryption - When this option
button is selected, session-level mandatory
cryptography is required through Triple DES encryption.

• Trace Decrypted Data - In the event of communications
problems, you may require a communications log file to be
written.  If the Trace Decrypted Data check box is
activated, the log file for the current session will be written
with un-encrypted data.

Folder Tab Options
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Internal PU

The following options make up the Internal PU folder tab
options.

• XID - This text box contains the Exchange ID (XID)
required for host site connections.  The XID consists of two
parts, the IDBLK (three hexadecimal digits) and the IDNUM
(five hexadecimal digits).  You can usually get the XID from
your host site contact.

• Max RU - This drop-down list contains the maximum data
amount allocated for each block of data transmitted.  You
can select a maximum Request Unit (Max RU) from the list
or enter one directly into the text box.  The Max RU
currently selected appears in the space provided.

Master Key Storage Options

The Master Key Storage Options group box displays the
storage information for the DES Master Keys.  These options
are only available with a Data Encryption Standard (single DES
or Triple DES) version of CQ-3770EE.  If these options are
available, use them to enter one or more Master Keys.  This
information is usually provided to you by your Central Site
contact.  Also, in some cases, partial Master Key information
may have already been entered for you by your Central Site
contact.

Note:
For information on the single DES and Triple DES security
options, see Chapter 11: DES/Triple DES Security Options.
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• Master Key Number - By selecting a Master Key Number
option (1, 2, or 3), the remaining options within the Master
Key Storage Options group box change to display the
information for the selected Master Key Number.

• Keyn Location - This drop-down list displays the location
of the currently selected Master Key Number.

1. NONE - When this option is selected, there is no Master
Key information for the currently selected Master Key
Number.  In other words, you are not implementing this
Master Key Number.

2. Software - When this option is selected, the currently
selected Master Key Number is stored within the CQ
software.

3. Glenco - When this option is selected, the currently
selected Master Key Number is stored within a Glenco
Hardlock device attached to the computer.

4. Jones Card - When this option is selected, the currently
selected Master Key Number is stored within a Jones
Futurex ENC-347 card installed in the computer.

NONE Master Key Storage Options

When the NONE option is selected, there are no additional
options displayed within the Master Key Storage Options group
box.

Software and Glenco Master Key Storage Options

When the Software or Glenco option is selected, the following
additional options are displayed within the Master Key Storage
Options group box.

• Partial Master Keyn - This text box contains the 16
hexadecimal digits that make up the Master Key.  In most
cases, this information will have been provided to you by
your Central Site personnel.  Also, in some cases, partial
Master Key information may have already been entered for
you in this text box by your Central Site contact.

Folder Tab Options
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• Confirm Partial Key - This text box is used to confirm the
16 hexadecimal digits that were entered in the Partial
Master Keyn text box.

Note:
Any digits entered in the Partial Master Key and Confirm
Partial Key text boxes will always be blank when
re-entering the Controller folder tab screen.  There will be
no indication that anything was ever entered into these
fields.  These fields are used only to change, not display,
the Master Key.

• Accept Partial Keyn - This button installs the Partial
Master Key that is entered in the Partial Master Key and
Confirm Partial Key text boxes.

• Clear Master Keyn - This button clears the Partial Master
Key information.

Jones Card Master Key Storage Options

When the Jones Card option is selected, the following additional
options are displayed within the Master Key Storage Options
group box.

• I/O Address - This text box contains the Jones card’s I/O
address.  In most cases, this should have been pre-configured
for you by your Central Site personnel.

• DES Keyn Slot # - This text box contains the Jones card’s
DES key slot number.  In most cases, this should have been
pre-configured for you by your Central Site personnel.

Chapter 3: Configuration Options
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EE Link

The following options make up the EE Link folder tab options.

• Local CP Name - This text box contains the remote fully
qualified local Control Point (CP) name which specifies the
control point of CQ-3770EE.  This should match the name the
node sends on its XIDs. The Local CP Name is usually
provided to you by your host site contact.

The fully qualified CP Name is a 17-byte character string that
consists of three parts.  The first part is a 1- to 8-byte
character string that is the network name.  The second part is
a period that separates the first and third parts.  The third part
is a 1- to 8- byte character string that is the CP Name.

• DLUS Name - This text box contains the fully qualified
Dependent Logical Unit Server (DLUS) name.  The
DLUS Name is usually provided to you by your host site
contact.

The fully qualified DLUS Name is a 17-byte character string that
consists of three parts.  The first part is a 1- to 8-byte
character string that is the network name.  The second part is
a period that separates the first and third parts.  The third part
is a 1- to 8- byte character string that is the DLUS Name.

• Destination IP - This text box contains the destination IP
address of a node in the APPN network that CQ-3770EE will
be communicating with.  The Destination IP is usually
provided to you by your host site contact.

• Host SAP Number - This text box contains the host end
Service Access Point (SAP).  The SAP consists of two
hexadecimal digits.  The default Host SAP Number is 04.
The Host SAP Number is usually provided to you by your
host site contact.

• Local SAP Number - This text box contains the local
Service Access Point (SAP).  The SAP consists of two
hexadecimal digits.  The default Local SAP Number is 04.

Folder Tab Options
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• Backup DLUS - This text box contains the optional fully
qualified backup DLUS name.  In the event that session
establishment fails with the primary DLUS Name, the
Backup DLUS is used in its place.  The Backup DLUS is
usually provided to you by your host site contact.  This
backup setting is optional and is not required for
connectivity.

The fully qualified Backup DLUS is a 17-byte character string
that consists of three parts.  The first part is a 1- to 8-byte
character string that is the network name.  The second part is
a period that separates the first and third parts.  The third part
is a 1- to 8- byte character string that is the DLUS Name.

• Backup IP - This text box contains the optional destination
IP address of Enterprise Extender.  In the event that session
establishment fails with the primary Destination IP, the
Backup IP is used in its place.  The Backup IP is usually
provided to you by your host site contact.  This backup
setting is optional and is not required for connectivity.

Chapter 3: Configuration Options
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This chapter explains how to use the CQ-3770EE software to
communicate with a host site.

Running a Configuration

Before you can use CQ-3770EE to communicate with a host site,
you must have first created a configuration through the
Configurator.  For more information on the Configurator, see
Chapter 2: Configurator.

When you exit the Configurator program after creating a new
configuration, a new program icon appears in the CQ_WIN
program group.  The icon name is the same name that you saved
the configuration as in the Configurator program.  For example,
the configuration that is used in the icon below is called Config1.

To run the Config1 configuration, you would simply select this
icon from the CQ_WIN program group.

4 - 1  Interface Program Icon Example
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To run a configuration:

1. From the CQ_WIN program group that was created during
installation, select the icon for the configuration you want to
run.  For example, if you saved a configuration under the
default name Config1, select the icon called Config1.

2. The next events that occur depend on if the configuration is set
for Quick Startup mode:

• Quick Startup - If the configuration is set for Quick
Startup mode, an Interface screen appears and the
software attempts to connect with the host according to
the communications options that you set through the
Configurator program.

• NOT Quick Startup - If the configuration is not set for
Quick Startup mode, the CQ Session Status screen
appears.  You can use this screen to open (i.e., run) the
configuration when you are ready to connect with the
host.

3. In most cases, users have their configurations setup in Quick
Startup mode which in turn automatically runs a script the
user has specified within the configuration.  In these cases,
the Interface screen is minimized in the Windows desktop’s
taskbar (unless otherwise instructed in the script to appear in
a maximized format) and the CQ Script screen will appear as
the script begins to run.

Note:
For more information on Quick Startup mode, see the
section called “Setting Quick Startup” on Page 2-25.  For
more information on the CQ Script screen, see Chapter 9:
Scripts.

Running a Configuration
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Special Note for Password Protected Users

If the Interface screen has been password protected, a screen will
appear that requests entry of the Run Time Password.  Once the
Run Time Password has been entered, the Interface screen
explained in the next section appears.

For information on password protecting the Interface screen, see
the option called “Password” on Page 2-9.

Entering a New Run Time Password

In some cases involving the Run Time Password, you may have
the option of entering a new Run Time Password.

For example, if the Allow user to change at run time and/or
Require user to change on the first time execution check
boxes on the Change Passwords screen explained on Page 2-10
are activated, then a dialog box appears instructing you to enter
the Old Password as well as a New Password.

If this occurs, enter the Old Password and select the OK button.
Then, enter a New Password and confirm the New Password.
When you have successfully confirmed the New Password, the
Interface screen explained in the next section appears.

Chapter 4: Solution Operation

4 - 4



Interface Screen

The Interface screen is where all communications occurs.  Every
configuration is accessed through a separate Interface screen.

The Interface screen appears each time a program icon for a
configuration that is set in Quick Startup mode is accessed.
Program icons for each configuration are created through CQ’s
Configurator program.

4 - 2  Interface Screen
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Interface Screen Description

The Interface screen consists of five parts.

1. Title Bar

The title bar is the horizontal bar at the top of the Interface screen
that contains the session name and the current connection mode.
If the configuration is not connected to the host, the term Local
will appear as the connection mode.  If the configuration is
connected to the host, the term CQ In/Out Bound will appear as
the connection mode.

2. Menu Bar

The menu bar is the horizontal bar located just below the title bar
that contains the names of the menus, including File, Edit,
Transfer, Options, and Help.

3. Toolbar

The toolbar is the horizontal bar located just below the menu bar
that contains the icon buttons.  These buttons initiate the
commands that are associated with them.  Think of toolbar
buttons as shortcut commands.  Another part of the Interface
screen similar to the toolbar is the SmartKey Pad.  This pad is
independent of the Interface screen and may appear anywhere on
your computer’s desktop.
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4. Console Area

The console area is the large rectangular area located below the
toolbar.  Connectivity with the host site occurs within the console
area.

The Interface screen appears in CQ In/Out Bound mode when
you are connected with the host.

Once you have connected with the host, the console area in
CQ In/Out Bound mode is divided into three parts:  Status,
OutBound Console, and InBound Console.

4 - 3  Interface Screen in CQ In/Out Bound Mode
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• Status - Contains status messages about the operation of the
current session.  This information is divided into five
columns:

1. Device - The type of device the session is emulating.
2. Current Status - The current status of the corresponding

device, such as End, Closed, etc.
3. File Destination - The name of the file that the data is

being transmitted to.
4. Number of Bytes - The total number of bytes transmitted.
5. Percentage of Bytes Sent - The percentage of the bytes

transmitted.

Note:
Some of the columns explained above may appear without
a value during transmissions.  Blank values are caused by
insufficient information and DO NOT effect the speed or
accuracy of file transfers.

• OutBound Console - Contains the outbound console data
transferred with the host.  Any command that you enter in
the InBound Console area also appears in the OutBound
Console area.

• InBound Console - Use this area to send commands to the
host.  Once you have entered a command into the InBound
Console area, it is then displayed in the OutBound Console
area.

Note:
The InBound Console area of the console area will not
appear until after you have established a connection with
the host.
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5. Status Line

The status line is the horizontal bar located at the bottom of the
Interface screen.  This bar displays information on the status of
the current session, data transfer events, and other
communications information.

The status line consists of six fields that display information
messages about the particular area that they monitor.

Field 1. Insert/Overwrite Status - This field indicates if the
InBound Console area of the Interface screen is in
Insert (INS) or Overwrite (OVR) mode.  Insert mode
inserts the text you type into the console area at the
cursor location, while the Overwrite mode causes the
text you type at the cursor location to be placed over
any existing text.  You can toggle between these
modes by pressing the [INSERT] key.

Field 2. Terminal Identification - This field displays the LU
Name your host staff uses to identify the session.

Field 3. EMPTY - This field is empty.  It is not used by
CQ-3770EE.

Field 4. Field Attribute - The field attribute status displays if
the Interface screen is password protected or not.  If
the screen is not password protected, this field will
be blank.  Otherwise, the message Password will
appear in this field and the contents of the Interface
screen will not be visible.

Field 5. Communications Status - This field shows the
current status of communications with the host.  Use
the lists on the next few pages for detailed
explanations of the abbreviated status codes and
other messages that appear in this field.

4 - 4  Sample Status Line with Numbered Fields

   1                 2                      3                  4                        5                       6
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Status Line Messages

Abbreviated Messages

• INA (Communications Inactive) - There is currently no
connection with the host.  This message appears when the
program is first loaded and run.  It indicates that
communications has not yet been established.

• CNT (Connecting) - The session is connecting with the host.

• PRB (Communications Problem) - Communications was
established but has stopped for some reason.  Many different
hardware and software problems such as modem failure, a
bad phone line, or too high a data rate can cause this
message.

• IDL (Communications Idle) - The systems are in contact,
but no transmissions have been received for more than six
seconds.  The link may be gone or the host response time
may be slow.

• XID (Exchange ID Sent) - Each session responds to the
host and sends Exchange ID (XID).  If XID continues to
appear on the status line, your XID was refused.  Try again,
or contact the host site personnel for assistance.

• ACT (Communications Active) - This message indicates
that CQ-3770EE and the host are connected and ready to
transmit data.

Long Messages

• BUSY - The number that you are calling is busy.

• DIAL TONE DETECTED - This message indicates that a
dial tone is detected, and that dialing is in process.

• INTERNAL ERROR - No internal error messages should
occur.  Write down the message error code, and contact CQ
Technical Support.
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• MODEM FIRMWARE VERSION INCOMPATIBLE -
If the modem firmware has changed so that it is
incompatible, this message will be displayed.

• NO TONE DETECTED - The modem did not ‘hear’ a dial
tone on the phone line.  Check to be sure that the phone line
is connected and operational.

• NO TONE DETECTED - After issuing a dial command,
the modem sends status updates to the dial program.
Absence of an update for thirty seconds results in this
message.

• RING - The number that you are calling is ringing.

• MODEM REJECTED THE DIAL COMMAND - This
error occurs if you have invalid digits in the phone number.
Valid digits include numbers zero through nine (0-9),
asterisk (*), number sign (#), comma (,), space, the letters T
and P, and a hyphen (-).  Check your modem documentation
for a valid character.

• TRANSMIT TIMEOUT - A Transmit timeout error occurs
if there is no sign of a proper response from the modem.
Probable causes include the address of the modem is set
incorrectly, the address of the modem was entered
incorrectly during installation of CQ-3770EE, there is an
address conflict with another board, you have used the
wrong COM port (with the async version only), or there is a
modem problem.  This message does not occur with a
properly installed modem.

• UNEXPECTED RESPONSE FROM MODEM - This
message occurs if the modem does not respond properly, or
rejects a command.

• WAITING FOR DIAL TONE - The modem has taken
control of the phone line, and is awaiting a dial tone.

Interface Screen
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Field 6. Cursor Position - This field is the last portion of the
status line.  It shows the current position of the
cursor in InBound Console area of the Interface
screen.  The format is as follows:

• Row,Column

For example, if the cursor is in the upper left hand
corner, the Cursor Position field will display 1,1.
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CQ Session Status Screen

The CQ Session Status screen appears when you access a
configuration that is not set in Quick Startup  mode.  This screen
reports the status (open or closed) of the configuration.

Note:
When you run a configuration set for Quick Startup, the software
automatically dials into and connects with the host site.  CQ
recommends that you activate the Quick Startup check box for
each configuration that you create.  For more information, see
the section called “Setting Quick Startup” on Page 2-25.

To open a configuration from the CQ Session
Status screen:

1. Select the configuration that you want to open from the
CQ Session Status screen.

2. Select the Open button.  The Status column changes from
Closed to Open and the Interface screen for the
configuration appears.  The CQ Session Status screen will be
minimized in the taskbar when one or more configurations is
running.

4 - 5  CQ Session Status Screen
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Running a Script Using the
Interface Command Line

To run a script using the Interface command line, you will need
to enter the command from the directory that you installed
CQ-3770EE under, from another program, or from a DOS batch
file.  For more information on scripting, see Chapter 9: Scripts.

For example, if the directory that you installed the software into
is called c:\cq3770, type the command cd c:\cq3770 at any DOS
prompt to return to that directory.

The format of the command line is as follows:

CQMULATE <configuration name> [options]

Command Line Description

• <configuration name> - The configuration name is required.
It is the name of the configuration file you specified.  If you
did not specify a name while running the Configurator, the
default name supplied is config1.cqc.  The extension is
always .cqc and is not required as it is automatically added
onto the filename.

• [options] - There are three options available.  If more than
one option is used, separate each one of them with a space.

1. /T= - Create and run a trace file.  This file is created each
time the Interface is executed in CQ In/Out Bound
mode.  Any previously existing file of the same name
will be overwritten.  The file name immediately
follows the equals sign (=) (i.e., /T=mytrace.cqt).  If
the extension is not supplied, .cqt will be appended to
the filename (i.e., mytrace.cqt).
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2. /A= - Create an audit file.  This file contains the summary
of date and time stamped communications events.  A
new audit file is created for each communications
session.  Any previously existing file of the same name
will be overwritten.  The file name immediately follows
the equals sign (=) (i.e., /A=myaudit.cqa).  The
extension is always .cqa.

3. /S= - Execute a script file.  This file must exist and have
been created by using the scripting language.  For
example, in the command /S=myscript, myscript is the
name of the script file created.  The extension is always
.cqs and need not be supplied.  For more information on
scripting, see Chapter 9: Scripts.

4. /K - Closes an open Interface screen so that a new Interface
screen can open.  This command can be used as long as
both Interface screens (the one being closed and the one
being opened) are opened through the same
configuration file.  This command helps to avoid
conflicts between two open Interface screens accessed
through the same configuration file.  This is especially
useful for users that launch CQ-3770EE from another
program in order to run CQ-3770EE in unattended mode
from a script.

Command Line Example

In the following example, the Interface will run with the
configuration file config1.cqc and will run with the script named
myscript.cqs.  An audit file will also be created and will be
called myaudit.

CQMULATE config1 /S=myscript /A=myaudit

A command line such as the example above would be used in the
calling program, entered as a line in a DOS batch file, or typed at
a command line prompt in a DOS window.

Running a Script Using the Interface Command Line
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This chapter explains how to use the printing features associated
with CQ-3770EE.

Print Commands

The print commands are located in the File menu bar option of
the Interface screen.  CQ-3770EE allows you to print the contents
of the OutBound Console area of the Interface screen through
these commands.  The OutBound Console area contains the
outbound console data transferred with the host.

Print commands include:

• Print Screen to Printer - Use this command to send the
contents of the Interface screen’s OutBound Console area
to the connected printer.  This command is also available as
a toolbar button.

• Print Screen to File - Use this command to save the
contents of the Interface screen’s OutBound Console area
to a file.  This command is also available as a toolbar button.

• Print Screen Set Up - Use this command to access the Print
Screen Customization dialog box.  From this dialog box, you
can change the settings associated with printing to a file (i.e.,
saving the screen) or printing to a printer.  This command is
also available as a toolbar button.

The directions in this chapter explain how to setup CQ-3770EE to
print the contents of the OutBound Console area to a printer or
save the contents to a file.
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Print Screen Customization

The File > Print Screen Set Up menu bar command accesses the
Print Screen Customization dialog box.  From this dialog box,
you can change the settings associated with printing the contents
of the OutBound Console area to a file (i.e., saving the screen)
or a printer.

5 - 1  Print Screen Customization Dialog Box
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Print Screen Customization Options

• Print Setup - This button accesses the Print Setup dialog
box.  From this dialog box, you can set printer options such
as printer properties, paper size and source, and page
orientation.

• Raw Line Print - When this check box is selected, all data
is sent to the printer as raw print data.  This is useful when
printing to generic text, line, dot matrix, and similar printers.

• Filename - This field displays the name of the file you are
printing to on your computer.  The Filename includes the
entire pathname, including all directories and subdirectories.

• Browse - This button accesses the Browse dialog box where
you can select a file already saved on your computer.  The
filename that you choose in this dialog box is displayed in
the Filename area, including all directories and
subdirectories.

• Prompt for Filename - When this check box is selected,
you will be prompted for a filename each time you print the
OutBound Console text to a file.

• Append - When this check box is selected, the OutBound
Console text being printed to a file is appended to a file by
the same name already on the computer.
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Setting the Print Screen Options

Before you print, it is recommended that you first check your
print options on the Print Screen Customization dialog box.

To customize for prints to a file:

1. Access the Print Screen Customization dialog box:

• Select the File > Print Screen Set Up menu bar
command.

• Select the Customize Screen Prints toolbar button

.

2. Select the Browse button to change the Filename displayed.
The Filename includes the entire pathname, including all
directories and subdirectories.

3. To be prompted for a filename each time you print to a file,
activate the Prompt for Filename check box.  To print to
the default filename each time you print (this includes
overwriting), do not activate the Prompt for Filename
check box.

4. To append the contents being printed to a file by the same name
already on the computer, activate the Append check box.  To
overwrite a file with the current contents being saved, do not
activate the Append check box.

5. Select OK.

Print Screen Customization
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To customize for prints to a printer:

1. Access the Print Screen Customization dialog box:

• Select the File > Print Screen Set Up menu bar
command.

• Select the Customize Screen Prints toolbar button

.

2. To check the printer options, select the Print Setup button.
These options include the printer properties, paper size and
source, and page orientation.

3. To send data to the printer as raw data, activate the Raw Line
Print check box.  This is useful when printing to generic
text, line, dot matrix, and similar legacy-type printers.

4. Select OK.
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Printing to a File

CQ-3770EE allows you to print (i.e., save) the contents of the
OutBound Console area of the Interface screen to a file.  The
OutBound Console area contains the outbound console data
transferred with the host.

Before you print to a file, make sure your print options are set
correctly.  To check your print options, access the Print Screen
Customization dialog box.  Print options include the filename to
print to, prompting for a filename, and appending to an existing
file.

Once you have checked your print options, there are two ways to
print the OutBound Console text to a file:

To print to a file using the menu bar:

• Select the File > Print Screen to File menu bar command.

To print to a file using the toolbar:

• Select the Save Screen to File toolbar button

.

Printing to a File
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Printing to a Printer

CQ-3770EE allows you to print the contents of the OutBound
Console  area of the Interface screen to a printer.  The OutBound
Console  area contains the outbound console data transferred with
the host.

Before you print to a printer, make sure your print options are set
correctly.  To check your print options, access the Print Screen
Customization dialog box.  Print options include the print setup
options (i.e., destination, orientation, etc.), printing NUL lines,
and form feeding after each screen print.

Once you have checked your print options, there are two ways to
print the OutBound Console text to a printer:

To print to a printer using the menu bar:

• Select the File > Print Screen to Printer menu bar
command.

To print to a printer using the toolbar:

• Select the Print Screen to Printer toolbar button

.
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This chapter explains how to use the edit features associated with
CQ-3770EE.

Edit Commands

The edit commands are located in the Edit menu bar option of
the Interface screen.  CQ-3770EE allows you to manipulate the
contents of the OutBound Console area of the Interface screen
through these commands.  Use the table below to find
information on each command.

Command Page

Copy 6 - 3

Append 6 - 4

Select All 6 - 5

View Clipboard 6 - 6
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Copy Command

The Copy command duplicates the selected area of OutBound
Console text to the Clipboard.  The Copy command does not
delete the selected area from the OutBound Console area.

To copy text using the menu bar:

1. Select the text you want to copy by holding the left mouse
button and dragging the mouse across the OutBound
Console text.  A box appears around the text you selected.

2. Select the Edit > Copy menu bar command.

3. The text has been copied to the Clipboard.

To copy text using the toolbar:

1. Select the text you want to copy by holding the left mouse
button and dragging the mouse across the OutBound
Console text.  A box appears around the text you selected.

2. Select the Copy toolbar button .

3. The text has been copied to the Clipboard.
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Append Command

The Append command duplicates the selected area of the
OutBound Console area to the Clipboard.  If there is already
text in the clipboard, the Append command appends the new text
to it.  The Append command does not delete any text from the
OutBound Console area.  Appended text is copied to the
clipboard in a position immediately after the text that is already
present in the clipboard.

To append text to other text already in the
Windows Clipboard using the menu bar:

1. Select the text you want to append by holding the left mouse
button and dragging the mouse across the OutBound
Console  text.  A box appears around the text you selected.

2. Select the Edit > Append menu bar command.

3. The text has been appended to any text already in the Clipboard.

To append text to other text already in the
Windows Clipboard using the toolbar:

1. Select the text you want to append by holding the left mouse
button and dragging the mouse across the OutBound
Console  text.  A box appears around the text you selected.

2. Select the Append toolbar button .

3. The text has been appended to any text already in the Clipboard.
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Select All Command

The Select All command selects all of the text within the
OutBound Console area.

To select all of the text using the menu bar:

1. Select the Edit > Select All menu bar command.

2. All of the text is selected.  A box appears around the entire
OutBound Console area.  You can now use one of the other
Edit commands to copy, append, etc. the selected text.

To select all of the text using the toolbar:

1. Select the Select All toolbar button .

2. All of the text is selected.  A box appears around the entire
OutBound Console area.  You can now use one of the other
Edit commands to copy, append, etc. the selected text.

Edit Commands

6 - 5



View Clipboard Command

The View Clipboard command accesses the Clipboard Viewer.
The Clipboard Viewer enables you to view the contents of the
Clipboard.

Note:
If the View Clipboard command is grayed out, then the
Clipboard Viewer is not installed on your computer.  To install
the ClipBrd.exe program, consult the Help files for your
Windows operating system.

To view the clipboard using the menu bar:

• Select the Edit > View Clipboard menu bar command.

To view the clipboard using the toolbar:

• Select the View Clipboard toolbar button .
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This chapter explains how to use the data transfer features
associated with CQ-3770EE.

Transfer Commands

The Transfer menu bar option from the Interface screen accesses
the features associated with sending data from the PC to the host
and receiving data from the host to the PC.  From this menu bar
option, you can select one of the following commands:

• Send File - Use this command to access the Send Data
dialog box.  From this dialog box, you can change the
settings associated with sending data from your PC to the
host.  This command is also available as a toolbar button.

• Receive Print Data - Use this command to access the
Receive Data dialog box.  From this dialog box, you can
change the settings associated with receiving data from the
host to your PC.  This command is also available as a toolbar
button.

Note:
The Receive File command is grayed out for the CQ-3770EE
program.  It is used to initiate IND$FILE file transfer sessions in
CQ’s interactive CQ-3270 software program.
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Send Data

The Transfer > Send File menu bar command accesses the Send
Data dialog box.  From this dialog box, you can change the
settings associated with sending data from your PC to the host.

7 - 1  Send Data Dialog Box
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Send Data Options

• Filename - This field displays the name of the file you are
sending to the host.  The Filename includes the entire
pathname, including all directories and subdirectories.

• Browse - This button accesses the Open File dialog box
where you can select a file already saved on your computer.

• File Type - Use these option buttons to choose if the file will
be Text or Binary.

• Record Size - This text box displays the size of the record.
For text data, the Record Size represents the maximum
record size.  For binary data, the Record Size is absolute.
The maximum record size is 256.

• Send As - Use these option buttons to choose the format you
want to send the file.  If you need to send records larger than
128 bytes and the host specifies Exchange data, then choose
Exchange.  Otherwise, it should be left as Card Reader.

• More Data to Follow - When this check box is activated,
multiple files are appended into a single file from the host’s
perspective.

• OK - Select this button to send data to the host.
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Setting the Send Data Options

Before you send data to the host, it is a good idea to check your
send options in the Send Data dialog box.

To set your send options:

1. Access the Send Data dialog box:

• Select the Transfer > Send File menu bar command.

• Select the Send File to Host toolbar button .

2. Enter or select a filename.  If the filename you want to send is
not in the drop-down list, select the Browse button to access
a file already saved on the computer.

3. Select the file type, either text or binary.

4. Select the form to send the file as, either card reader or
exchange.

5. Indicate the record size.

6. If more data is to follow this file at a later time, select the More
Data to Follow check box.

Send Data
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Sending Data

Before you send data to the host, make sure your send options are
set correctly.  To check your send options, access the Send Data
dialog box.

Once you have checked your send options, there are two ways to
send data.

To send data using the menu bar:

1. Select the Transfer > Send File menu bar command.

2. Select the OK button to start the transfer.

To send data using the toolbar:

1. Select the Send File to Host  toolbar button .

2. Select the OK button to start the transfer.
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Receive Print Data

The Transfer > Receive Print Data  menu bar command
accesses the Receive Data dialog box.  From this dialog box, you
can change the settings associated with receiving data from the
host.

7 - 2  Receive Data Dialog Box
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Receive Data Options

• Device Select - This drop-down list contains the name of the
device(s) currently selected.

• To Printer - When this check box is activated, any printer
data that you receive from the host will be redirected to the
currently selected printer.

• To File - When this check box is activated, any printer data
that you receive from the host will be redirected to a file that
you specify in the Filename text box.

• To Window - When this check box is activated, any printer
data that you receive from the host will be redirected to the
display window.

• Punch - Select this button to access the Receive Data -
Punch Options dialog box.

• Form - Select this button to access the Receive Data - Form
Options dialog box.

• Print Setup - This button accesses the Print Setup dialog
box.  From this dialog box, you can set printer options such
as the destination, page orientation, paper size, and paper
source.

• Raw Line Print - When this check box is selected, all data
is sent to the printer as raw print data.  This is useful when
printing to generic text, line, dot matrix, and similar printers.

• Maximum Number of Lines  - This text box displays the
maximum number of lines that the Interface reserves for the
display window.

• Filename - This drop-down list contains the names of the
most recently received files from the host.  These are the
names as they appear on your computer.  The name of the
file currently selected to be received appears in the space
provided.  You can change this name by selecting from the
drop-down list, typing in a new name, or using the Browse
button to browse your computer for the filename.
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• Browse - This button accesses the Open File dialog box
where you can select a file already saved on your computer.

• Keep Appending - When this option button is activated, if
more than one file is being sent from the host, then all of the
data is appended into the designated filename that appears in
the Filename text box.

• Close File at End of Job - When this option button is
activated, the filename specified in the Filename text box is
automatically closed after a file is received from the host and
written to it.  Also, the To File check box becomes
deselected to prevent appending to or overwriting that file.

• Auto Increment File Extension - When this option button
is activated, CQ’s Automatic File Naming (AFN) feature is
activated.  There are several ways to use the AFN feature.
These are explained in the section called “Automatic File
Naming” on Page 7-10.

• Advanced - Select this button to access the Receive Data to
File - Advanced Options  dialog box.

Receive Print Data
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Automatic File Naming

To activate the Automatic File Naming (AFN) feature for
incoming printer data from the mainframe, activate the Auto
Increment File Extension option button on the Receive Data
dialog box.

The AFN feature is useful when you do not know exactly how
many files you will be receiving or if you have a large number of
files and do not want to name them one at a time.  There are
several ways to use the AFN.

AFN with No Specified Numeric Extension

If the filename that you entered in the Filename text box does
not have an extension, AFN creates a new filename for each
incoming file using the filename you specify and a three-digit
extension plus one.  The first three-digit extension is .000 or the
next available numeric extension in that subdirectory.

For example, if the filename you specify is called data and you
are receiving three files from the mainframe, they will be called
data.000, data.001, and data.002.

Note:
If a non-numeric extension exists, it will be replaced with a
numeric extension.
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AFN with a Specified Numeric Extension

If the filename that you entered in the Filename text box has an
extension, AFN creates a filename and numeric extension you
specify to receive the first downloaded file.  Then, AFN creates
the next filename for each incoming file using the filename you
specify and the three-digit extension plus one.

For example, if the filename you specify is called data.555 and
you are receiving three files from the mainframe, they will be
called data.555, data.556, and data.557.

Note:
If a file has a .999 extension, AFN names the next file with a .000
extension.
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Setting the Receive Print Data
Options

Before you receive print data from the host, it is a good idea to
check your receive print data options in the Receive Data dialog
box.

To set the receive print data options:

1. Access the Receive Data dialog box:

• Select the Transfer > Receive Print Data menu bar
command.

• Select the Receive Print Data from Host toolbar button

.

2. Select the name of the device that the data being received is
going to.

3. Select which devices you want the data to be redirect to,
including the Printer, File, and/or Window.

4. Set the options associated with the device(s) you selected in
Step 3. 

5. If you need to set the more advanced punch data receive
options, select the Punch button to access the Receive Data -
Punch Options dialog box.

6. If you need to set the more advanced form data receive options,
select the Form button to access the Receive Data - Form
Options dialog box.
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7. If you need to set the more advanced receive data to file
options, select the Advanced button to access the Receive
Data to File - Advanced Options dialog box.

Note:
The next several sections explain the options associated with the
dialog boxes referenced in Steps 5 through 7.  If you do not need
to set these options, turn to the section called “Receiving Print
Data” on Page 7-20 for instructions on how to receive print data.

Receive Print Data

7 - 13



Receive Data - Punch Options Dialog
Box

The Punch button from the Receive Data dialog box accesses the
Receive Data - Punch Options dialog box.  From this dialog box,
you can change the settings associated with receiving punch data.

7 - 3  Receive Data - Punch Options Dialog Box
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Receive Data - Punch Options

• Record Size - This text box displays the default record size.
This record size is used if the host specifies a default size.
Otherwise, the host specified record size is used.

• Translate To ASCII - When this check box is activated,
EBCDIC files will be translated to ASCII format.  This box
must be activated if the first punch data file is a text file in
EBCDIC.

• Terminate Records w/ CRLF - When this check box is
activated, each record will end with a Carriage Return Line
Feed (CRLF).

• Blank Fill Records - When this check box is activated, short
records are blank filled to the indicated Record Size.

Receive Print Data
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Receive Data - Form Options Dialog
Box

The Form button from the Receive Data dialog box accesses the
Receive Data - Form Options  dialog box.  From this dialog box,
you can change the settings associated with receiving form data.

7 - 4  Receive Data - Form Options Dialog Box
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Receive Data - Form Options

• Use FCB name specified by Host - When this check box is
activated, the Form Control Buffers (FCBs) will be set to the
host’s specifications.  If it is not activated, then the FCBs
will be set according to the default settings.  FCBs are used
to specify vertical margins and tab stops for different types
of forms you may use on your printer.

• FCB Name - This drop-down list contains the names of
FCBs you have used.

• New - Select this button to add a new FCB name to the FCB
Name drop-down list.  The name of this new FCB name is
Formx, where x is the number given to the next new FCB
name that you create for the current session.  For example,
each new session is preset with one FCB name that cannot
be deleted called Default.  If you select the New button,
another FCB name called Form1 is created.  New FCB
names are preset with the default settings for your version of
CQ-3770EE.

• Delete - Select this button to delete the FCB name displayed
in the FCB Name drop-down list.

• Lines Per Page - This text box contains the total number of
lines of printer data on one page.

• Margins - The Top and Bottom text boxes contain the
margins for the top and bottom of one page.

• Vertical Tab Stops - These text boxes contain the vertical
tab stops 2 through 12 (vertical tab 1 always goes to the top
margin of the page).

• Maximum Characters Per Line - This text box contains
the maximum number of characters per line.

• Characters Beyond Maximum - Use these option buttons
to Wrap or Truncate any characters that exceed the
maximum number of allowed characters per line.
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Receive Data to File - Advanced
Options Dialog Box

The Advanced button from the Receive Data dialog box accesses
the Receive Data to File - Advanced Options dialog box.  From
this dialog box, you can change the settings associated with
receiving advanced file data.

7 - 5  Receive Data to File - Advanced Options Dialog Box
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Receive Data to File - Advanced Options

• Ignore - When this option button is activated, there will not
be any form or job names used when receiving data.

• Form Name from any PDIR - When this option button is
activated, the filename that you specified in the Receive Data
dialog box will be treated as a backup if there is no form
name specified in the Peripheral Data Information Record
(PDIR).

• Form Name from Job Separator PDIR - When this option
button is activated, the data following the Job Separator
header (i.e., a banner page) can be written to a separate file
with the form name found in the PDIR.

• Job Name from any PDIR - When this option button is
activated, the filename that you specified in the Receive Data
dialog box will be treated as a backup if there is no job name
specified in the PDIR.

• Job Name from Job Separator PDIR - When this option
button is activated, the data following the Job Separator
header (i.e., a banner page) can be written to a separate file
with the job name found in the PDIR.
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Receiving Print Data

Before you receive print data from the host, make sure your
receive print data options are set correctly.  To review your
receive options, access the Receive Data dialog box.

Once you have reviewed your receive print data options, you are
ready to receive print data.

To receive print data:

• Contact your host site.  Instruct the site that you are ready to
receive their print data.
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This chapter explains how to use the view functions associated
with the toolbar and SmartKey Pad of CQ-3770EE.

View Commands

The Options > View menu bar option from the Interface screen
accesses the features associated with showing or hiding the
toolbar and SmartKey Pad.  From this menu bar option, you can
select the View command:

• View - Use this command to either show or hide the toolbar
or SmartKey Pad.

• Toolbar - This option functions as a toggle.  If there is a
check mark next to it, the toolbar will appear on the
Interface screen.  This command is also available as a
toolbar button.

• SmartKey Pad - This option functions as a toggle.  If
there is a check mark next to it, the floating SmartKey
Pad will appear on the computer’s desktop.  This
command is also available as a toolbar button.

For more information on the toolbar and the SmartKey Pad
features of the Interface screen, see Chapter 10: Advanced
Options.
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Viewing the Toolbar

The View > Toolbar option functions as a toggle.  The toolbar
appears just below the Interface screen’s menu bar.

To view the toolbar:

• Select the Options > View menu bar command and make
sure that there is a check mark next to the Toolbar option.

To hide the toolbar:

• Select the Options > View menu bar command and make
sure that there is not a check mark next to the Toolbar
option.

Note:
To quickly hide the toolbar, select the Hide Toolbar

toolbar button .
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Viewing the SmartKey Pad

The View > SmartKey Pad option functions as a toggle.  The
SmartKey Pad appears on your desktop as a separate floating
window.

To view the SmartKey Pad:

• Select the Options > View menu bar command and make
sure that there is a check mark next to the SmartKey Pad
option.

To hide the SmartKey Pad:

• Select the Options > View menu bar command and make
sure that there is not a check mark next to the SmartKey
Pad option.

Note:
To quickly view or hide the SmartKey Pad, select the

Toggle SmartKey Pad toolbar button .
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This chapter explains how to create, modify, and run scripts
within CQ-3770EE.

Scripts Overview

A script is a series of instructions that accomplish a particular
task and can be launched easily within CQ-3770EE.  Once a script
is launched, it is executed without any further input from the
user.  Scripts can be written from within CQ-3770EE through the
Options > Script menu bar option of the Interface screen.

The CQ Scripting Language consists of several useful and
powerful commands.  These script commands are entered within
the Script Text Area of the Script Editor dialog box explained
later in this chapter.
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Script Design

The structure of a CQ script is one command per line.  The
general format of the script commands appear as follows:

COMMAND parameters

• COMMAND is the name of the CQ scripting command.

• Parameters can be any combination of device names, file
names, event names, or strings.  Multiple parameters are
separated by at least one space.  Parameters may be optional
depending on the scripting command.

Spaces in front of commands are ignored allowing for
indentation.  You can use spaces to help clearly document a script.
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Script Programming Styles

The CQ Scripting Language provides the script programmer with
two styles of programming that are based on the way they are
executed.  CQ scripts can be either executed Line-by-Line or
Event Driven.

Line-by-Line

With the Line-by-Line execution programming style, each task is
accomplished before moving to the next.  This style is best used
for short scripts that consist of commands for sending and/or
receiving files.

The following script sends a signon, waits to receive a file, and
ends the script without ending communications.

SEND signon
WAIT_FOR SEND_COMPLETE
RECEIVE mydata.txt
WAIT_FOR RECEIVE_COMPLETE
EXIT

Event Driven Execution Style

With the Event Driven execution programming style, the code is
focused on the tasks to be accomplished for each event
independently of the others.  This is accomplished by the WHEN
and OR_WHEN commands.  As the command name suggests,
the code following the WHEN and OR_WHEN is the code
executed when the event happens.  For any given phase of the
script, including scheduling calls, establishing the
communications link, sending and receiving files, and
terminating the communications link, there can be a collection of
WHEN commands for each anticipated event.
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A collection of WHEN commands have the following format:

WHEN <event1>
(an unspecified number of script lines for event1 tasks)

OR_WHEN <event2>
(an unspecified number of script lines for event2 tasks)

OR_WHEN <event3>
(an unspecified number of script lines for event3 tasks)

OR_WHEN <event4>
(an unspecified number of script lines for event4 tasks)

END_WHEN

Execution of the script is suspended at the END_WHEN until
one of the events (event1, event2, etc.) occurs.  After a WHEN
event occurs, all of the WHEN commands preceding the
END_WHEN command are disabled and the point of execution
begins with the first line following the END_WHEN command.
If there is no first line, the script terminates while
communications remains active.  Structurally, the lines of code
following a given WHEN command are executable for that
WHEN command until an END_WHEN or OR_WHEN
command is encountered.  Therefore, only the code for that
WHEN command event is executed.  A GOTO command can be
used to reinstate a wait for the next event for same set of WHEN
commands.

Note:
For more information on the WHEN commands, see the section
called “WHEN Commands” on Page 9-36.
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Script Writing Advice

• Pad the script.  Add a comment line at the end of your
script.  The last line will not be executed so a non-essential
line is needed to pad the script.

• Review and test the script.  Make sure your script follows
the communications events properly.  CQ suggests that you
review the audit file after you go through the
communications process manually.

For example, use the menus to send and receive files after you
make your connection.  Also, use the ANY device option for
the manual trial.  The incoming devices will be specified in
the audit file.  After a successful completion of this process,
review the audit file.  It will show all messages received from
the mainframe as CONSOLE data, your receive files coming
in on the devices of CONSOLE1, PRINTERx, or PUNCHx,
and your files sent by name and device.  Your script should
model these events.

• Be careful when using the WAIT_FOR commands.  Trap
all errors and use the INACTIVITY command to avoid
waiting indefinitely for an event that will not happen.  For
example, when sending a file with the SEND command, the
loss of communications may not generate an error.  If you
use a WAIT_FOR command, the script might end up waiting
and unacceptably long period of time.  Use WHEN
commands instead of WAIT_FOR commands in this
situation.  WAIT_FOR commands are best used with
TIMER commands.

• Limit each line of a script to only 200 characters.  Do not
exceed 200 characters on any line of a script.
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• DO NOT nest calls within a script.  This can occur when
using the CALL, WHEN, or IF commands.  Inadvertent
nesting can also happen when you use a GOTO command
from a CALLed subroutine.  For example, if you use the
CALL command to call another portion of the script, you
must first return to the original script location using the
RETURN command before you can place another call.

• DO NOT send and receive at the same time.  The only
time it is recommended that you try and send and receive at
the same time within a script is if you have more than one
Logical Unit (LU).

Note:
The number of LUs that you have are listed in the audit
file.  An audit file is created if the Audit check box from the
Configurator program is activated.  For information on
how to use and read Audit files, see the section called
“Audit Files and Scripts” on Page 10-28.

Common Scripting Questions

• What is a device?  A device can be thought of as a channel,
path, or connection type.  A device name identifies a
particular channel on which the data flows.

• How is received and sent data assigned?  All received data
arrives “on” a device assigned by the host end.  All sent data
arrives “on” a device assigned by you.
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Script Samples, Tips, and Hints

The information below gives brief descriptions of the sample
scripts, script fragments, tips, tricks, and hints that were copied to
the CQ-3770EE main directory you specified during installation.
You may be able to use these files to customize your CQ-3770EE
software to your specific project requirements.  These files are
located in the examples subdirectory.

Some of these files include:

• complex.cqs - This file is a full script that, on a schedule,
connects, waits for a possible start up message, sends a file,
and then waits for any number of files.  It then sends a
signoff and waits for confirmation.  The script then
disconnects and returns to the scheduling.  The script has
been written with error trapping and demonstrates the use of
audit entries.

• dial.cqs - This script displays detailed error messages about
the connection and opens a prompt for manual commands.

• schedule.txt - This file explains a few ways in which
scheduling and “connecting and sending when a file is
ready” can be achieved from a script.  The instructions are
written as script code fragments and are intended to
demonstrate features that may be useful to your operation.

• simprecv.cqs - This script assumes an auto-answer
configuration.  When the connection is made, the script
receives one or more files and then returns to auto-answer
mode.

• task.txt - This file contains some example uses of the
SYSTEM command.  This CQ script command enables
execution of Windows programs, MS-DOS programs and
MS-DOS batch files.

• tips.txt - This file contains some tips on script-writing, audit
file use, and how to use some of the CQ supplied utility
programs located in the utilities directory.
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CQ Scripting Language

This section explains each of the CQ-3770EE scripting commands
that make up the CQ Scripting Language.  Use the table below to
find information on each command.

Command Page Command Page

;comment 9 - 10 DEBUG 9 - 32

UNATTEND 9 - 11 WAIT_FOR 9 - 34

ATTEND 9 - 11 WHEN 9 - 36

DISPLAY 9 - 12 OR_WHEN 9 - 36

BEEP 9 - 13 END_WHEN 9 - 36

CONNECT 9 - 14 IF 9 - 38

DISCONNECT 9 - 15 IF_EXIST 9 - 38

SEND 9 - 16 ELSE_IF 9 - 38

RECEIVE 9 - 19 ELSE 9 - 38

START 9 - 24 END_IF 9 - 38

STOP 9 - 26 DELETE 9 - 45

RESUME 9 - 27 SYSTEM 9 - 46

GOTO 9 - 28 MAIN_WINDOW 9 - 48

CALL 9 - 29 SCRIPT_WINDOW 9 - 49

RETURN 9 - 29 EXIT 9 - 50

CLEAR 9 - 31
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Comment Command

The comment command is used to provide documentation within
your scripts.  Any characters on a line to the right of a semicolon
will be ignored.  The comment command is useful for
documenting your script.

Command Format

;comment

Examples

• Comments on single lines:

; This is an example of a comment on a line by itself.
; Comments can also appear one line after another.
; Like this...
; And this...
; Etc.

• Comments on lines with other commands:

GOTO exit ; goto the exit label
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UNATTEND/ATTEND Commands

The UNATTEND command is used within scripts that are
intended to run without operator intervention.  Scripts that run in
unattended mode continue to run despite any errors during
communications.  It is expected that the scriptwriter will use the
error trapping commands provided through CQ’s software.

The ATTEND command is used within scripts that are intended
to run with an operator present.  Many error messages and
exception events appear on the screen and are ready to be
handled in real time by the operator.

Note:
To set the script for attended mode, you do not have to enter the
command ATTEND at the beginning of a script.  All scripts
automatically default to ATTEND mode.  Use the UNATTEND
command to run a script in unattended mode and the ATTEND
command to return to attended command if necessary.

Command Format

UNATTEND

ATTEND

Example

• The following example runs a script in unattended mode and
then returns the script to attended mode later in the script:

UNATTEND
(an unspecified number of script lines
that run in unattended mode)
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DISPLAY Command

The DISPLAY command is used to display a message in the
Message scrolling text box portion of the CQ Script screen.  This
command can also be used to optionally write the message to an
audit/log file.

Command Format

DISPLAY <string> [AUDIT]

Description of Parameters

• <string> - A string is any number of characters contained
within quotation marks (“ ”).  This is the message that will
appear on the display screen.

• [AUDIT] - When AUDIT is included in the DISPLAY
command, the string is not only displayed on the screen, bit
it is also appended to the Audit file.  For information on the
audit feature, see the section called “Audit” on Page 10-27.

Examples

• The following example displays the string “File Received” in
the Message scrolling text box portion of the CQ Script
screen:

DISPLAY “File Received”

• The following example displays the string “File Received” in
the Message scrolling text box portion of the CQ Script
screen and also inserts it into the Audit file:

DISPLAY “File Received” AUDIT
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BEEP Command

The BEEP command is used to audibly signal the user by
producing a beep or succession of beeps from the computer. 

Command Format

BEEP [number]

Description of Parameters

• [number] - This is the number of beeps that will be
produced.  The maximum number is ten.  If no number is
specified, one beep will be produced.

Example

• The following example produces five beeps:

BEEP 5
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CONNECT Command

The CONNECT command establishes a communications link
between the remote computer and the host site.

If you are dialing into the host site, the CONNECT command
will begin dialing the host site phone number stored in the current
or specified configuration file.

The CONNECT command will generally establish the
communications link in accordance with the current or specified
configuration file.  If you need to review or modify the connect
parameters, they can be found in that configuration file.

Command Format

CONNECT

Example

• The CONNECT command appears on a line in a script with
no other options or values:

CONNECT
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DISCONNECT Command

The DISCONNECT command disconnects the remote computer
from the host site.  This is useful when there is a long period of
inactivity between the two sites.  Also, before you can use the
DISCONNECT command you must first be connected to the host
site, usually through the CONNECT command.

Note:
The DISCONNECT command does not terminate the script or
necessarily close the Interface screen.  The DISCONNECT
command simply terminates the communications link.

Command Format

DISCONNECT

Example

• The DISCONNECT command appears on a line in a script
with no other options or values:

DISCONNECT
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SEND Command

The SEND command is used to send files or strings within your
scripts.

Command Format

SEND [device] <{string} / {filename}> [send options]

Description of Parameters

• [device] - This part of the command is optional (signified by
the brackets [ ]).  Device names include:

• CONSOLE - This is the default device when sending
strings.

• CARD - This is the default device when sending files.

• EXCHANGE

• <{string} / {filename}> - You may either send a string or a
filename.

• string - This is any number of characters contained
within quotation marks (“ ”).  The default device for a
string is CONSOLE.

• filename - This is any standard filename and may also
include a directory path.  Do NOT enclose filenames
within quotation marks.  The default device for a file is
CARD.
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• [send options] - There are several send options to choose
from:

• TEXT / BINARY - Specifies whether you want to send
files as text (default) or binary data.  When files are sent
as text data, the data is translated to EBCDIC character
set before it is sent.  Carriage Return Line Feeds
(CRLFs) are replaced with a record separator and tabs
are expanded with spaces.

• RECORD_SIZE=nn or RS=nn - If the files that are
being sent are text data, this option specifies the
maximum record size to send.  Any lines larger than this
will be split.  If the files that are being sent are binary
data, this option specifies the absolute record size of the
files.  The default record size is 80 bytes.

• MORE_DATA or MORE - This option specifies that
more data (i.e., another file) is to follow this file and is
to be included in the same job.
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Examples

• Send a text file called file.sgn as card reader data.

SEND file.sgn

Note:
The device automatically defaults to CARD data because
the file being sent is a text file.

• Send JCL with a record size of 80 and then append more
binary data in the file that is to follow with a record size of
128.

SEND header.jcl RS=80 MORE
SEND data.dat BINARY RS=128

Note:
Separate multiple options with a space between each
option.

• Send a string that signals the mainframe to start sending the
punch data:

SEND “$SPU1”

Note:
The device automatically defaults to CONSOLE data
because the text being sent is a string.
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RECEIVE Command

The RECEIVE command is used to receive files within your
scripts.

Command Format

RECEIVE [device] <{filename} / PRINTER> [receive options]

Description of Parameters

• [device] - This is the type of device you will be receiving
from.  Device names include:

• ANY (default)

• CONSOLE_PRINTER

• PRINTER1 through PRINTER16

• PUNCH1 through PUNCH16

• EXCHANGE1 through EXCHANGE16

• <{filename} / PRINTER> - You may either send the data
that you receive to a filename that you specify or to the
PRINTER.  A filename is any standard filename, with or
without the three-character extension.  Do not enclose
filenames within quotation marks.  There are numerous
options associated with sending received data to a filename.
These options are explained in the next section called
“Receive Options”.

Each [receive option] list is divided according to the type of
device.  A printer is the name of the printer attached to the
computer that you defined in the Receive Data dialog box.
For more information, see Chapter 7: Data Transfers.

• [receive options] - You can choose from several different
receive options.  These options depend on the type of device
that is receiving the data.  The lists on the next few pages
explain the options that are specific to the devices.
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Receive Options

These options apply only to PUNCH or EXCHANGE devices:

• TEXT / BINARY - If the TEXT option is defaulted or
specified, the incoming data will be translated into ASCII.  If
the BINARY option is specified, the incoming data will not
be translated.

• RECORD_SIZE=nn or RS=nn - This option sets the
maximum record size for TEXT data or the absolute record
size for BINARY data.

• INSERT_CRLFS - The incoming record separators are
replaced with Carriage Return Line Feeds (CRLFs).
Records larger than RECORD_SIZE are truncated and
CRLFs are inserted while the remaining part of that record is
processed as a separate record.

• BLANK_FILL - Short records are filled with blanks until
RECORD_SIZE.

Note:
Incoming BINARY data is processed BLANK_FILL
regardless of the setting of INSERT_CRLF and
BLANK_FILL.

These options apply only to PRINTER devices:

• HOSTFCBNAME - Specifying this option allows the host to
specify the Form Control Block (FCB) name to use.
HOSTFCBNAME is the form name expected from the host.
If you have not configured the forms for the given form
name, see the section called “Receive Data - Form Options
Dialog Box” on Page 7-16.

• FCBNAME = name - The FCBNAME is used in the event
the HOSTFCBNAME is not given by the host or, if given by
the host, is not in the list of configured FCBs.
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These options apply to PRINTER, PUNCH, or EXCHANGE
devices:

• HOSTFORM or HOSTFORM_ST - HOSTFORM is used to
receive data to a file named from the host form name.  If
HOSTFORM_ST is used, only the form name from the
Standard PDIR will be used.  This typically is used to
capture only the data of a download exclusive of any banner
pages.

• HOSTJOB or HOSTJOB_ST - HOSTJOB is used to receive
data to a file named from the host job name.  If
HOSTJOB_ST is used, only the job name from the Standard
PDIR will be used.  This typically is used to capture only the
data of a download exclusive of any banner pages.

These options apply to all devices and when writing to a file:

• KEEP_OPEN - Append all data coming into the device into
one file.

• CLOSE - Close the file after end of file is received from the
host.  This is the default.

• AUTO or AUTO_INC - The received file is named with a
numeric extension.  If an extension is given, it is ignored
unless it is all numeric.  If it is all numeric, that extension
will be used and should the name be a duplicate, the file will
be overwritten.  Otherwise, if a non-numeric or no extension
is given, the first available (unduplicated) numeric extension
will be used.  The numeric extension is automatically
incremented by one for each file received.

Note:
Only one of the options in the list above may be specified.
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Examples

• Receive data to an unknown number of files from any device:

RECEIVE report.fil AUTO

This command will direct all incoming data to files named
report.000, report.001, etc. according to the AUTO option.
Note that the extension .fil is overwritten.  Since BINARY is
not specified, TEXT is the default.  Since the device type is
not specified, ANY device is the default.  The host for all
incoming data assigns the device type.  The ANY device
parameter is useful if you are not sure as to what device types
the host has assigned or it may be used just to simplify your
script.  For more information on devices, see the section
called “Corresponding Device/Event Names” beginning on
Page 9-51.

• Receive untranslated data to a punch device for an unknown
number of files:

RECEIVE PUNCH1 edi_data BINARY AUTO

PUNCH1 is the specified device.  If the host had assigned
PRINTER3, the data would not go to PUNCH1 so the file
(edi_data) would not be written.  The data received will not
be translated.  This is useful when the arriving data is already
in ASCII, there is post processing such as decompression to
be done, or the data contains unprintable characters.

Chapter 9: Scripts

9 - 22



• Receive text data to the print device for an unknown number
of files.  The files here are named according to the host’s
form name but do not include banner pages in the file:

RECEIVE PRINTER1 banners.dat HOSTFORM_ST KEEP_OPEN

When data needs special print formatting, the host’s Form Name
can name the file as well as identify the type of form to be
used with the data.  Another method of letting the host name
the incoming files is the HOSTJOB option.  This option can
be used to track incoming jobs (reports) via a file name.
Banner pages, and all jobs not named by the host, will go to
the file called banner.dat.
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START Command

The START command resets a specified timer to zero and then
starts the timer within a script.  The timer functions count up
from zero, similar to a stopwatch.  There is no practical upper
limit to the timer.  There can be a maximum of nine timers
running in a script.

The inactivity timer is a special timer that is always running.
Inactivity is any period where there is no active data transfer on
the communications line  There is only one inactivity timer.  It is
used to detect extended periods of inactivity.

The WAIT_FOR, WHEN, and IF commands are used to check a
timer.  For more information on timer events, see the
“WAIT_FOR Command” (Page 9-34), “WHEN Commands”
(Page 9-36), and “IF Commands” (Page 9-38) sections in this
chapter.

Note:
The inactivity command resets to zero not only each time that you
call the command through the START INACTIVITY command,
but also when communications becomes active, a file is actively
being sent, or a file is actively being received.

Command Format

START <timer_device>

Description of Parameters

• <timer_device> - This option is one of ten possible choices.
The choices are TIMER1 through TIMER9 and
INACTIVITY.
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Examples

• The START command is most often used in conjunction
with the WHEN command.  In this example, the script waits
for 30 seconds before continuing.

START TIMER1
WHEN TIMER1 >= 30
END_WHEN

This script example can be used, for example, to wait between
busy signals.  Once it is started, it continues until it is
stopped.

• The START command can also be used with the
INACTIVITY option.  In this example, the script waits for
30 seconds of inactivity before continuing.

START INACTIVITY
WHEN INACTIVITY >= 30
GOTO no_more_files
END_WHEN
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STOP Command

The STOP command stops a specified timer within a script.  This
command stops the timer number that you specify by suspending
its operation.  It holds its count without changing until either it is
resumed or restarted at zero with the START command.

Command Format

STOP <timer_device>

Description of Parameters

• <timer_device> - This option is one of nine possible choices.
The choices are TIMER1 through TIMER9.

Example

• The STOP command:

STOP TIMER1
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RESUME Command

The RESUME command resumes a timer after you have stopped
it.  The specified timer continues counting from where it was
stopped through the STOP command.

Command Format

RESUME <timer_device>

Description of Parameters

• <timer_device> - This option is one of nine possible choices.
The choices are TIMER1 through TIMER9.

Examples

• The RESUME command:

RESUME TIMER1

• Resuming another timer within a script:

RESUME TIMER2
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GOTO Command

The GOTO command is used to jump unconditionally from one
part of a script to another part.  This command can also initiate a
jump from one script to another script.

Command Format

GOTO <[filename::] [label]>

Description of Parameters

• [filename::] - This parameter is used to jump to another
script from within the current script.  The script filename
should be followed by two colons (::).  If you do not enter a
filename, the script action stays within the current script and
does not access another script.

• [label] - This is the place in the script the script action is
jumping to.  A label is any arbitrary name of alphabetic
characters with no spaces allowed that ends with a colon (:).
If you do not enter a label, then the script action goes to the
first line in the script.

Examples

• The following example forms a loop with a GOTO
command and a label:

mylabel:
(an unspecified number of script lines)
GOTO mylabel

• The following example accesses another script called
get_data.cqs.

GOTO get_data.cqs::

The get_data script will then run from its first line.
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CALL/RETURN Commands

The CALL command is used to jump to a subroutine either
within the same script or to another script.  The RETURN
command appears at the end of the subroutine to return the script
execution point to the command line immediately following the
CALL command.

Command Format

CALL <[filename::] [label]>

RETURN

Description of Parameters

• [filename::] - This parameter is used to jump to another
script from within the current script.  The script filename
should be followed by two colons (::).  If you do not enter a
filename, the script action stays within the current script and
does not access another script.

• <label> - This is the name of the subroutine the script action
is jumping to.  A label is any arbitrary name of alphabetic
characters with no spaces allowed that ends with a colon (:).
If you do not enter a label, then the script action goes to the
first line in the script.

Examples

• The following example calls a subroutine and then returns to
where the subroutine was originally called.

CALL mysubroutine
(an unspecified number of script lines)
mysubroutine:
(an unspecified number of script lines)
RETURN
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• The following example calls a subroutine from another script
and then returns to the original script.

Original Script:

CALL get_data.cqs::mysubroutine
(an unspecified number of script lines)

get_data.cqs Script:

(an unspecified number of script lines)
mysubroutine:
(an unspecified number of script lines)
RETURN

As the original script runs, it calls the get_data.cqs script and
goes to the mysubroutine label.  The script lines in the
get_data.cqs are then executed from the mysubroutine label
to the RETURN command, which returns back to the
original script on the next line after the CALL command.
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CLEAR Command

The CLEAR command is used to clear the particular option that
you specify.  This command is likely to be used only in the most
complex scripts.

Command Format

CLEAR <option>

Description of Parameters

• <options> - There are three options to choose from:

• EVENTS - Clears all of the currently programmed
events that may occur.  Note that after a WHEN
command occurs, all other timer and inactivity events
are automatically cleared.

• TIMERS - Sets the timer specified to zero (0), but does
not start the timer.  This option can be any timer
between TIMER0 and TIMER9.

• OUTBOUND DEVICES - Removes all previous
destinations for incoming files going to the specified
outbound device.  This option can be any of the
outbound device names listed in the “Outbound
(Receive Command) Names” table on Page 9-51.

Examples

• Examples of the CLEAR command:

CLEAR EVENTS

CLEAR PRINTER1

CLEAR TIMER3
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DEBUG Command

Script writers use the DEBUG command to help debug their
scripts.

Command Format

DEBUG [options]

Description of Parameters

• [options] - This part of the command is optional (signified
by the brackets []).  The options available are ON and OFF.

• If the DEBUG command is not used in a script or it has
been turned OFF, then the Device Status section of the
CQ Script dialog box will display communications event
information and the Message section will display
messages defined through the DISPLAY command, any
syntax errors, and other messages.

• If the DEBUG command is turned ON, then the Device
Status section of the CQ Script dialog box will display
the script text as it runs and the Message section will
display detailed information about the status of each line
of the script as it is executed.
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Examples

• The following example turns the debug feature on:

DEBUG

During the DEBUG operation, the following CQ Script dialog
box tracks the script’s point by displaying lines as they are
executed.

Note:
To set the debug command in a script, you do not have to
enter the term ON after the DEBUG command.  ON is the
default.

• The following example turns the debug feature off:

DEBUG OFF

9 - 1  CQ Script Dialog Box (DEBUG Command ON)
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WAIT_FOR Command

The WAIT_FOR command is used when you need to have the
script wait for a certain device to complete a certain event before
continuing.

Command Format

WAIT_FOR [device] <event>

Description of Parameters

• [device] <event> - The type of device name must match the
corresponding type of event.  For example, if the device type
is a send device, the event must be a send event.  See the
section called “Corresponding Device/Event Names” on
Page 9-51 for information on the corresponding device and
event names.

Examples

• Receive commands:

WAIT_FOR CONSOLE_PRINTER RECEIVE_ERROR

WAIT_FOR PRINTER1 ACTIVE

• Send commands:

WAIT_FOR CONSOLE COMPLETE

WAIT_FOR CARD ACTIVE

• Other communications commands:

WAIT_FOR COMMUNICATIONS DISCONNECTED

WAIT_FOR COMMUNICATIONS ACTIVE

Chapter 9: Scripts

9 - 34



• Timer and inactivity commands:

WAIT_FOR TIMER1 > 60

WAIT_FOR INACTIVITY >= 1:00
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WHEN Commands

The WHEN commands are used to perform tasks within a script
when devices complete defined events.  The WHEN command is
used first.  Each subsequent OR_WHEN command defines
another event.  When there are no more WHEN or OR_WHEN
commands, the END_WHEN command must appear in the
script.  Be aware that when you use the WHEN commands, the
script will always wait for one of the events to occur before
continuing past the END_WHEN command.

Command Format

WHEN [device] <event>
(unspecified number of commands)

OR_WHEN [device] <event>
(unspecified number of commands)

END_WHEN

Description of Parameters

• [device] <event> - The type of device name must match the
corresponding type of event.  For example, if the device type
is a send device, the event must be a send event.  See the
section called “Corresponding Device/Event Names” on
Page 9-51 for information on the corresponding device and
event names.

• (unspecified number of commands) - These are the
commands that are performed when the first WHEN or
OR_WHEN event occurs.
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Example

• The following example script language does a number of
things.  When communications indicates a busy signal after
dialing (COMMUNICATIONS BUSY), a timer is started to
wait 60 seconds and execution goes back to the beginning of
the script until the next event.  When the inactivity is more
than three minutes, the session disconnects and exits.  Once
the communications is active, the inactivity timer is activated
and the script continues after the END_WHEN statement
where other commands, such as SEND and RECEIVE, are
executed.

START INACTIVITY
beginning:
CONNECT
WHEN COMMUNICATIONS ACTIVE

START INACTIVITY
OR_WHEN COMMUNICATIONS BUSY

START TIMER1
WAIT_FOR TIMER1 > 60
STOP TIMER1
GOTO beginning

OR_WHEN INACTIVITY > 3:00
DISCONNECT
EXIT

END_WHEN
continue:
(an unspecified number of script lines)
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IF Commands

The IF commands are used to perform tasks within a script if
devices complete specified events, if system variables created by
calling other programs equal certain values, and if filenames exist
in an accessible location.

The IF command is used for the first event.  Each subsequent
ELSE_IF command defines another event.  You can also use the
ELSE command to automatically perform a task if none of the IF
or ELSE_IF commands are achieved.  When there are no more
IF, ELSE_IF, or ELSE commands, the ENDIF command must
appear at the end of the list of IF commands.  Be aware that when
you use the IF commands, the script will continue past the
ENDIF command even if none of the events occur.

There are three formats for the IF commands.  These three
formats are explained separately on the next few pages.

1. IF [device] <event>

2. IF <system variable> <boolean> <value>

3. IF EXIST <filename>
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1. IF [device] <event>

Command Format

IF [device] <event>
(unspecified number of commands)

ELSE_IF [device] <event>
(unspecified number of commands)

ELSE
(unspecified number of commands)

ENDIF

Description of Parameters

• [device] <event> - The type of device name must match the
corresponding type of event.  For example, if the device type
is a send device, the event must be a send event.  See the
section called “Corresponding Device/Event Names” on
Page 9-51 for information on the corresponding device and
event names.

• (unspecified number of commands) - These are the
commands that are performed when the IF, ELSE_IF, OR
ELSE events are achieved.
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Example

• The following example script language does a number of
things.  If communications is active, a message is displayed
on the screen.  If communications is disconnected, a
different message is displayed on the screen.  If there is an
error in communications, the DEBUG command is called, a
message is displayed on the screen, and then the DEBUG
command is turned off.  Keep in mind that if none of these
communications events occur (i.e., communications is busy),
then the script continues with the next command after
ENDIF.

IF COMMUNICATIONS ACTIVE
DISPLAY “The communications is active”

ELSE_IF COMMUNICATIONS DISCONNECTED
DISPLAY “The line has been disconnected”

ELSE_IF COMMUNICATIONS ERROR
DEBUG
DISPLAY “There is a communications error”
DISPLAY “Debugging in process”
DEBUG OFF

ENDIF
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2. IF <system variable> <boolean> <value>

Note:
See the section called “SYSTEM Command” on Page 9-46 for
information on this format.

Command Format

IF <system variable> <boolean> <value>
(unspecified number of commands)

ELSE_IF [device] <event>
(unspecified number of commands)

ELSE
(unspecified number of commands)

ENDIF

Description of Parameters

• <system variable> - This option can be either
SYSTEM_STATUS or SYSTEM_RETURNS.  See the
section called “SYSTEM Command” on Page 9-46 for
information on these two options.  Please note that the
SYSTEM_STATUS must be successful (return a value of
zero) to ensure that any SYSTEM_RETURNS values are
valid.

• <boolean> - This option may be one of the following values:

• > (greater than)

• >= (greater than or equal to)

• < (less than)

• <= (less than or equal to)

• = (equal to)

• NOT (not equal to)
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• <value> - This option can be any positive or negative
number.  Three possible values can be returned by the
SYSTEM command and accessed through the
SYSTEM_STATUS variable:

• 0 - The program that was accessed through the
SYSTEM command was successfully launched.  If the
WAIT option was activated, a return code was also
successfully fetched.  SYSTEM_RETURNS codes can
only be checked for valid returns if the
SYSTEM_STATUS returns a code of zero (0).

• -1 - The program that was accessed through the
SYSTEM command failed to launch.  This could be due
to a bad command, incorrect path, etc.

• -2 - The program that was accessed through the
SYSTEM command failed to fetch a return code.

Other return code values can be accessed through the
SYSTEM_RETURNS variable.  These return codes can be
any positive or negative number that is returned by the
program accessed through the SYSTEM command.
SYSTEM_RETURNS codes can only be checked for valid
returns if the SYSTEM_STATUS returns a code of zero (0).

• (unspecified number of commands) - These are the
commands that are performed when the IF, ELSE_IF, OR
ELSE events are achieved.
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Example

• The following example script language checks the
completion status of the program that was called by a
SYSTEM command.  If the program that was called returned
a SYSTEM_STATUS code less than zero (error codes -1 or
-2), the DEBUG command is called, a message is displayed
on the screen, and then the DEBUG command is turned off.
If the program that was called returned a
SYSTEM_STATUS code of zero, a different message is
displayed on the screen and the SYSTEM_RETURNS are
checked.

Note:
SYSTEM_RETURNS codes can only be checked for valid
returns if the SYSTEM_STATUS returns a code of zero (0).

SYSTEM “chekfile.exe myfile.txt”
IF SYSTEM_STATUS<0

DEBUG
DISPLAY “chekfile was not successfully executed”
DISPLAY “Debugging in process”
DEBUG OFF  

ELSE_IF SYSTEM_STATUS=0
DISPLAY “chekfile ran, will now check system returns”
GOTO ok

ENDIF
(an unspecified number of script lines)
ok:
IF SYSTEM_RETURNS 12

DISPLAY “chekfile verifies ok, (returned error level 12)”
ELSE

DISPLAY “no file, myfile.txt” AUDIT
ENDIF
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3. IF EXIST <filename>

Command Format

IF EXIST <filename>
<unspecified number of commands>

ELSE_IF [device] <event>
(unspecified number of commands)

ELSE
(unspecified number of commands)

ENDIF

Description of Parameters

• <filename> - Through the IF EXIST command, the
<filename> option can be any complete pathname and/or
filename that is accessible from the workstation.

• (unspecified number of commands) - These are the
commands that are performed when the IF, ELSE_IF, OR
ELSE events are achieved.

Example

• The following example script language checks to see if the
file process.txt exists.  If the file exists, it is sent to the host
through the SEND command and a message is displayed.  If
it does not exist, a different message is displayed on the
screen.

IF EXIST process.txt
SEND process.txt
DISPLAY “Sending the file process.txt"

ELSE
DISPLAY “The file process.txt does not exist”

ENDIF
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DELETE Command

The DELETE command is used to delete a file from the user’s
local drive or network.  The filename may include all necessary
drive letter and pathname information.

Note:
The DELETE command does not support ambiguous filenames.
These include filenames with an asterisk (*) to indicate any
number and type of character or a question mark (?) to indicate
any character.  The filename must be a specific filename.

Command Format

DELETE <filename>

Description of Parameters

• <filename> - This is the filename to be deleted from the
user’s local drive or network.  The filename may include all
necessary drive letter and pathname information.

Examples

• The following example deletes a file from the user’s local
drive:

DELETE datafile.txt

Note:
The current drive letter and path are assumed in the
example above.

• The following example deletes a file from the user’s network:

DELETE h:\user\transfer\datafile.txt
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SYSTEM Command

The SYSTEM command is used access another program through
the current operating system.

Note:
When the SYSTEM command is used, the program that is
accessed generates a status code and an optional return code.
The generated status codes can be used to determine if the
accessed program was completed successfully or resulted in an
error.  The user generated return codes can be used at the
discretion of the user.  The IF command is used to check the
status and return codes.  See the section called “IF <system
variable> <boolean> <value>” on Page 9-41 for information
on how to use the IF command to check the status and return
codes.

Command Format

SYSTEM “command string” [wait option]

Description of Parameters

• “command string” - This option is the command used to
access the program through the current operating system.

• For DOS commands, the command string should appear
as follows:
path.com /c <DOS command>.

• For Windows commands, simply enter the program
name and any related commands.

• [wait option] - This option can be one of two values:

• WAIT (default) - The script will wait for the program
that has been accessed to completely execute and exit
before continuing with the script.

• NO_WAIT - Both the script and the program that has
been accessed through the script will run simultaneously.
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Example

• The following example script language checks the
completion status of the program that was called by a
SYSTEM command.  If the program that was called failed to
execute for whatever reason, then the SYSTEM_STATUS
will be less than zero (error codes -1 or -2) and a message
will be displayed on the screen as the “fail” label is accessed
through the GOTO command.  If the program that was called
returned a SYSTEM_RETURNS code of twelve (12)
demonstrated in the example below, a different message is
displayed on the screen and the “ok” label is accessed
through the GOTO command.

Note:
Certain programs such as DOS batch files will not return
error levels.  In these cases, SYSTEM_RETURNS values
will not have valid values.  Operation results of DOS batch
files can be determined indirectly through the use of the IF
EXIST command.  For more information, see the tips.txt
file located in the examples subdirectory under the main
CQ-3770EE directory that you specified during installation.

SYSTEM “chekfile.exe myfile.txt”
; test SYSTEM_STATUS to see if chekfile.exe
; executed successfully
IF SYSTEM_STATUS<0

DISPLAY “chekfile.exe failed to execute” AUDIT
GOTO fail

; else check what error level chekfile.exe returned
; (if any) since execution was on
ELSE_IF SYSTEM_RETURNS=12

DISPLAY “chekfile.exe returned error level 12” AUDIT
GOTO ok

ENDIF
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MAIN_WINDOW Command

The MAIN_WINDOW command is used to restore or minimize
the Interface screen.  The Interface screen automatically appears
in the taskbar in a minimized format when a script is initiated
through a configuration as it is accessed.  The MAIN_WINDOW
command is useful for restoring the Interface screen.

Command Format

MAIN_WINDOW <options>

Description of Parameters

• <options> - The two options are RESTORE and MIN. Use
the RESTORE option to restore the Interface screen from a
minimized state in the taskbar.  Use the MIN option to
minimize the Interface screen to the taskbar.

Examples

• The following example restores the Interface screen:

MAIN_WINDOW RESTORE

• The following example minimizes the Interface screen:

MAIN_WINDOW MIN
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SCRIPT_WINDOW Command

The SCRIPT_WINDOW command is used to restore or
minimize the CQ Script dialog box.  When a configuration that
accesses an attached script is accessed, the CQ Script dialog box
automatically appears in a maximized format.  The
SCRIPT_WINDOW command is useful for minimizing the
CQ Script dialog box into the taskbar.

Command Format

SCRIPT_WINDOW <options>

Description of Parameters

• <options> - The two options are RESTORE and MIN. Use
the RESTORE option to restore the CQ Script dialog box
from a minimized state in the taskbar.  Use the MIN option
to minimize the CQ Script dialog box to the taskbar.

Examples

• The following example restores the CQ Script dialog box:

SCRIPT_WINDOW RESTORE

• The following example minimizes the CQ Script dialog box:

SCRIPT_WINDOW MIN
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EXIT Command

The EXIT command is used to exit from either a script or an
Interface screen.

Command Format

EXIT [options]

Description of Parameters

• [options] - This part of the command is optional.  The
default is SCRIPT.  You can also choose to exit the current
Interface screen by entering PROGRAM.

Examples

• The following example exits a script:

EXIT

Note:
To exit the script, you do not have to enter the term
SCRIPT after the EXIT command.  SCRIPT is the default.

• The following example exits an Interface screen:

EXIT PROGRAM
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Corresponding Device/Event Names

The lists in this section summarize the devices and their
corresponding events.  These combinations can be used in the
SEND, RECEIVE, WAIT, WHEN, and IF commands.

Outbound (Receive Command) Names

[device] <event>

CONSOLE_PRINTER
PRINTER1 through PRINTER16
PUNCH1 through PUNCH16
EXCHANGE1 through EXCHANGE16
ANY

RECEIVE_ERROR
RECEIVE_COMPLETE
RECEIVE_ACTIVE
ACTIVE
COMPLETE
E RROR

Inbound (Send Command) Names

[device] <event>

CONSOLE
CARD
EXCHANGE1

SEND_ERROR
SEND_COMPLETE
SEND_ACTIVE
ACTIVE
COMPLETE 
ERROR

Other Names

[device] <event>

COMMUNICATIONS
ACTIVE
DISCONNECTED
BUSY
ERROR
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Timer and Inactivity Names

[device] <event>

TIMER1 through TIMER9
INACTIVITY

<boolean> <time>

The <boolean> may be either of two
symbols:

• > (greater than)
• >= (greater than or equal to)

The <time> is in the format
[[hh:]mm:]ss, where hh is the hour
(between 0 and 23), mm is the minutes
(between 0 and 59), and ss is the seconds
(between 0 and 59).

Please note that you are not required to
enter every field of the time.  If you
enter 50, this signifies 50 seconds.  If
you enter 90, this will automatically be
converted to 1:30, or one minute and 30
seconds.
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Script Commands

The Options > Script menu bar option from the Interface screen
accesses the features associated with creating, modifying, or
running scripts.  From this menu bar option, you can select one of
the following commands:

• New Script - Use this command to create a new script. This
command is also available as a toolbar button.

• Open Script - Use this command to open an existing script.
This command is also available as a toolbar button.

• Run Script - Use this command to run an existing script.
This command is also available as a toolbar button.
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New Script Command

The Options > Script > New Script menu bar command
accesses the Script Editor dialog box.  From this dialog box, you
can write a new script.

Script Editor Options

• Script Text Area - This scrolling text box contains all of the
text and commands associated with the script.  You can edit
the script text in this box.

• Save  - Select this button to save the current script.

• Save As - Select this button to save the current script as
another name.

• Run - Select this button to run the current script.

• Close - Select this button to close the current script.

9 - 2  Script Editor Dialog Box
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Creating a New Script

To create a new script from the Interface screen:

1. Access the Script Editor dialog box:

• Select the Options > Script > New Script menu bar
command.

• Select the Create a New Script toolbar button .

2. In order to write a script, you will need to use the CQ Scripting
Language explained in this chapter.  For information on the
CQ Scripting Language, turn to the section called
“CQ Scripting Language” on Page 9-9.

To create a new script from a text editor:

1. You can create a script using a text editor such as DOS Edit or
Notepad.  Do not use a program that automatically formats
text, such as Microsoft Word or WordPerfect.  If you use a
text editor to create a script, the file must have the extension
.cqs.

2. In order to write a script, you will need to use the CQ Scripting
Language explained in this chapter.  For information on the
CQ Scripting Language, turn to the section called
“CQ Scripting Language” on Page 9-9.
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Open Script Command

The Options > Script > Open Script menu bar command
accesses the Script Editor dialog box.  From this dialog box, you
can edit an existing script.

Script Editor Options

• Script Text Area - This scrolling text box contains all of the
text and commands associated with the script.  You can edit
the script text in this box.

• Save  - Select this button to save the current script.

• Save As - Select this button to save the current script as
another name.

• Run - Select this button to run the current script.

• Close - Select this button to close the current script.

9 - 3  Script Editor Dialog Box
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Opening an Existing Script

To open a script for editing from the Interface
screen:

1.  Access the Open dialog box:

• Select the Options > Script > Open Script menu bar
command.

• Select the Open a Script to Edit toolbar button .

2. From the Open dialog box that appears, select the script you
want to open.

3. Edit the script within the Script Editor dialog box.  In order to
edit a script, you will need to use the CQ Scripting Language
explained in this chapter.  For information on the CQ
Scripting Language, turn to the section called
“CQ Scripting Language” on Page 9-9.

4. Select the Save button.

To open a script for editing from a text editor:

1. You can edit a script using a text editor such as DOS Edit or
Notepad.  Do not use a program that automatically formats
text, such as Microsoft Word or WordPerfect.  If you use a
text editor to edit a script, be sure to save the file with the
extension .cqs.

2. In order to edit a script, you will need to use the CQ Scripting
Language explained in this chapter.  For information on the
CQ Scripting Language, turn to the section called
“CQ Scripting Language” on Page 9-9.
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Run Script Command

The CQ Script dialog box is accessed through one of two ways:

1. The Run Script command from the Options > Script menu
bar command accesses the Run dialog box.  After selecting a
script, the CQ Script dialog box appears containing the script
selected.

2. The Run button from the Script Editor dialog box accesses the
CQ Script dialog box.

Once the CQ Script dialog box is accessed, the script selected
automatically runs.  From the CQ Script dialog box, you can
view a script as it runs.

9 - 4  CQ Script Dialog Box
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CQ Script Options

• Device Status - The contents of the Device Status scrolling
text box depend on whether or not the DEBUG command is
turned ON or OFF.

If the DEBUG command is not used in a script or it has been
turned OFF, then the Device Status section will display
communications events such as the host connection, send and
receive data progress reports, and host disconnection.

If the DEBUG command is turned ON, then the Device Status
section will display the script text as it runs.

• Comm Status - This field displays the current status of
communications with the host.  Turn to the section called
“Status Line Messages” on Page 4-10 for a complete list of
messages that may appear.

• Message - The contents of the Message scrolling text box
depends on whether or not the DEBUG command is turned
ON or OFF.

If the DEBUG command is not used in a script or it has been
turned OFF, then the Message section will display messages
defined through the DISPLAY command, any syntax errors,
and other messages.

If the DEBUG command is turned ON, then the Message section
will display detailed information about the status of each line
of the script.
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• Run - Select this button to run the current script.

• Abort - Select this button to abort the current script as it is
running.

• Script - Select this button to view the script text in the
Device Status scrolling text box.

• Save  - Select this button to save the current script.

• Close - Select this button to close the current script.
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Running a Script

To run a script from the Interface screen:

1. Access the Run dialog box:

• Select the Options > Script > Run Script menu bar
command.

• Select the Run a Script toolbar button .

2. From the Run dialog box that appears, select the script you
want to run.

3. Select the Run button.
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This chapter explains how to use the more advanced options of
CQ-3770EE.  These options include the Interface screen’s toolbar,
the floating SmartKey Pad, password protection of the Interface
screen, and the audit and trace diagnostics features.

Advanced Commands

The Options > Advanced menu bar option from the Interface
screen accesses the advanced features associated with
CQ-3770EE.  From this menu bar option, you can select one of the
following commands:

• Toolbar - Use this command to add, edit, or delete toolbar
buttons from the toolbar.  This command is also available as
a toolbar button.

• SmartKey Pad - Use this command to add, edit, or delete
SmartKeys from the SmartKey Pad.  This command is also
available as a toolbar button.

• Change Password - Use this command to change the Run
Time Password for the Interface screen.

• Audit - This option functions as a toggle.  If there is a check
mark next to it, an audit file is created when you run the
configuration.

• Trace - This option functions as a toggle.  If there is a check
mark next to it, a trace file is created when you run the
configuration.
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Toolbar

The Options > Advanced > Toolbar menu bar command
accesses the Customize Toolbar  dialog box.  From this dialog
box, you can customize the toolbar that appears within the
Interface screen by adding, editing, or deleting toolbar buttons.

Customize Toolbar Options

• Toolbar Area - This area displays the toolbar as it appears
for your current configuration.  From this area you can drag
and drop toolbar buttons to different positions on the toolbar.
A small arrow appears below the toolbar button that is
currently selected.

• Edit - This button accesses the Edit Toolbar Button dialog
box where you can edit the selected toolbar button.

• Add Button - This button accesses the Add Toolbar Button
dialog box where you can add a toolbar button to the
Toolbar Area.

• Delete - Select this button to delete the selected toolbar
button from the Toolbar Area.

• Add Space - Select this button to add a space to the right of
the selected toolbar button in the Toolbar Area.

• Defaults - Select this button to return the toolbar settings to
their default values.

10 - 1  Customize Toolbar Dialog Box
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Edit Toolbar Button

The Edit button from the Customize Toolbar dialog box accesses
the Edit Toolbar Button dialog box.  From this dialog box, you
can edit a toolbar button.

Edit Toolbar Button Options

• Commands, Menu Items, or Scripts - These option buttons
allow you to classify the toolbar button function.

• Browse - This button is available when the Scripts option
button is selected.  Select the Browse button to access the
Open dialog box where you can select a script file already
saved on your computer.  Scripts should end with the
extension .CQS.

10 - 2  Edit Toolbar Button Dialog Box
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• Function Selected - This drop-down list changes according
to which option button is currently selected.  The function
currently selected appears in the space provided.  For
example, if the Commands option button is selected, the
Function Selected drop-down list will contain commands
such as Send, Print, Receive, Reset, etc.

• Use Icon Instead of Title - When this check box is
activated, a graphic icon in bitmap (.bmp) format is used in
place of a text button.  A list of available .bmp files appears
in the Icon Selected drop-down list.

• Preview - This area displays how the toolbar button will
appear on the toolbar.

• Icon Selected - This drop-down list contains all of the
available .bmp files that you can use as graphic icons on the
toolbar.  The .bmp file currently selected appears in the
space provided.

Note:
You can use bitmap files that you have created and
customized.  To use your own bitmap files most effectively
as toolbar button icons, make sure that each .bmp filename
is no more than eight characters long and that it is the
correct size (32 x 32 pixels), the correct resolution (1 dpi),
the correct number of colors (16 or less), and is then
placed in the same directory that you installed CQ-3770EE.
It will then be accessible through the Icon Selected
drop-down list as a toolbar button icon.

• Title - This text box contains the text that appears on a
toolbar button when the Use Icon Instead of Title check
box is not activated.  You should limit the text to only two or
three letters by abbreviating functions.  For example, the
Help toolbar button is labeled as Hp.

• Flash Prompt  - This text box contains a brief description of
the toolbar button.  This description extends out from the
toolbar button when you leave the mouse cursor idle over the
button for more than one second.

Toolbar
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Editing a Toolbar Button

To edit a toolbar button:

1.  Access the Customize Toolbar dialog box:

• Select the Options > Advanced > Toolbar menu bar
command.

• Select the Customize Toolbar toolbar button .

2. Select the toolbar button you want to edit from the Toolbar
Area.

3. Select the Edit button to edit the selected toolbar button.

4. Make all necessary changes to the toolbar button in the Edit
Toolbar Button dialog box.  Changes include button
function, button label (appearance), and the flash prompt.

5. Select OK.

6. Select OK to return to the Interface screen.
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Add Toolbar Button

The Add Button button from the Customize Toolbar dialog box
accesses the Add Toolbar Button dialog box.  From this dialog
box, you can add a toolbar button.

Add Toolbar Button Options

• Commands, Menu Items, or Scripts - These option buttons
allow you to classify the new toolbar button function.

• Browse - This button is available when the Scripts option
button is selected.  Select the Browse button to access the
Open dialog box where you can select a script file already
saved on your computer.  Scripts should end with the
extension .CQS.

10 - 3  Add Toolbar Button Dialog Box
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• Function Selected - This drop-down list changes according
to which option button is currently selected.  The function
currently selected appears in the space provided.  For
example, if the Commands option button is selected, the
Function Selected drop-down list will contain commands
such as Send, Print, Receive, Reset, etc.

• Use Icon Instead of Title - When this check box is
activated, a graphic icon in bitmap (.bmp) format is used in
place of a text button.  A list of available .bmp files appears
in the Icon Selected drop-down list.

• Preview - This area displays how the toolbar button will
appear on the toolbar.

• Icon Selected - This drop-down list contains all of the
available .bmp files that you can use as graphic icons on the
toolbar.  The .bmp file currently selected appears in the
space provided.

Note:
You can use bitmap files that you have created and
customized.  To use your own bitmap files most effectively
as toolbar button icons, make sure that each .bmp filename
is no more than eight characters long and that it is the
correct size (32 x 32 pixels), the correct resolution (1 dpi),
the correct number of colors (16 or less), and is then
placed in the same directory that you installed CQ-3770EE.
It will then be accessible through the Icon Selected
drop-down list as a toolbar button icon.

• Title  - This text box contains the text that appears on a
toolbar button when the Use Icon Instead of Title check
box is not activated.  You should limit the text to only two or
three letters by abbreviating functions.  For example, the
Help toolbar button is labeled as Hp.

• Flash Prompt - This text box contains a brief description of
the toolbar button.  This description extends out from the
toolbar button when you leave the mouse cursor idle over the
button for more than one second.
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Adding a Toolbar Button

To add a toolbar button:

1.  Access the Customize Toolbar dialog box:

• Select the Options > Advanced > Toolbar menu bar
command.

• Select the Customize Toolbar toolbar button .

2. Select the Add Button button.

3. Design the toolbar button using the Add Toolbar Button dialog
box.  Be sure to select a button function, button label (either
a graphic .bmp file or text), and flash prompt description.

4. Select OK.

5. Select OK to return to the Interface screen.

Toolbar
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Toolbar Button Descriptions

Toolbar buttons quickly perform the command(s) assigned to
them.  These buttons appear on the toolbar, a horizontal bar
located just below the menu bar in the Interface screen.  Think of
a toolbar button as a shortcut to a command, script, or menu item.

Commands

A toolbar button can initiate a command.  To add or edit a toolbar
button to perform a command, access the Customize Toolbar
dialog box.  The table below lists the commands that you can
make available through a toolbar button.

Note:
Some commands listed here are intended to be used with CQ’s
other software products, such as CQ-3270.

Command Description

Alternate Cursor
(Alt Cursor) Alternates the cursor.

APL Toggle Toggles between APL on and APL
off.

Attention
(Attn) Signals the mainframe.

Backspace Moves the cursor one space to the
left.

BackTab
Moves the cursor to the first input
location of the previous
unprotected field.

Blink Selects the blink attribute.

Blue Selects the blue color attribute.

Clear Clears the 3270 session window.

Clear Partition Clears the partition.
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Command Description

Cursor Down Moves the cursor down one line.

Cursor Left Moves the cursor left one
character position.

Cursor Right Moves the cursor right one
character position.

Cursor Select Light Pen
(Cursor Sel)

Performs the light pen selection
function at the current cursor
position.

Cursor Up Moves the cursor up one line.

Delete

Erases the character at the cursor
and moves all the characters to the
right of the cursor right one
position.

Device Cancel Cancels a current print request in
the printer queue.

Double Left Moves the cursor two characters
to the left.

Duplicate
(Dup) Duplicates.

Enter Sends the data to the mainframe.

Erase to End-of-Field
(Erase EOF)

Erases the current field from the
cursor position to the end of the
field.

Erase Input Erases all input fields in the
session window.

Escape Escapes.

Field Mark Informs the program that the end
of the field has been reached.

Forward Tab
Moves the cursor to the first input
location of the next unprotected
field.

Green Selects the green color attribute.

Toolbar
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Command Description

Home Move the cursor to the first input
character of the field.

Insert Inserts a character.

Monochrome/Color Toggle
(Mono-Color Toggle)

Toggles between a Monochrome
and a Color display screen.

New Line Moves the cursor to the first input
character of the next line.

Next Page Moves the cursor to the first input
character of the next page.

Program Access Keys 1-3
(PA1 - PA3)

Sends user-defined signals to the
mainframe.

Partition Jump Jumps to the next partition.

Program Function Keys 1-24
(PF1 - PF24)

Sends user-defined signals to the
mainframe.

Pink Selects the pink color attribute.

Previous Page Moves the cursor to the first input
character of the previous page.

Print 3270 Screen
(Print 3270 Scrn)

Prints the 3270 screen, excluding
the status line.

Red Selects the red color attribute.

Remove Color Removes a color attribute.

Remove Highlight Removes a highlight attribute.

Reset Resets.

Scrol Back Scrolls back one line.

Scroll Forward Scrolls forward one line.

Scroll Left Scrolls left one character position.

Scroll Right scrolls right one character position.

System Request System request.
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Command Description

Turquoise Selects the turquoise color
attribute.

Underscore Selects the underscore attribute.

White Selects the white color attribute.

Yellow Selects the yellow color attribute.

Scripts

A toolbar button can initiate a script.  CQ scripts end with the
extension .CQS.  CQ-3770EE is configured with a few simple
scripts that you can modify and use in your applications.  These
files are located in the main directory that you specified during
installation.  To add or edit a toolbar button to run a script, access
the Customize Toolbar dialog box.

For information on the sample scripts files that came with your
software, turn to the section called “Script Samples, Tips, and
Hints” on Page 9-8.

Toolbar
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Menu Items

A toolbar button can initiate a menu bar command.  To add or
edit a toolbar button to perform a menu bar command, access the
Customize Toolbar dialog box.  The next few pages list the menu
items that you can make available through a toolbar button.  The
corresponding bitmap ( .bmp) files are located in the main
directory where you installed CQ-3770EE.

File menu bar items:

• Print Screen to Printer  .  .  .  .  .  .  prntscrn.bmp

• Save Screen to File .  .  .  .  .  .  .  .  .  save.bmp

• Print Screen Set Up  .  .  .  .  .  .  .  .  pr_setup.bmp

• Reconnect to Host  .  .  .  .  .  .  .  .  .  reconect.bmp

• Exit  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . exit.bmp

Edit menu bar items:

• Copy  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . copy.bmp

• Append  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . append.bmp

• Select All  .  .  .  .  .  .  .  .  .  .  .  .  .  .  selc_all.bmp

• View Clipboard  .  .  .  .  .  .  .  .  .  .  viewclip.bmp
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Transfer menu bar items:

• Send File to Host  .  .  .  .  .  .  .  .  .  .  send.bmp

• Receive Print Data from Host  .  .  .  recv_prn.bmp

Options menu bar items:

• Hide Toolbar  .  .  .  .  .  .  .  .  .  .  .  .  tbr_hide.bmp

• Toggle SmartKey Pad  .  .  .  .  .  .  .  smk_togl.bmp

• Create a New Script  .  .  .  .  .  .  .  .  scr_new.bmp

• Open a Script  .  .  .  .  .  .  .  .  .  .  .  .  scr_open.bmp

• Run a Script  .  .  .  .  .  .  .  .  .  .  .  .  scr_run.bmp

• Customize Toolbar  .  .  .  .  .  .  .  .  .  tbr_cust.bmp

• Customize SmartKey Pad  .  .  .  .  .  smk_cust.bmp

Help menu bar items:

• Contents & Index .  .  .  .  .  .  .  .  .  .  help_con.bmp

• About  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . about.bmp

Toolbar
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SmartKey Pad

The Options > Advanced > SmartKey Pad menu bar command
accesses the Customize SmartKey Pad dialog box.  From this
dialog box, you can customize the SmartKey Pad by adding,
editing, or deleting SmartKeys.

10 - 4  Customize SmartKey Pad Dialog Box
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Customize SmartKey Pad Options

• SmartKey Pad Area - This area displays the SmartKey Pad
as it appears for your current configuration.  From this area
you can drag and drop SmartKeys to different positions on
the SmartKey Pad Area.  The currently selected SmartKey
appears in the Selected Key area and also is outlined with a
rectangular box in the SmartKey Pad Area.

• Selected Key - This area displays the currently selected
SmartKey within the SmartKey Pad Area.

• Edit - This button accesses the Edit SmartKey dialog box
where you can edit the selected SmartKey.

• Add - This button accesses the Add SmartKey dialog box
where you can add a SmartKey to the SmartKey Pad Area.

• Delete - Select this button to delete the selected SmartKey
from the SmartKey Pad Area.

• Defaults - Select this button to return the SmartKey settings
to their default values.

SmartKey Pad

10 - 17



Edit SmartKey

The Edit button from the Customize SmartKey Pad  dialog box
accesses the Edit SmartKey dialog box.  From this dialog box,
you can edit a SmartKey.

Edit SmartKey Options

• Commands or Scripts - These option buttons allow you to
classify the SmartKey button function.

• Browse - This button is available when the Scripts option
button is selected.  Select the Browse button to access the
Open dialog box where you can select a script file already
saved on your computer.  Scripts should end with the
extension .CQS.

10 - 5  Edit SmartKey Dialog Box
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• Function Selected - This drop-down list changes according
to which option button is currently selected.  The function
currently selected appears in the space provided.  For
example, if the Commands option button is selected, the
Function Selected drop-down list will contain commands
such as Send, Print, Receive, Reset, etc.

• Use Icon Instead of Title - When this check box is
activated, a graphic icon in bitmap (.bmp) format is used in
place of a text SmartKey.  A list of available .bmp files
appears in the Icon Selected drop-down list.

• Preview - This area displays how the SmartKey button will
appear on the SmartKey Pad.

• Icon Selected - This drop-down list contains all of the
available .bmp files used as graphic icons on the SmartKey
Pad.  The .bmp file currently selected appears in the space
provided.

• Title - This text box contains the text that appears on a
SmartKey when the Use Icon Instead of Title check box is
not activated.  You should limit the text to eight to ten letters
by abbreviating functions.  For example, the System
Request SmartKey is labeled as SysRq.

• Flash Prompt  - This text box contains a brief description of
the SmartKey.  This description extends out from the
SmartKey when you leave the mouse cursor idle over the
SmartKey for more than one second.

SmartKey Pad
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Editing a SmartKey

To edit a SmartKey:

1.  Access the Customize SmartKey Pad dialog box:

• Select the Options > Advanced > SmartKey Pad menu
bar command.

• Select the Customize SmartKey Pad toolbar button

.

2. Select the SmartKey you want to edit from the SmartKey Pad
Area.

3. Select the Edit button to edit the selected SmartKey.

4. Make all necessary changes to the SmartKey in the Edit
SmartKey dialog box.  Changes include function, button
label (appearance), and the flash prompt.

5. Select OK.

6. Select OK to return to the Interface screen.
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Add SmartKey

The Add button from the Customize SmartKey Pad dialog box
accesses the Add SmartKey dialog box.  From this dialog box,
you can add a SmartKey.

Add SmartKey Options

• Commands or Scripts - These option buttons allow you to
classify the new SmartKey button function.

• Browse - This button is available when the Scripts option
button is selected.  Select the Browse button to access the
Open dialog box where you can select a script file already
saved on your computer.  Scripts should end with the
extension .CQS.

10 - 6  Add SmartKey Dialog Box
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• Function Selected - This drop-down list changes according
to which option button is currently selected.  The function
currently selected appears in the space provided.  For
example, if the Commands option button is selected, the
Function Selected drop-down list will contain commands
such as Send, Print, Receive, Reset, etc.

• Use Icon Instead of Title - When this check box is
activated, a graphic icon in bitmap (.bmp) format is used in
place of a text SmartKey.  A list of available .bmp files
appears in the Icon Selected drop-down list.

• Preview - This area displays how the SmartKey will appear
on the SmartKey Pad.

• Icon Selected - This drop-down list contains all of the
available .bmp files used as graphic icons on the SmartKey
Pad.  The .bmp file currently selected appears in the space
provided.

• Title  - This text box contains the text that appears on a
SmartKey when the Use Icon Instead of Title  check box is
not activated.  You should limit the text to eight to ten letters
by abbreviating functions.  For example, the System
Request SmartKey is labeled as SysRq.

• Flash Prompt - This text box contains a brief description of
the SmartKey.  This description extends out from the
SmartKey when you leave the mouse cursor idle over the
SmartKey for more than one second.
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Adding a SmartKey

To add a SmartKey:

1.  Access the Customize SmartKey Pad dialog box:

• Select the Options > Advanced > SmartKey Pad menu
bar command.

• Select the Customize SmartKey Pad toolbar button

.

2. Select the SmartKey from within the SmartKey Pad Area

with a question mark on it: .

3. Select the Add button.

4. Design the SmartKey using the Add SmartKey dialog box.  Be
sure to select a button function, button label (either a graphic
.bmp file or text), and flash prompt description.

5. Select OK.

6. Select OK to return to the Interface screen.

SmartKey Pad
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SmartKey Descriptions

SmartKeys quickly perform the command(s) assigned to them.
SmartKeys appear on the SmartKey Pad, a floating keypad
window that you can move anywhere on your computer’s
desktop.  SmartKeys are similar to toolbar buttons in that they
both quickly access commands or scripts.

Commands

A SmartKey can initiate a command.  To add or edit a SmartKey
to perform a command, access the Customize SmartKey Pad
dialog box.

For a complete list of commands, turn to the section called
“Commands” on Page 10-10.

Scripts

A SmartKey can initiate a script.  CQ scripts end with the
extension .CQS.  CQ-3770EE is configured with a few simple
scripts that you can modify and use in your applications.  These
files are located in the main directory that you specified during
installation.  To add or edit a SmartKey to run a script, access the
Customize SmartKey Pad  dialog box.

For information on the sample scripts files that came with your
software, turn to the section called “Script Samples, Tips, and
Hints” on Page 9-8.
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Change Password

The Options > Advanced > Change Password menu bar
command accesses the Change Password dialog box.  From this
dialog box, you can password protect the Interface screen.

Change Password Options

• Run Time Password - The password modification process
requires the re-entry of the old password in the Old
Password text box, the entry of the new password in the
New Password text box, and the re-entry of the new
password in the Confirm New Password text box.  The
characters that are entered are displayed as asterisks (*) for
security reasons.

• Minimum Length  - This text box contains the minimum
length of the Run Time Password.  It is recommended that
a minimum length be specified for this password.  Only
passwords containing at least the minimum number of
characters will be accepted.

10 - 7  Change Password Dialog Box
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Setting the Run Time Password

The Run Time Password can be modified within the Interface
screen.

Passwords Overview

The Interface screen can be password protected by a Run Time
Password.  When a password is activated, the user must enter it
before communicating with the software.  You can set up this
password through the Interface screen.

To modify the Run Time password from the
Interface screen:

1. Select the Options > Advanced > Change Password menu
bar command.

2. The Change Password dialog box appears and presents the
Run Time Password fields for modification.  The password
modification process requires the re-entry of the old
password to provide additional security.  The new password
also requires re-entry as confirmation of the new password
since the characters are not displayed.

3. Set the Run Time Password and any options associated with
the Run Time Password.

4. Select the OK button to return to the Interface screen.
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Audit

The Options > Advanced > Audit menu bar command functions
as a toggle.  If there is a check mark next to it, an audit file is
created when you run the configuration.

Note:
You can also set a configuration to save an audit through the
Configurator program.  Simply activate the Audit check box on
the CQ Configurator screen.  For more information, see the
section called “Activating the Audit Feature” on Page 2-26.

Description of Audit Files

Audit files give a summary of all communications events,
including a date and time stamp of the number of records sent or
received, the number of bytes sent or received, the filenames sent
or received, and the status of each file.

Naming Audit Files

CQ-3770EE automatically names each audit file as the same name
as the configuration with the extension .cqa.  All CQ audit files
are located in the directory that you installed CQ-3770EE under
during installation.  Previous audit files with the same name are
overwritten each time you run a configuration with the audit
feature activated.

Audit
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Audit Files and Scripts

Each time you run CQ-3770EE, a new audit file is created with the
extension .cqa.  If a script terminates communications and then
restarts communications at a later time without exiting
CQ-3770EE, the audit file for the second communications will be
appended to the first audit file.

For more information on the audit file feature, access the tips.txt
file in the examples directory in the location that you installed
CQ-3770EE.

Auditing Communications

To audit communications:

1. Select the Options > Advanced menu bar command.

2. Select the Audit option if a check mark is not currently beside
it.  The check mark indicates that the audit feature is
activated.
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Trace

The Options > Advanced > Trace menu bar command functions
as a toggle.  If there is a check mark next to it, a trace file is
created when you run the configuration.

Note:
You can also set a configuration to save a trace through the
Configurator program.  Simply activate the Trace check box on
the CQ Configurator screen.  For more information, see the
section called “Activating the Trace Feature” Page 2-27.

Description of Trace Files

Trace files give detailed descriptions of all low-level
communications events.  Hexadecimal details of all
communications events are date and time stamped and include
details of options including SDLC framing.

Naming Trace Files

CQ-3770EE automatically names each trace file as the same name
as the configuration with the extension .cqt.  All CQ trace files
are located in the directory that you installed CQ-3770EE under
during installation.  Previous trace files with the same name are
overwritten each time you run a configuration with the audit
feature activated.

Trace

10 - 29



Tracing Communications

To trace communications:

1. Select the Options > Advanced menu bar command.

2. Select the Trace option if a check mark is not currently beside
it.  The check mark indicates that the trace feature is
activated.
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This chapter explains the Data Encryption Standard (DES)
security options (single DES and Triple DES) that may have
come with your version of CQ-3770EE.

Note:
The DES and Triple DES security options are available as
options to CQ-3770EE at additional costs.  Your version of
CQ-3770EE may not be equipped with one of these options.  For
information on how to upgrade your software to CQ-3770EE/DES
or CQ-3770EE/Triple DES, contact your CQ Sales representative.

Security Overview

CQ-3770EE supports several password protection options as well
as the Data Encryption Standard (DES) and Triple DES forms of
encryption.  These features provide exceptional security for EE
communications.

Encrypted Files

All CQ configuration files are encrypted on the CQ-3770EE
distribution CD or diskettes and remain encrypted when they are
loaded onto your computer.  These files can only be viewed
through the Configurator program or through the CQ-3770EE
software during run time.

Chapter 11: DES/Triple DES Security Options

11 - 2



Password Protection

Access to the Configurator and Interface programs can be
restricted by implementation of passwords.  The passwords can
be set through the Configurator program or through the Interface
screen during run time.

• For more information on setting passwords through the
Configurator program, see the section called “Passwords” on
Page 2-29.

• For more information on setting passwords through the
Interface screen during run time, see the section called
“Change Password” on Page 10-25.

If your CQ-3770EE software was initially configured with
password protection off-site (usually by a Central Site
administrator), the Configuration Password, Run Time
Password, and all password related parameters may have already
been set for you.  The actual values of the passwords are never
displayed on the screen.  You will need to get this password
information in order to access CQ-3770EE.

DES/Triple DES Encryption

The DES options, including Master Key information, are also
set through the Configurator program.  The remainder of this
chapter explains the features of the single DES and Triple DES
security options.

Security Overview
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DES/Triple DES Encryption

CQ-3770EE supports the Data Encryption Standard (DES)
through the single DES and Triple DES security options.  Your
DES version of CQ-3770EE depends on the DES option that came
with your software:

• CQ-3770EE/DES - This version supports single DES data
encryption.  A single Master Key is stored through this
version.

• CQ-3770EE/Triple DES - This version supports Triple DES
data encryption.  Up to three Master Keys are stored
through this version.

All DES security option information appears on two folder tabs
within the Configurator program.  These folder tabs are called
DLU(EE) and Internal PU.
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DLU(EE) Folder Tab

The DLU(EE) folder tab contains the settings associated with the
minimum setting of session-level encryption that is required in
the BIND for CQ-3770EE to accept the BIND.

The encryption levels that you may choose from depends on the
DES version of CQ-3770EE  that you are using.  CQ-3770EE
supports five different levels of minimum session-level
encryption.

Encryption Level Versions
Supported

No Encryption - No session-level
cryptography is required.

CQ-3770EE
CQ-3770EE/DES
CQ-3770EE/Triple DES

Selective DES Encryption -
Session-level selective or mandatory
cryptography is required through single
DES or Triple DES encryption.

CQ-3770EE/DES
CQ-3770EE/Triple DES

Mandatory DES Encryption -
Session-level mandatory  cryptography is
required through single DES or
Triple DES encryption.

CQ-3770EE/DES
CQ-3770EE/Triple DES

Selective Triple-DES Encryption -
Session-level selective or mandatory
cryptography is required through
Triple DES encryption.

CQ-3770EE/Triple DES

Mandatory Triple-DES Encryption -
Session-level mandatory  cryptography is
required through Triple DES encryption.

CQ-3770EE/Triple DES

DES/Triple DES Encryption
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To set the minimum session-level encryption:

1. From the CQ_WIN program group that was created during
installation, select the Configurator icon.

2. Enter the Configuration Password if you are prompted to do
so.  The CQ Configurator screen appears.

3. Select the Advanced button.  The Advanced Options screen
appears.

4. Select the DLU(EE) folder tab.

5. From this screen, select the option button that corresponds with
the Minimum Session-Level Encryption that you want
required in order for CQ-3770EE  to accept the BIND.  If an
option button is grayed out, then this form of session-level
encryption was not included with your version of CQ-3770EE
(see the previous table).

6. In the event of communications problems, you may require a
communications log file to be written.  This log file can be
written to include data in decrypted or encrypted form.  This
log file may be interpreted by users familiar with the SNA
protocols and by personnel who are authorized to view
decrypted data.  If you want to log the decrypted data, select
the Trace Decrypted Data check box.  The communications
log file will be written with un-encrypted data.

7. Select the OK button to return to the CQ Configurator screen.

8. Select the Save button.

9. Select the Close button.
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Internal PU Folder Tab

The Internal PU folder tab contains the settings associated with
storage of a Master Key.

The following Master Key storage locations are available for use
with the DES versions of CQ-3770EE.

• Software - Master Key is stored through the CQ software
(Page 11-8).

• Glenco - Master Key is stored through a Glenco Hardlock
device attached to the computer (Page 11-9).

• Jones Card - Master Key is stored through a Jones Futurex
ENC-347 card installed in the computer (Page 11-17).

The next few sections explain each of these storage locations in
greater detail as well as specific hardware installation instructions
where applicable.  Turn to the page number indicated above for
more information on each of these storage locations.
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Software DES

CQ-3770EE supports Master Key storage through the CQ
software.  Software storage eliminates the expense and
maintenance of additional hardware.

Master Key Distribution

CQ-3770EE supports the split key method defined in the
American National Standards Institute (ANSI) X9.17 standard.
The split key method splits the Master Key into two parts.  The
Master Key is split at the Central Site before distribution to
Remote Sites.  After the key is split, the Central Site personnel
enters the first part of the Master Key and then distributes the
CQ software to each Remote Site where the second part of the
Master Key is entered.

Note:
If you are a Central Site administrator, you can contact CQ for
more information on splitting the Master Key during Central Site
installation.

CQ-3770EE also supports entering the Master Key in its entirety
at either the Central Site or Remote Site.

Master Key Installation

For information on installing a Master Key, turn to the section
called “Master Key Installation” on Page 11-19.
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Glenco Hardlock Device

CQ-3770EE supports Master Key storage through the Glenco
Engineering, Inc.’s (a.k.a. Aladdin Knowledge Systems, Inc.)
Hardlock devices.  This form of DES Master Key storage
requires an external 306060 Hardlock DES dongle device
attached to a computer’s parallel printer port.

Dongle Description

The dongle is a portable external module that connects directly to
the printer port on a PC, notebook computer, or compatible
machine.  The printer cable can be attached to the dongle,
allowing the end user to perform normal printer tasks while the
dongle is attached to the computer.  The dongle’s data rate is
limited by the printer port to just under 6K bytes per second.

Note:
Due to certain limitations of Windows 95, CQ recommends that
you quit or temporarily suspend any printer sessions that are
using the printer port that the dongle is attached to during
initialization.  Once the Master Key  has been obtained from the
dongle by CQ-3770EE and you are logged onto a DES  session,
you can resume all print jobs without interruption.

The GL306060 Hardlock dongle contains an application-specific
integrated circuit that supports the Master Key for the DES
algorithm stored in the EEPROM cells.  The Master Key may be
written and used but there are no functions that permit the
Master Key to be read.

A feature of the Hardlock DES device is its ability to merge an
external key part with the internal key storage, either storing the
result or using it as a DES key without transferring it to
EEPROM storage.
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Master Key Distribution

There are two different ways that your Central Site personnel can
choose to distribute the Master Key.  Your Central Site
personnel should instruct you which of the following ways you
will use to install the Master Key.

• Option 1: Glenco Hardlock Device Only - CQ-3770EE
supports entering the Master Key in its entirety.  This
method involves simply plugging the pre-programmed
Glenco Hardlock device into your computer’s printer port.
There is no configuration that needs to occur within the
Configurator program.  If your Central Site personnel
supplies you with the dongle device and does not provide
any type of a hexadecimal code, this is most likely the option
you will use.

• Option 2: Glenco Hardlock Device and Hexadecimal
Code (Split Key Method) - CQ-3770EE supports the split
key method defined in the American National Standards
Institute (ANSI) X9.17 standard.  The split key method splits
the Master Key into two parts.  The Master Key is split at
the Central Site before distribution to Remote Sites.  After
the key is split, the Central Site personnel distribute the
pre-programmed Glenco Hardlock device and CQ-3770EE
software to each Remote Site.  Each Remote Site then plugs
the Glenco device into the computer’s printer port and enters
the second part of the Master Key through the Configurator
program.  If your Central Site personnel supply you with the
dongle device as well as a hexadecimal code, this is most
likely the option you will use.
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Hardware Installation

For the Windows 2000 and Windows XP operating systems, you
must install a special Glenco device driver that came with your
CQ software CD to properly use the Glenco Hardlock DES
dongle.  Windows 95, Windows 98, and Windows NT users are
not required to install this device driver.

• Windows 95, Windows 98, and Windows NT Users - For
information on installing the Glenco Hardlock DES dongle,
turn to the section called “Windows 95, Windows 98, and
Windows NT Installation” on Page 11-12.

• Windows 2000 Users - For information on installing the
Glenco Hardlock DES dongle as well as the required
Windows 2000 dongle device driver, turn to the section
called “Windows 2000 Installation” on Page 11-13.

• Windows XP Users - For information on installing the
Glenco Hardlock DES dongle as well as the required
Windows XP dongle device driver, turn to the section called
“Windows XP Installation” on Page 11-15.

DES/Triple DES Encryption

11 - 11



Windows 95, 98, and NT Installation

Note:
These instructions are intended for users running CQ-3770EE
under the Windows 95, Windows 98, or Windows NT operating
systems.

1. Connect the Glenco Hardlock DES dongle to any parallel port
on your computer.  If there is a printer cable attached to that
port, detach the printer cable and plug the dongle into the
port.  Reconnect the printer cable to the dongle.  The Glenco
Hardlock DES dongle should not affect normal printer
operation.

Glenco Hardlock DES dongle installation is now complete.  For
information on installing a Master Key, turn to the section called
“Master Key Installation” on Page 11-19.
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Windows 2000 Installation

Note:
These instructions are intended for users running CQ-3770EE
under the Windows 2000 operating system.  The Windows 2000
operating system requires special dongle device driver
installation that is explained in these instructions.

1. Connect the Glenco Hardlock DES dongle to any parallel port
on your computer.  If there is a printer cable attached to that
port, detach the printer cable and plug the dongle into the
port.  Reconnect the printer cable to the dongle.  The Glenco
Hardlock DES dongle should not affect normal printer
operation.

2. Select Start > Settings > Control Panel.

3. Select the Add/Remove Hardware icon.

4. Select the Next button.

5. Select the Add/Troubleshoot a device button and then select
the Next button.

6. From the list of Devices, select the Add a new device option
and then select the Next button.

7. Select the No, I want to select the hardware from a list
option and then select the Next button.

8. From the list of Hardware types, select the Other devices
option and then select the Next button.  After a few
moments, the next screen appears.

9. Select the Have Disk button.

DES/Triple DES Encryption

11 - 13



10. Select the Browse button and locate the directory where you
installed CQ-3770EE.

Note:
The default directory that you most likely used during
software installation is C:\CQ3770.

11. Select the glendngl.inf file and then select the Open button.

12. Select the OK button.

13. Select the Hardlock DES Dongle  option and then select the
Next button.

14. Select the Next button.

15. Select the Finish button.

Glenco Hardlock DES dongle installation is now complete.  For
information on installing a Master Key, turn to the section called
“Master Key Installation” on Page 11-19.
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Windows XP Installation

Note:
These instructions are intended for users running CQ-3770EE
under the Windows XP operating system.  The Windows XP
operating system requires special dongle device driver
installation that is explained in these instructions.

1. Connect the Glenco Hardlock DES dongle to any parallel port
on your computer.  If there is a printer cable attached to that
port, detach the printer cable and plug the dongle into the
port.  Reconnect the printer cable to the dongle.  The Glenco
Hardlock DES dongle should not affect normal printer
operation.

2. Select Start > Control Panel.

3. Find the Add Hardware icon that should appear somewhere
within the Control Panel.  You may have to switch to
“classic view” or change other settings in order for the Add
Hardware icon to appear.

4. Once you have found the Add Hardware icon, select the Add
Hardware icon.

5. Select the Next button.  The Add Hardware Wizard will search
for new hardware.

6. A question will appear asking you if you have already
connected the new hardware to your computer.  Select the
Yes, I have already connected the hardware option and
then select the Next button.
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7. From the list of Installed hardware, select the Add a new
hardware device option and then select the Next button.

8. Select the Install the hardware that I manually select from a
list (Advanced) option.

9. From the list of Common hardware types, select the Show
All Devices option and then select the Next button.  After a
few moments, the next screen appears.

10. Select the Have Disk button.

11. Select the Browse button and locate the directory where you
installed CQ-3770EE.

Note:
The default directory that you most likely used during
software installation is C:\CQ3770.

12. Select the glendngl.inf file and then select the Open button.

13. Select the OK button.

14. Select the Hardlock DES Dongle  option and then select the
Next button.

15. Select the Next button.

16. A message appears stating that the Hardlock DES dongle has
not passed Windows Logo testing.  Select the Continue
Anyway button to continue with installation.

17. Select the Finish button.

Glenco Hardlock DES dongle installation is now complete.  For
information on installing a Master Key, turn to the section called
“Master Key Installation” on Page 11-19.
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Jones Futurex ENC-347 Card

CQ-3770EE supports Master Key storage through the Jones
Futurex Encryptor 347 SDLC adapter card.  This form of DES
requires an internal Jones Futurex ENC-347 card installed in a
PC.

ENC-347 Adapter Card Description

The Jones Futurex ENC-347 card provides security for remote
computers, mainframes, and networks by encrypting sensitive
data over synchronous communication lines to remote sites.  The
ENC-347 is equipped with a single synchronous port that is
functionally compatible with IBM’s SDLC adapter card.  This
allows CQ-3770EE to operate with the ENC-347 without any
modifications.

Security features of the ENC-347 include:

• A user supplied key to encrypt and decrypt sensitive data.

• Keyword protection through the use of fixed and variable
keys.  The fixed and variable keywords used in conjunction
with CQ-3770EE provide a variety of logical and physical
security options.  Among these options are multi-layered
security, user authentication, and PC identification.

• Physical security is accomplished by encasing sensitive
components directly on the card in a steel enclosure filled
with x-ray opaque epoxy.  This security prevents intruders
from probing and reading the keywords while the board is
resident in the PC.
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The Jones Futurex ENC-347 card contains an application-specific
integrated circuit that supports the Master Key for the DES
algorithm stored in the EEPROM cells.  The Master Key may be
written and used but there are no functions that permit the
Master Key to be read.

A feature of the Jones Futurex ENC-347 card is its ability to
merge an external key part with the internal key storage, either
storing the result or using it as a DES key without transferring it
to EEPROM storage.

Master Key Distribution

With the Jones Futurex ENC-347 Card, the Master Key is
distributed in its entirety from within the card.  This method
involves simply installing the pre-programmed Jones Futurex
card into a slot on your PC.  There is no configuration that needs
to occur within the Configurator program.  The Central Site
personnel distribute the pre-programmed Jones Futurex card and
CQ software to each Remote Site.  Each Remote Site then plugs
the Jones Futurex card into an open PC slot.

Hardware Installation

Follow the Jones Futurex card installation instructions you should
have received from your Central Site personnel.  When the card
is installed, continue with the Master Key installation
instructions later in this chapter.

For information on installing a Master Key, turn to the section
called “Master Key Installation” on Page 11-19.
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Master Key Installation

In most cases, you should receive specific instructions on how to
install one or more Master Keys for use with your DES version
of CQ-3770EE.  The instructions in this section serve as a
guideline.

Master Key Notes

When going through these instructions, be aware that
CQ-3770EE/Triple DES users will need to enter a double or triple
key.  In most cases, simply a double key will do.  This means that
Master Key Numbers 1 and 2 will have Key Locations such as
Software, Glenco, or Jones Card as well as the appropriate
Master Key information.  Master Key Number 3 will have a
Key Location of NONE.

Also, be aware that CQ-3770EE/DES users will need to enter a
single key.  This means that Master Key Number 1 will have a
Key Location such as Software, Glenco, or Jones Card as well
as the appropriate Master Key information.  Master Key
Numbers 2 and 3 are grayed out so no information needs to be
entered for these options.

Hardware Installation

If you are using a Glenco Hardlock DES dongle device, you
should have already installed the device according to the previous
instructions in this chapter.  For Glenco Hardlock DES dongle
installation instructions, turn to the section called “Hardware
Installation” on Page 11-11.  When the Glenco Hardlock DES
dongle device is plugged in, continue with the Master Key
installation instructions on the next page.

If you are using a Jones Futurex card, follow the Jones Futurex
card installation instructions you should have received from your
Central Site personnel.  When the Jones card is installed,
continue with the Master Key installation instructions on the
next page.
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To install a Master Key at the Remote Site:

1. From the CQ_WIN program group that was created during
installation, select the Configurator icon.

2. Enter the Configuration Password if you are prompted to do
so.  The CQ Configurator screen appears.

3. Select the Advanced button.  The Advanced Options screen
appears.

4. Select the Internal PU folder tab.  There should be a group box
on the Internal PU folder tab page called Master Key
Storage Options .

5. From the Master Key Number options, select an option
number for the Master Key you intend to configure.  For
example, single DES users should always select 1.
Triple DES users should select option 1, 2, or 3 depending
on the Master Key to be configured.  If installing a Master
Key for the first time, always select option 1.

Note:
If you are upgrading from a previous DES  version of
CQ-3770EE, select the Clear Master Key button now before
continuing.  DO NOT select the Clear Master Key button if
you are NOT upgrading your version of CQ-3770EE
software or if you received your software from a Central
Site contact.  Your Central Site contact may have already
configured part of the Master Key in your software.  By
selecting this button, you will clear the first part of the
Master Key  entered by the Central Site if they implemented
the split key method.

6. From the Keyn Location drop-down list, select the location of
the Master Key.  Available options include Software,
Glenco, and Jones Card.  If you select the NONE option,
no DES Master Key information will occur for the currently
selected Master Key Number.
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7. If you selected Software or Glenco as the Key Location:

a. Enter the 16 hexadecimal digits of the Master Key that
was provided to you by your Central Site personnel into
the Partial Master Keyn text box.

b. Confirm your entry in the text box labeled Confirm
Partial Key.

c. Select the Accept Partial Keyn button.  This is the button
located directly below the Confirm Partial Key heading.

8. If you selected Jones Card as the Key Location, the options in
the Master Key Storage Options group box ( I/O Address
and DES Keyn Slot #) should have been pre-configured for
you by your Central Site personnel.  If you were instead
instructed to enter these values now, enter them in the spaces
provided.

9. If you need to enter another Master Key, repeat steps 5
through 8 for each Master Key.  For example, Triple DES
users should have been instructed by their Central Site
personnel to enter at least two keys.

10. After you have entered your encryption options, select the OK
button to return to the CQ Configurator screen.

11. Select the Save button.

12. Select the Close button.

Note:
If you entered hexadecimal digits in the Partial Master
Keyn and Confirm Partial Key text boxes, these text boxes
will always be blank when re-entering the Internal PU
folder tab screen.  There will be no indication that
anything was ever entered into these fields.  These fields
are used only to change, not display, the Master Key.
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This chapter explains the customer services available through
CQ Computer Communications, Inc.

About CQ

CQ Computer Communications, Inc. has been a leading
communications connectivity and post-processing solution
provider since it was founded in 1982.  CQ designs, engineers,
and distributes these solutions to clients worldwide.

Address:
CQ Computer Communications, Inc.
570 Peachtree Parkway
Cumming, GA  USA  30041-6820

Telephone: 770-844-0233
Office Hours: Mon-Fri, 9:00 A.M. to 5:00 P.M., EST

Fax: 770-886-7021

E-Mail:
email@cq-comm.com
sales@cq-comm.com
tech @cq-comm.com

Internet: http://www.cq-comm.com
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Sales

CQ’s sales department staff is ready to answer your sales
questions Monday through Friday during regular office hours
(9-5, EST).

Contact your CQ sales representative for information on CQ’s
complete line of products, software upgrade information, CQ’s
beneficial software maintenance plan, and more.  If you need
technical assistance, please contact the CQ Technical Support
Department.

Sales Phone:
1-800-523-6807
770-844-0233
Office Hours: Mon-Fri, 9:00 A.M. to 5:00 P.M., EST

International: 1-770-844-0233

Sales Fax: 770-886-7021

Sales E-Mail: sales@cq-comm.com

Internet: http://www.cq-comm.com

Sales
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CQ Web Site

CQ’s web site address is:

•  http://www.cq-comm.com

Check us out for information concerning your CQ product.

User Registration Form

Please take the time to fill out the User Registration Form
enclosed with your CQ product.  Upon receipt of this form, you
become eligible for special incentives offered through CQ
including discounts on software upgrades and any other special
programs offered by CQ.

User Registration Online

For your convenience, you can register your new CQ software
conveniently through CQ’s web site.  Just locate your software
serial number and follow these simple steps:

Note:
Your software serial number can be found most easily through
the Help > About menu bar command from the CQ Configurator
or Interface screens.

1. Point your web browser to CQ’s User Registration page:

•  http://www.cq-comm.com/user_reg.htm

2. Fill in the User Registration ONLINE form and submit it to CQ.

3. Upon submission of this form, you become eligible for special
incentives offered through CQ including discounts on
software upgrades and any other special programs offered by
CQ.
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Technical Support Policy

CQ recognizes the importance of providing our customers with
access to comprehensive technical services and support.  CQ also
feels that access to product upgrades and updates is an integral
part of an organization’s overall software deployment strategy.
With this in mind, CQ provides the CQ Access Point  agreement
to its customers - CQ’s annual license activation and software
maintenance agreement.  With each license acquisition, you
receive annual license activation as well as access to the product
upgrade and technical support features of Software Maintenance.

License Activation

During initial installation, your new CQ software will require its
license to be activated by contacting CQ and requesting
“License Key Codes”.  Upon activation, the software will be fully
licensed and fully functional on the workstation or server that you
have loaded it onto.  Then, on an annual basis, your license will
need to be reactivated.   You will receive notification in the form
of a pop-up message 30 days from the expiration date that the
software license is due to expire soon.  Then, you will receive a
similar notification each day under the 30-day period.  If you
have been unable to extend your license within the allotted time,
CQ allows a short grace period before the license is terminated.
By maintaining this “grant of license” with CQ, this ensures a
stable environment for your CQ solution to function.  It also
allows for the free product upgrades and updates that you will be
receiving to be more easily installed.

Technical Support Policy
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Technical Support

During each year of your software’s usage, CQ’s technical
support staff will be available to troubleshoot any CQ related
technical issues.  CQ will provide up to two hours of telephone
technical support for each licensed CQ software product.  Along
with the two hours of telephone support, we will provide
unlimited e-mail technical support.  This is CQ’s way of making
sure that you are covered with the technical support that you
need.  This is your way of getting an increased return on your
investment in a total software solution.

Product Updates and Upgrades

As new product upgrades (new features, etc.) and product
updates (patches, bug fixes, etc.) become available, they will be
made available to CQ Access Point customers.  Then, you can
upgrade to new releases and new versions as your needs dictate.

By providing constantly updated software to CQ Access Point
customers such as yourself, we are helping you maintain your
software budgeting.  For example, if you weren’t enrolled in the
CQ Access Point agreement, then you would have to budget an
uncertain amount for new software releases.  Then, if you forgot
to budget for new software releases – or didn’t even know that
you needed to budget for this – then you are stuck with an
unplanned expenditure, or forced to wait until the next budget
cycle to be current with the CQ software.  With the
CQ Access Point agreement, you never have to worry about new
software releases because they are included in the agreement.
This makes it simple for you to purchase and administer all CQ
related solutions in one planning and budgeting cycle as part of
its overall software acquisition plan.
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CQ Access Point Agreement Features

• License Activation and Annual License Renewals.
Upon initial installation of the CQ software, you will be
entitled to activate your license for a period of one year.
Then, on an annual basis, your license will need to be
reactivated by continually paying your annual
CQ Access Point agreement fee.  By maintaining this “grant
of license” with CQ, this ensures a stable environment for
your CQ solution to function and also allows for the free
product upgrades and updates that you will be receiving to
be more easily installed.

• Initial Telephone Installation and Configuration Support.
Within 30 days of receipt of the CQ solution, the customer
will be entitled to contact CQ via telephone and speak with a
CQ Technical Support Representative for up to 30 minutes
for initial installation and configuration assistance.  In most
cases, a maximum of 30 minutes will be all that is required
for the CQ solution to be installed and working properly.  At
CQ’s sole discretion, additional phone calls and support time
may be initiated.

• Telephone Technical Support.
Technical support of up to two hours per license is provided
to CQ Access Point customers on an annual basis.
Subscribers will receive a telephone response from CQ
within four hours that the original call is received.  Please
note that CQ does not guarantee that the technical issue that
is phoned in to CQ will be resolved within two hours, but
that CQ will begin to troubleshoot the situation and attempt
to solve the issue expediently.

Technical Support Policy
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• Unlimited E-Mail Technical Support.
After initial telephone technical support has expired, all
subsequent technical support issues for the CQ solution must
be made through e-mail.  CQ guarantees that the customer
will receive a response within one business day from the day
the request is received by CQ.  Please note that CQ does not
guarantee that the technical issue described in the e-mail will
be resolved within one business day, but that CQ will begin
to troubleshoot the situation and attempt to solve the issue
expediently.

Technical support issues that the CQ Access Point agreement
covers include installation help, simple configuration of
communications parameters, basic CQ solution operating
procedures, and limited troubleshooting of hardware and
software issues.  This agreement does not include
programming or script writing.  Some CQ solutions come
with basic scripts or customized user interfaces.  These
scripts and customizations were developed as a service for
CQ customers and are provided on an “as is” basis.

• Free Same Version Software Updates
(Patches, Bug Fixes, etc.).
The customer is entitled to free patches and bug fixes from
CQ for the version of CQ software licensed.

• Free New Version Software Upgrades
(New Features, etc.).
The customer is entitled to free CQ software upgrades to
major releases as well as new CQ software releases with new
features.  Keep in mind that you may use either the upgraded
software or the original CQ software, but never both at the
same time.
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Technical Support and
Troubleshooting

The CQ Access Point agreement includes troubleshooting of
CQ’s solution problems as well as limited conflicts with other
hardware and software products already present on the system.
Over the course of troubleshooting of these errors, CQ may
require the customer to run diagnostic tests as instructed by CQ’s
technical support staff.  In these cases, the customer must have
some degree of computer knowledge in order for CQ to be able
to offer assistance.

Over the course of troubleshooting, if it is determined that there
is an error in CQ’s software or hardware products, CQ will do all
that it can to fix the error.  CQ will, at its sole discretion,
accomplish this through one or more ways: CQ will fix the error
and provide a working solution to the customer; CQ will let the
customer know that the error has been fixed in a later version of
the software; CQ will suggest alternatives that will avoid the
error; and/or CQ will notify the customer that the error will not
be repaired in the foreseeable future.

All technical support issues will be limited to applications that
involve CQ products.  If there is an identified error through the
use of CQ’s products due to other environmental issues such as
operating system conflicts or with conflicts with other installed
software or hardware, CQ’s responsibility will be limited to the
discovery of the problem or simply ruling out CQ’s products as
the cause of the problem.

CQ Access Point agreement subscriptions must be purchased
concurrently for all licenses of the CQ solutions owned by a
customer.  CQ may, at its sole discretion, prorate the term of the
customer’s CQ Access Point agreement subscription so that all
CQ Access Point agreement subscriptions for the CQ customer
renew concurrently.
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Software Copy Protection through
“License Key Codes”

CQ protects its software assets and intellectual property from
illegal, unauthorized duplication and piracy through software
copy protection.  This method in no way hinders or otherwise
obstructs the CQ software’s capabilities.  Through CQ’s license
and software copy protection, the CQ software is “linked” to the
workstation (this can be a single user workstation or a server) that
it is loaded onto through “License Key Codes”.

The “License Key Codes” are based on some of the workstation’s
internal characteristics.  This prevents the software from being
installed and used without authorization on more than one
workstation.  In order to enable the software on more than one
workstation, additional “License Key Codes” must be generated
for each workstation.  CQ permits a customer to transfer the
software from one workstation to another by invalidating the
prior “License Key Codes” and issuing new “License Key
Codes”.  In order for CQ to issue these new “License Key
Codes”, the customer must provide CQ with a valid removal code
that is generated by the software.  Customers with environments
where frequent reinstallation, regular system changes, or other
modifications are a natural occurrence are strongly advised to
contact CQ before any workstation changes are made.
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Contacting Technical Support

If you have a technical question that you cannot answer with
CQ’s Help screens or documentation and you are currently
enrolled in the CQ Access Point agreement, please contact our
Technical Support department.  CQ Technical Support
representatives look forward to answering your questions
regarding your CQ products.

Tech Support
Phone:

770-844-0233
Technical support representatives are available Monday
through Friday (excluding certain holidays) from 9:00 A.M.
to 5:00 P.M., EST

Tech Support
E-Mail: tech@cq-comm.com

Before contacting CQ, please have the following
information ready:

• NAME - Your name as well as the name of the person
within your company or organization that purchased the CQ
product.

• COMPANY - Your company as well as the name of the
company or organization that purchased the CQ product (in
some cases, this may be an outside consultant, etc.).

• PHONE - A phone number where you can be reached.

• SERIAL NUMBER - Your CQ software serial number can
be found most easily through the Help > About menu bar
command from the CQ Configurator or Interface screens.
Also, please provide the serial numbers of any CQ hardware
you may be using.

• TECHNICAL DESCRIPTION - A detailed description of
your current technical issue.  This may include error
messages you are receiving, your operating system, the name
of the mainframe/host site, the types of hardware you are
using such as modems, etc.

Technical Support Policy
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Policies and Procedures

Technical and Consulting Services

CQ technical and consulting services that are provided by CQ to
customers without enrollment in the CQ Access Point agreement
are available on an hourly basis at the then current hourly rate
with a minimum charge of four hours and may be subject to the
current CQ prices, terms, and conditions at the time the technical
and consulting services are used.  For on-site technical and
consulting services, the customer must agree to accept reasonable
costs determined by CQ that are associated with travel expenses
for CQ support personnel.

Hardware Warranties

All hardware products developed by CQ (i.e., CQ-Sync200 PCI,
etc.) are covered by a Limited Lifetime Hardware Warranty.
CQ warrants its hardware products to be in working order for the
life of the product.

You can find details on CQ’s Hardware Warranties on the
Hardware Warranties page on CQ’s web site.

Product Reproduction Policy

The customer agrees to make no more than one copy of the CQ
software, for backup purposes, at any one time.  The customer
also agrees to label the backup copy with the software name,
serial number, and copyright and trademark notices provided by
CQ on the original software media.  The only copies of the
software that that are permitted the customer are the original
copy, the backup copy, and one copy of the CQ software loaded
and in use on one computer at any time.

Chapter 12: Customer Services
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Backup Systems

CQ always recommends the purchase of a backup system for
contingency purposes.  To help encourage the implementation of
backup systems, CQ offers discounts on software used for
backup purposes.  These discount offers are contingent on the
customer’s agreement to use backup products for reserve backup
purposes only and not for additional processing capacity (i.e.,
another “active” system).  Backup products should not be placed
in service while the machine with the original software installed
is running except for periodic updating of the backup system to
mirror the main original system.

CQ cannot be held responsible for a lack of appropriate
contingency and disaster-recovery planning on the customer’s
part.  Therefore, CQ strongly encourages its customers to
maintain a backup system according to their connectivity needs
and to also subscribe all systems into the CQ Access Point
agreement. 

Backup License Activation

During initial installation, the backup CQ software will require its
license to be activated by contacting CQ and requesting
“License Key Codes”.  Upon activation, the software will be fully
licensed and fully functional on the backup workstation or server
that you have loaded it onto for a period of one year.  It will be
the user’s responsibility to contact CQ annually in order to extend
the backup software license each year.  Also, CQ will only
extend the backup license if the CQ Access Point agreement for
the original license of the software has been paid in full when it is
due on an annual basis.

Policies and Procedures
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Technical Support

Unless you have chosen to pay the annual fee for the
CQ Access Point agreement on the backup software, technical
support for the backup software will be limited to 30 minutes for
initial installation and configuration assistance.  In most cases, a
maximum of 30 minutes will be all that is required for the backup
CQ solution to be installed and working properly.  At CQ’s sole
discretion, additional phone calls and support time may be
initiated.

Product Updates and Upgrades

Unless you have chosen to pay the annual fee for the
CQ Access Point agreement on the backup software, you will
not have access to new product upgrades (new features, etc.) and
product updates (patches, bug fixes, etc.) for the backup software.

By annually paying for the CQ Access Point agreement, your
backup system will mirror your “active” system.  In order to have
an effective backup system, CQ recommends that you subscribe
to the CQ Access Point  agreement for all live “active” systems
as well as their corresponding backup systems.
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Software Protection Policy through
“License Key Codes”

CQ protects its software assets and intellectual property from
illegal, unauthorized duplication and piracy through software
copy protection.  This method in no way hinders or otherwise
obstructs the CQ software’s capabilities.  Through CQ’s license
and software copy protection, the CQ software is “linked” to the
workstation (this can be a single user workstation or a server) that
it is loaded onto through “License Key Codes”.

The “License Key Codes” are based on some of the workstation’s
internal characteristics.  This prevents the software from being
installed and used without authorization on more than one
workstation.  In order to enable the software on more than one
workstation, additional “License Key Codes” must be generated
for each workstation.  CQ permits a customer to transfer the
software from one workstation to another by invalidating the
prior “License Key Codes” and issuing new “License Key
Codes”.  In order for CQ to issue these new “License Key
Codes”, the customer must provide CQ with a valid removal code
that is generated by the software.  Customers with environments
where frequent reinstallation, regular system changes, or other
modifications are a natural occurrence are strongly advised to
contact CQ before any workstation changes are made.

Product Evaluation Policy

Customers may request CQ products for evaluation from CQ for
a set period of time.  CQ will evaluate each evaluation request on
a case-by-case basis to determine if the product that is requested
for evaluation will solve the customer’s needs.  CQ may at any
time demand return of any products under evaluation.  Evaluation
products not returned within the agreed upon period of time or
not returned to CQ following a request by CQ for its return will
be considered to have been purchased and the customer will be
invoiced accordingly.
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Payment Policy

CQ provides several ways to purchase our products and solutions:

• Credit Card.  For added convenience, CQ accepts
numerous credit cards, including Visa, MasterCard, and
American Express.  Credit card orders provide the most
expedient means to order products from CQ.  In most cases,
orders that are paid for through the use of a credit card can
be shipped the same day the order is received.  To place an
order through a credit card, simply call CQ at
1-800-523-6807.

• Pre-Payment.  Products can also be ordered from CQ
through pre-payment by company check.  Before pre-paying
for CQ products, please contact CQ for mailing instructions
and to also confirm the final cost of the products.

• Company Purchase Order.  For orders placed with CQ
through the use of a company purchase order, you may fax
or e-mail the company purchase order to CQ.  In some cases,
the use of a company purchase order to order products from
CQ may be subject to credit approval.  In these cases, CQ
may ask for credit statements and banking references.

• Wire Transfer.  CQ accepts payment for orders via wire
transfer.  Customers should contact CQ for further
instructions regarding the specifics of wire transfer
payments. 

Customers that have been granted payment terms of “NetDue”
agree that CQ is to receive payment immediately upon receipt of
CQ’s invoice.  Customers that have been granted payment terms
of “Net15" (or similarly, ”Net30", “Net45", etc.) agree that CQ is
to receive payment within 15 days or less of the date that the
customer’s products are shipped or 15 days or less from the date
that technical services are rendered by CQ.
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Failure to pay invoices within the agreed amount of time subjects
the customer to loss of credit approval and other privileges for
future orders.  CQ may further withhold technical support
services, disregard Hardware Warranties to customers, and/or
further withhold CQ services to customers that are past due on
payments to CQ, until the customer’s accounts are brought
current.  Furthermore, CQ reserves the right to collect the full list
price of CQ products with the forfeiture of any discounts that
might have been granted to the customer, and also in collection of
past due balances, CQ may add interest or finance charges of
1.5% of the unpaid balance per month, retroactive to the original
billing date.  If use of a third-party agency, such as a collection
agency, or if any formal legal action is required by CQ in order to
recover payment of past due invoices, the customer is further
liable for reimbursement to CQ of all third-party fees, including
collection agency fees, attorneys’ fees, court fees, plus any
additional expenses incurred in preparation of testimony and/or
travel to testify before a court, to the fullest extent allowed by the
applicable laws at the customer’s location.
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Return Policy 

CQ strives to make all of our customers completely satisfied with
the purchase of CQ solutions.  To this end, all CQ software and
hardware products are warranted to function properly and to meet
the needs of the customer through the products’ represented
purposes.  If a customer chooses to return a CQ product in good
condition within 30 days of the original purchase date, CQ will
credit, at its sole discretion, any payments that have been made to
CQ, less shipping costs, and any unpaid bill will be adjusted to
only include any unpaid shipping costs.

CQ will accept any returned products to CQ after 30 days of the
original purchase date at CQ’s sole discretion.  These returns may
be subject to a twenty-five percent (25%) restocking fee.  In order
for a product to be returned to CQ after 30 days, the customer
must first contact CQ and receive an authorized Return
Authorization Number (RA#).  Once an RA# has been assigned,
the product must be returned in the original packing and the
product received by CQ before CQ will authorize a refund.
Returned products and refunds are subject to CQ’s approval.
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Shipping and Delivery Procedures

All CQ orders are shipped to our customers by way of a national
shipping carrier (UPS, FedEx, Airborne Express, etc.).  If you
request a specific shipment option or carrier, we will do our best
to accommodate your request.  All shipping and handling charges
will be added to your order and these charges are different
depending on the carrier, the destination, and also if there are any
additional duties or taxes that are incurred for the shipment.

Terms of shipment are F.O.B. Destination.  In case of damage,
shipments received should be accepted and the appropriate carrier
should be contacted for freight claims processing.  Damaged
shipments received via common and air carriers must be accepted
with all damages clearly noted on the bill of lading.  The
Consignee must place damage claims with the carrier.  All
damage claims are the responsibility of the Consignee.

Changes to Policies and Procedures

CQ reserves the right to change policies and procedures at any
time.  All other rights are reserved by CQ Computer
Communications, Inc., 570 Peachtree Parkway, Cumming,
Georgia 30041-6820 USA (www.cq-comm.com).
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Chapter 13

CQ Solutions and
Products



CQ Computer Communications, Inc. has been a leading
communications connectivity and post-processing solution
provider since it was founded in 1982.  CQ designs, engineers,
and distributes these solutions to clients worldwide.  For more
information on these solutions, contact CQ at 770-844-0233  or
email@cq-comm.com.

Productivity Solutions

Have you been researching data management tools that can offer
your organization the benefits of increased efficiency and lower
costs?  Or, are you simply tired of not getting the benefits that
you had hoped for from the data management technology
initiatives that you have already implemented?  Either way, look
no further than CQ’s complete line of powerful data management
application programs.  These products offer superior data
management tools that improve efficiencies while driving down
the costs associated with the management of large quantities of
recurring data.

It is often a daunting task to manage the massive amounts of data
that organizations receive everyday.  Many times, this data
includes reports and files sent on a daily basis from mainframe
computers to remote workstations.  So, the simple question
becomes, “How can I efficiently manage all this data?”.

CQ offers productivity solutions that incorporate automated and
time-saving features that allow you to efficiently manage your
data.  Many of these programs can be used independently,
combined with other CQ productivity solutions, or combined
with CQ connectivity solutions such as CQ-EE™, CQ-3770EE®,
CQ-3770MC®, CQ-3770®, CQ-3270EE®, CQ-3270®, and CQ-3780®.
Each solution focuses on a particular aspect of data management
that allows users to efficiently manage data and thus increase
your organization’s productivity.
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CQ-Forms Manager™

CQ’s form selection management solution allows
efficient management of the micro/mainframe file
transfer process.

The CQ-Forms Manager productivity solution, used in
conjunction with a CQ connectivity solution such as CQ-EE,
CQ-3770EE, CQ-3770MC, and CQ-3770, allows you to both
receive forms from a mainframe queue and to also send forms to
a mainframe site.

The solution is customizable according to your organization’s
forms download and upload needs.  For example, the solution
allows you to pick and choose the files you download from
mainframe queues, and then rename or redirect these files
according to your needs.

The CQ-Forms Manager solution can be divided into two
components:  the Receive Component and the Send Component.

Receive Component

Historically, the JES application running on the mainframe
provides a queue for print jobs.  Some example print jobs might
include collections reports or year-end reports.  Often times,
these print jobs are stored in a queue on the mainframe computer
with a “form report” name that describes the print job.  Some
example “form report” names include COLL and YEND.

Typically, an operator in charge of retrieving these forms (or
reports) will retrieve the queue list from the mainframe and then
request one of the reports.  This review of the mainframe queue
and the retrieval of “forms” are done using the mainframe
application’s JES commands.

Productivity Solutions
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While the CQ-EE, CQ-3770EE, CQ-3770MC, or CQ-3770
connectivity solution enables the operator to accomplish these
tasks through the JES commands, it is a time-consuming,
multi-step process to specify the destination (either a file or
printer), view the mainframe queue, specify the wanted form with
or without a banner page, request the form download, and finally
to close out the mainframe queue.

The CQ-Forms Manager productivity solution provides simple,
point-and-click access to user-customized forms lists and even
allows for unattended forms downloads of the mainframe queue.
With CQ-Forms Manager, all forms download jobs can be setup
and saved in advance and then run with ease when it is time for a
download to occur.

Send Component

The second component of the CQ-Forms Manager program is the
Send Component.

The Send Component allows you to send forms (i.e., reports) to
the mainframe site.  Through this component of the solution, you
can setup separate configurations for unique sets of forms that
you can send to the mainframe site manually (attended) or
through a command line in a script (unattended).

Technical Features

• Easy maintenance of send and receive lists.

• Form retrieval specifications.

• Customizable destination specifications.

• Alternative file naming.

• For sending of files, customization of JCL specifications.

• Attended downloads and uploads.

• Unattended downloads and uploads.

• Integration with the SmartKey Pad.
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CQ-Print Administrator™

CQ’s print management solution allows efficient
management of multiple text-based files to multiple
printers according to page ranges and specifications
set within the program.  This solution allows you to
minimize the effects of crippling printer malfunctions
and errors by printing your large text-based files
through this program.

The CQ-Print Administrator productivity solution provides an
efficient way to manage and print text based files according to
your specific print layout requirements and specifications.  The
solution is especially useful for large recurring print jobs that
require pre set file formatting options such as the number of
columns per line and the number of rows per page.  The solution
also allows you to configure and save print Layouts that are
useful for unattended print jobs that you schedule through other
programs.  Through these print Layouts, you can also include
customizable headers, footers, and banner pages that allow you to
separate print jobs.

Print Files the Easy Way

CQ-Print Administrator is the ideal solution for print operators
that receive large, multi megabyte text based files that need to be
printed efficiently with little user intervention.  The solution is
especially useful for print operators that receive print jobs on a
daily, weekly, or monthly recurring basis.  The
CQ-Print Administrator solution provides all the tools and features
for complete print job satisfaction.

The solution simplifies the print process by allowing you to open
large text based files and preview these files on the screen.  This
might sound like a simple task, but most programs in use today,
such as word processing programs, will automatically format text
and make it next to impossible to view it in an unformatted way.
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The large Preview Area on the main CQ-Print Administrator’s
screen allows you to view each file in a fixed text format.  You
simply enter in the maximum number of columns per page and
the CQ-Print Administrator shows you a true representation of
what your text will look like when it is printed.

Technical Features

• Unattended operation through pre-set print Layouts.

• Header, Footer, and Banner page features.

• Print recovery.  Useful for paper jams, out of paper errors,
or other printing errors.

• Compatible with any attached printer.  CQ’s software is
fully compatible with any laser printer that the Windows
operating system supports.  Print jobs can also be sent to
printers as raw print data.

• Easily handles any size text-based file.  Text files include
files in ASCII format.

• Manage multiple files simultaneously.  You can have
several files open simultaneously as the software can easily
format and print multiple files.

• Print to multiple printers.

• Set file formatting options.  Options such as the maximum
number of columns per line, the maximum number of lines
per page, and whether to wrap or truncate long lines can be
set through the software.

• Preview Area.  The scrolling Preview Area allows you to
preview each page of the file.

• Print according to your page ranges.

• Navigation features.  You can easily move throughout text
files through the program’s navigation features.
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CQ-Event Scheduler™

CQ’s event scheduling solution allows the scheduling
of recurring computer tasks, including daily or
monthly data downloads.  This solution allows you to
schedule recurring computer tasks, including daily or
monthly data downloads, that you would otherwise
have to initiate manually.

The CQ-Event Scheduler productivity solution provides an
automated way to schedule recurring computer tasks that you
would otherwise have to initiate manually.  The solution is
especially ideal for the automation of daily, weekly, or monthly
tasks such as file management processes, report downloads, and
large after-hours print jobs.

For the ultimate in productive data management,
CQ-Event Scheduler can be integrated with other CQ productivity
solutions such as CQ-Forms Manager, CQ-Print Administrator,
and CQ-File Manager or other CQ connectivity solutions such as
CQ-EE, CQ-3770EE, CQ-3770MC, CQ-3770, and CQ-3780.
CQ-Event Scheduler allows for the complete automation of CQ’s
productivity and connectivity solutions according to your unique
requirements and specifications.

This scheduled automation of events allows you to shift your
organization’s financial and labor resources to other tasks that
cannot be automated.  By automating tasks, you also decrease the
likelihood of manual “human” errors from occurring.  Finally,
automated tasks can be completed during off-peak business hours
when computers and their attached devices can be dedicated to a
particular task that many times takes a lengthy period of time to
complete.
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Automated Task Scheduling

The CQ-Event Scheduler is a simple yet powerful solution.  The
solution is useful in situations that require certain computer tasks
to be completed on a recurring basis.  For example, the solution
can be configured for a task, such as a weekly file download, to
occur every Friday night at 11:59 P.M.  The solutions also allows
you to move ahead at any time in the calendar year and change
certain download dates based on holidays or other possible
interruptions.  Automated tasks can occur without any human
intervention.  There is no limit to the number of tasks that can be
scheduled up to 12 months in advance.

To schedule one or more tasks, you can select a date or
continuous range of dates by using the solution’s intuitive
calendar screen.  Once a date has been selected, the default task
and time is copied to the selected date or to the selected range
through the click of a button.  Then, the user moves to a new
screen to refine the scheduling defaults.  From this screen, one or
more tasks can be scheduled at multiple times.

For example, the user can have the CQ-Event Scheduler program
run a CQ-EE, CQ-3770EE, CQ-3770MC, CQ-3770, or CQ-3780
configuration file that in turn downloads one or more files.

The CQ-Event Scheduler program can also be used with other CQ
productivity solutions such as CQ-Forms Manager,
CQ-Print Administrator, and CQ-File Manager.  For example, the
CQ-Event Scheduler program can be setup to automatically
download and print one or more text files through the
CQ-Print Administrator.
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CQ-File Manager™

CQ’s file management solution provides a
standardized interface that manages the file
processing tasks that are customized to specific file
processing requirements and specifications.  The
solution allows you to avoid the time-consuming and
often times error-prone task of parsing data
manually by automating the process according to
your specific needs.

The CQ-File Manager productivity solution provides an
automated way to manage data that your organization receives,
usually through a recurring download, everyday.  By automating
the management procedures, the solution can improve your
organization’s efficiencies and drive down the costs associated
with the management of large amounts of recurring data.  The
solution is easily customizable according to the file processing
tasks that are unique to your requirements and specifications.

CQ-File Manager allows you to automate many of the daily data
management tasks so that you can shift your financial and
employee resources towards other issues.  The processes that are
defined within your customized version of CQ-File Manager also
make manual “human” errors less likely as most of the processes
will now be automated.  Some potential applications for the
solution include the daily “parsing” of data according to defined
file characteristics; redefinition of report fields; file reformating
and conversion; data conversion such as EBCDIC/ASCII
translation and field packing and unpacking; and data mining.
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Customized File Processing Solution

File processing tasks vary widely from one organization to
another and even from task to task within the same organization.
More often than not, programs and procedures are uniquely
designed and written for each task.  For example, you may have
the need to select specific fields of data from a file and then write
the contents of these specific fields to a separate output file.  With
the assistance of CQ’s engineering staff, the CQ-File Manager
program can be customized to accomplish this task.

The CQ-File Manager program has taken the “tailor on demand”
approach in the way that it can be customized for your
applications and needs.  CQ selected this approach in designing
the program because any “generic” program that attempts to
provide a user-customizable interface that allows for the
configuration of all conceivable file processing tasks would be
problematic and complex.

Instead, you simply provide CQ with your file processing
requirements and CQ will provide an engineering cost estimate to
accomplish your specified requirements.  This “scope of work”
that you would provide to CQ would include a sequence of
events and procedures for management of your data that are
currently in place at your organization.  CQ will then customize
CQ-File Manager to automate these procedures in a more efficient
way.  When the customized program has been written by CQ,
you simply press the [Start] button from the CQ-File Manager’s
main screen and the output files are generated.  For example, the
CQ-File Manager solution can help you avoid the time-consuming
and often times error-prone task of searching through your data
files manually by automating the process according to your
specific needs.

For the ultimate in productive data management,
CQ-File Manager can be integrated with other CQ productivity
solutions such as CQ-Forms Manager, CQ-Print Administrator,
and CQ-Event Scheduler or other CQ connectivity solutions such
as CQ-EE, CQ-3770EE, CQ-3770MC, CQ-3770, and CQ-3780.
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Connectivity Solutions

CQ delivers IBM terminal emulation connectivity solutions that
combine the depth and full range of IBM emulation with the
simplicity and ease-of-use of the Windows Graphical User
Interface (GUI).  These solutions provide connectivity from any
remote or local workstation or client running a Microsoft
Windows operating system, including Windows 95, Windows 98,
Windows NT, Windows 2000, and Windows XP.

SNA-over-IP Enterprise Extender
Connectivity Solutions

The Enterprise Extender (EE) technology allows for the use of
SNA transport protocols (namely APPN and HPR) over an IP
network.  It enables the leveraging of IP-based infrastructure
network components for use in delivering SNA traffic.  The
CQ-EE, CQ-3770EE, and CQ-3270EE solutions utilize IBM’s
Enterprise Extender technology to allow for SNA access over IP
connections.  Best of all, these solutions are not dependent on
specific hardware configurations like other SNA connectivity
solutions - CQ’s EE solutions can run on any Windows
workstation or server with no hardware changes required!

The Move to Enterprise Extender

IBM Front End Processors (FEPs), such as the 3745 and 3746
Controllers, form the backbone of many mission-critical SNA
networks by allowing remote SNA clients to connect to
mainframe computers.  These FEPs were withdrawn from
marketing by IBM effective September 27, 2002.  Since that date,
only used FEP products and features have been available.  Since
IBM’s announcement, networks that are based on these
controllers have begun the realization that these FEPs are no
longer supported and another SNA-type connectivity solution is
necessary.

Connectivity Solutions
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IBM states that the reason that the controllers were withdrawn
from marketing is the success of IP in corporate networks.  In the
IBM Announcement Letter dated February 26, 2002, IBM stated
that the “explosive growth of the Internet and TCP/IP traffic have
resulted in a severe decline in the demand for new 3745 and 3746
Communication Controllers.”  In fact, it is widely accepted that
IP is the strategic networking protocol of the future.  IP has been
around since 1969 so it is well established and also offers
features such as scalability, redundancy, resiliency, openness,
adaptability, and manageability.

As a transition for SNA users, IBM developed an IP transport
technology called Enterprise Extender (EE).  Enterprise Extender
allows remote SNA clients to continue to communicate with
mainframes over existing IP networks in much the same way as
they do today.

SNA Connectivity over IP Networks

The IBM Announcement of FEPs being withdrawn from
marketing is important because many SNA networks rely upon
IBM’s FEPs to connect SNA traffic between remote clients and
corporate mainframes.  CQ’s EE solutions utilize the EE
technology and allows remote SNA clients access to corporate
mainframe data centers over existing IP connections.

Through CQ-EE, CQ-3770EE, and CQ-3270EE, the applications and
data that remote clients have used throughout the years can now
be accessed over IP networks.  CQ software users will find this
new technology as reliable, scalable, and easy to use as SNA and
because CQ’s EE solutions use standard IP technology, the
solutions do not require new client hardware or software to be
installed.  In fact, certain client-side hardware such as dial-up
modems, DLSw routers, Token Ring cards, and serial adapter
cards are eliminated altogether.
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Hardware Specific Connectivity
Solutions

For mainframe or host communications that does not involve
Enterprise Extender, CQ connectivity solutions require that
workstation or server computers running the CQ software
product be equipped with the proper hardware.  In most cases, the
host site almost always determines the connection option for
communications between remote or local workstations or servers
and the mainframe computer.  For example, the host site might
help to determine the speed (baud rate) of the connection as the
host site ultimately controls this option.  Other factors, such as
port availability, type of port, and other factors, are controlled by
the workstation or server that is connecting with the mainframe.

CQ’s products support multiple methods of connection including
remote analog dial-up lines, dedicated leased lines, high-speed
T1/Fractional T1 leased lines, ISDN, Routed Networks (Frame
Relay, etc.), direct connections, and more.  These connections are
supported through numerous hardware connection options.
Hardware options include Hayes™ OPTIMA™ modems with the
AutoSync™ 2 feature; versatile 32-bit CQ-Sync™ PCI internal
adapter cards with external synchronous communications
devices; Ethernet Network Interface Cards (NICs) and
Token Ring adapter cards; and SNA over IP connections through
IBM’s Enterprise Extender technology.  Other connection
options are also available from CQ.
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CQ-EE
(Customized Solution for Select Clients)

The CQ-EE connectivity solution combines numerous features
with an advanced interface to provide clients with 377x
SNA/RJE mainframe connectivity over existing IP networks.
The transmission of SNA data over IP networks is accomplished
through IBM’s Enterprise Extender technology.

CQ-EE Features

• SNA-over-IP connectivity through the Enterprise Extender
technology.

• Seamless transition for CQ-3770MC clients.

• Interactive Graphical User Interface (GUI).

• Customized for select clients.

• Customizable features such as the toolbar and SmartKey Pad.

• Easy configuration of communication parameters.

• Informative CQ In/Out Bound screen displays current status
of communications.

• Scripting and scheduling features for unattended operation.

• Expanded printer support.

• Audit and trace diagnostic features.

• Security features such as Triple DES.

• 377x SNA/RJE features such as ASCII/EBCDIC translation,
Full Multiple Logical Unit (MLU) support, fast batch file
transfers through data compaction and repeated character
compression, and automatic file naming.
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CQ-3770EE

The CQ-3770EE connectivity solution combines numerous
features with an advanced interface to provide users with 377x
SNA/RJE mainframe connectivity over existing IP networks.
The transmission of SNA data over IP networks is accomplished
through IBM’s Enterprise Extender technology.

CQ-3770EE Features

• SNA-over-IP connectivity through the Enterprise Extender
technology.

• Seamless transition for CQ-3770 clients.

• Interactive Graphical User Interface (GUI).

• Customizable features such as the toolbar and SmartKey Pad.

• Easy configuration of communication parameters.

• Informative CQ In/Out Bound screen displays current status
of communications.

• Scripting and scheduling features for unattended operation.

• Expanded printer support.

• Audit and trace diagnostic features.

• Security features such as Triple DES.

• 377x SNA/RJE features such as ASCII/EBCDIC translation,
Full Multiple Logical Unit (MLU) support, fast batch file
transfers through data compaction and repeated character
compression, and automatic file naming.
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CQ-3270EE

The CQ-3270EE connectivity solution combines numerous
features with an advanced interface to provide users with 3270
interactive mainframe connectivity over existing IP networks.
The transmission of SNA data over IP networks is accomplished
through IBM’s Enterprise Extender technology.

CQ-3270EE Features

• SNA-over-IP connectivity through the Enterprise Extender
technology.

• Seamless transition for CQ-3270 clients.

• Interactive Graphical User Interface (GUI).

• Customizable features such as the toolbar, SmartKey Pad,
and the display’s color, font, and cursor attributes.

• Easy configuration of communication parameters.

• Interface screen displays all communications information.

• Security features such as Triple DES.

• Expanded printer support.

• Audit and trace diagnostic features.

• CQ graphical keyboard remapper.

• Scripting and scheduling features for unattended operation.

• 3270 SNA features such as terminal emulation of IBM’s
SNA 3270 interactive terminals and controllers, multiple
simultaneous LU devices (LU2 display or LU1/LU3 printer
type sessions) and IND$FILE file transfers.
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CQ-3770MC
(Customized Solution for Select Clients)

The CQ-3770MC connectivity solution delivers the ultimate in
IBM 377x SNA/RJE terminal emulation connectivity by
combining the depth and full range of IBM emulation with the
simplicity and ease-of-use of the Windows Graphical User
Interface (GUI). 

CQ-3770MC Features

• Numerous connection options, including remote analog
dial-up, dedicated leased line, high-speed T1/Fractional T1
leased line, ISDN, Routed Network (Frame Relay, etc.),
direct connection, and more.

• Customized for select clients.

• Interactive Graphical User Interface (GUI).

• Customizable features such as the toolbar and SmartKey Pad.

• Scripting and scheduling features for unattended operation.

• Interface screen displays all communications information.

• Easy configuration of communication parameters.

• Expanded printer support.

• Audit and trace diagnostic features.

• Security features such as Triple DES.

• 377x SNA/RJE features such as ASCII/EBCDIC translation,
Full Multiple Logical Unit (MLU) support, fast batch file
transfers through data compaction and repeated character
compression, and automatic file naming.
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CQ-3770

The CQ-3770 connectivity solution delivers the ultimate in IBM
377x SNA/RJE terminal emulation connectivity by combining
the depth and full range of IBM emulation with the simplicity
and ease-of-use of the Windows Graphical User Interface (GUI). 

CQ-3770 Features

• Numerous connection options, including remote analog
dial-up, dedicated leased line, high-speed T1/Fractional T1
leased line, ISDN, Routed Network (Frame Relay, etc.),
direct connection, and more.

• Interactive Graphical User Interface (GUI).

• Customizable features such as the toolbar and SmartKey Pad.

• Scripting and scheduling features for unattended operation.

• Interface screen displays all communications information.

• Easy configuration of communication parameters.

• Expanded printer support.

• Audit and trace diagnostic features.

• Security features such as Triple DES.

• Auto-dialing and auto-answer support.

• 377x SNA/RJE features such as ASCII/EBCDIC translation,
Full Multiple Logical Unit (MLU) support, fast batch file
transfers through data compaction and repeated character
compression, and automatic file naming.
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CQ-3780

The CQ-3770 connectivity solution delivers the ultimate in IBM
3780/2780 BSC/RJE terminal emulation connectivity by
combining the depth and full range of IBM emulation with the
simplicity and ease-of-use of the Windows Graphical User
Interface (GUI). 

CQ-3780 Features

• CQ-File Transfer Options utility program for easy
customization of file transfer settings and actions.

• Numerous connection options, including remote analog
dial-up, dedicated leased line, high-speed T1/Fractional T1
leased line, ISDN, Routed Network (Frame Relay, etc.),
direct connection, and more.

• Interactive Graphical User Interface (GUI).

• Customizable features such as the toolbar and SmartKey Pad.

• Scripting and scheduling features for unattended operation.

• Interface screen displays all communications information.

• Easy configuration of communication parameters.

• Expanded printer support.

• Audit and trace diagnostic features.

• Security features.

• Auto-dialing and auto-answer support.

• 3780 Bisync/RJE features such as ASCII/EBCDIC
translation, fast batch file transfers through repeated
character compression, automated file distribution, and
automatic file naming.
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CQ-3270

The CQ-3270 connectivity solution delivers the ultimate in IBM
3270 interactive terminal emulation connectivity by combining
the depth and full range of IBM emulation with the simplicity
and ease of use of the Windows Graphical User Interface (GUI).

CQ-3270 Features

• Numerous connection options, including remote analog
dial-up, dedicated leased line, high-speed T1/Fractional T1
leased line, ISDN, Routed Network (Frame Relay, etc.),
direct connection, and more.

• Customizable features such as the toolbar, SmartKey Pad,
and the display’s color, font, and cursor attributes.

• Interactive Graphical User Interface (GUI).

• Easy configuration of communication parameters.

• Interface screen displays all communications information.

• Security features such as Triple DES.

• Expanded printer support.

• Audit and trace diagnostic features.

• CQ graphical keyboard remapper.

• Scripting and scheduling features for unattended operation.

• Auto-dialing and auto-answer support.

• 3270 SNA features such as terminal emulation of IBM’s
SNA 3270 interactive terminals and controllers, multiple
simultaneous LU devices (LU2 display or LU1/LU3 printer
type sessions) and IND$FILE file transfers.
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Hardware Connection
Options

For mainframe or host communications that does not involve
Enterprise Extender, CQ connectivity solutions require that
workstation or server computers running the CQ software
product be equipped with the proper hardware.  In most cases, the
host site almost always determines the connection option for
communications between remote or local workstations and the
mainframe computer.  For example, the host site might help to
determine the speed (baud rate) of the connection as the host site
ultimately controls this option.  Other factors, such as port
availability, type of port, and other factors, are controlled by the
workstation that is connecting with the mainframe.

CQ supports several different connection options for use with the
CQ-3770MC, CQ-3770, CQ-3780, and CQ-3270 software products.
Some of these connection options are only available with certain
CQ products due to limitations in the technology.  For example,
the DLC Interface feature that is used for Ethernet and
Token Ring applications does not support the Bisync protocol, so
the CQ-3780 product cannot connect through this option.

Hardware Connection Options
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Hayes OPTIMA Modem
(with AutoSync 2)

Before the AutoSync technology, remote PC-to-host
communications users were required to install and configure
numerous hardware components on the workstation including an
internal synchronous adapter card, cable, external synchronous
modem, and, in some cases, additional hardware such as a switch
box.  

In the 1980’s, CQ co-developed and engineered the original
AutoSync technology with Hayes Microcomputer Products, Inc.
The AutoSync technology allows synchronous PC-to-host users
to eliminate additional hardware that was previously required for
host connectivity.  In AutoSync mode, the modem automatically
performs an internal asynchronous-to-synchronous conversion,
thus permitting easy PC-to-host communications without any
additional hardware required!

The AutoSync 2 feature automatically performs the sync/async
conversion that is necessary for synchronous host
communications over analog dial-up lines at speeds up to
33.6 Kbps.  This feature is available in the OPTIMA line of
external and internal modems that are currently manufactured by
Zoom® Telephonics, Inc.  PCMCIA versions of the OPTIMA
modem are available directly through CQ.
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CQ-Sync100™ PCI Adapter Card

This internal 32-bit synchronous adapter card allows PC users to
connect remotely to host computers over analog dial-up or
dedicated leased lines at speeds up to 33.6 Kbps.  The card uses
an RS-232 cable to connect to an external synchronous modem.

CQ-Sync200™ PCI and CQ-Sync300™

PCI High-Speed Adapter Cards

These internal 32-bit high-speed synchronous adapter cards allow
PC users to connect remotely to host computers through two
different hardware configurations.  The CQ-Sync200 PCI adapter
card uses an RS-232 cable to connect to an external synchronous
modem or high-speed device (CSU/DSU, Router, etc.).  The
CQ-Sync300 PCI adapter card uses a V.35 cable.

a. The first configuration uses the adapter cards to communicate
over analog dial-up lines, dedicated leased lines, ISDN lines,
T1/Fractional T1 leased lines, or other connection lines at
speeds between 2400 bps and 128 Kbps.  The CQ-Sync PCI
card is installed at the remote workstation and is then
connected to an external synchronous modem or high-speed
device.

b. The second configuration uses the adapter cards and
high-speed devices to communicate through a local router
over routed networks.

Hardware Connection Options
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Ethernet NIC or Token Ring Adapter
Card (DLC Interface)

These connections function through internal Network Interface
Cards (NICs) installed in a PC that is part of an Ethernet or
Token Ring network.  The solution communicates to the host
through a local router over a routed network (Frame Relay, etc.).
This solution is only available for SNA products (CQ-3770MC,
CQ-3770, and CQ-3270).

Local Direct Connection

This connection allows direct host connectivity through a local
workstation.  If the workstation is connected to a local Ethernet
or Token Ring network, the software communicates through an
internal Ethernet NIC or Token Ring adapter card installed on the
local workstation.  Another option is to use a CQ-Sync PCI
adapter card to perform the direct connection to the host.  For the
ultimate in high-speed connectivity, CQ’s solutions support
channel attach to the host via Bus&Tag.  This solution is only
available for SNA products (CQ-3770MC, CQ-3770, and CQ-3270).
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